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Welcome to This Guide

This guide describes how to configure and work with Business Process
Insight and provides information about the management tasks that you
need to complete for the ongoing set up and maintenance of your Business
Process Insight (BPI) solution.

This chapter includes:

» How This Guide Is Organized on page 11

» Who Should Read This Guide on page 12

» How Do I Find the Information That I Need? on page 13

» Additional Online Resources on page 15

» Documentation Updates on page 16

How This Guide Is Organized
The guide contains the following:
Chapter 1, "Introducing Business Process Insight."

Provides an overview of using BPI with Business Service Management to
visualize the health and performance of the Business Processes that are
running over an IT infrastructure.

11
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Part |

Part Il

BPI Administration

Describes the BPI Administration options: Modeler, Monitor Definer, Process
Repository Explorer, Process Intervention, and Notification.

BPI Application Reports

Describes the BPI Reports: BPI Application Scorecard, BPI Application
Health, Business Process Summary Report, BPI Monitors Over Time Report,
and Business Process Activity Summary Report.

Who Should Read This Guide

12

This guide is intended for the following users of HP Business Process Insight:

» HP Business Process Insight administrators
» HP Business Process Insight application administrators
» HP Business Process Insight end users

Readers of this guide should be knowledgeable about navigating and using
enterprise applications, and be familiar with HP Business Service
Management and enterprise monitoring and management concepts.
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How Do | Find the Information That | Need?

This guide is part of the HP Business Service Management Documentation
Library. This Documentation Library provides a single-point of access for all
Business Service Management documentation.

You can access the Documentation Library by doing the following:

» In Business Service Management, select Help > Documentation Library.

» From a Business Service Management Gateway Server machine, select
Start > Programs > HP Business Service Management > Documentation.

Topic Types

Within this guide, each subject area is organized into topics. A topic
contains a distinct module of information for a subject. The topics are
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by
dividing the documentation into the different types of information you
may need at different times.

13



Welcome to This Guide

Three main topic types are in use: Concepts, Tasks, and Reference. The topic
types are differentiated visually using icons.

Topic Type Description Usage
Concepts Background, descriptive, or Learn general information
&) conceptual information. about what a feature does.
Tasks Instructional Tasks. Step-by- » Learn about the overall
Qﬁ:} step guidance to help you workflow of a task.
work with the application and | » Follow the steps listed in
accomplish your goals. Some a numbered task to
task steps include examples, complete a task.
using sample data. » Perform independent
Task steps can be with or operations by
without numbering: completing steps in a

» Numbered steps. Tasks that non-numbered task.

are performed by following
each step in consecutive
order.

» Non-numbered steps. A list
of self-contained operations
that you can perform in any

order.
Use-case Scenario Tasks. Learn how a task could be
Examples of how to perform a | performed in a realistic
task for a specific situation. scenario.

14
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Topic Type

Description

Usage

Reference

®

General Reference. Detailed
lists and explanations of
reference-oriented material.

Look up a specific piece of
reference information
relevant to a particular
context.

User Interface Reference.
Specialized reference topics
that describe a particular user
interface in detail. Selecting
Help on this page from the
Help menu in the product
generally open the user
interface topics.

Look up specific
information about what to
enter or how to use one or
more specific user interface
elements, such as a
window, dialog box, or
wizard.

Q,

Troubleshooting
and Limitations

Troubleshooting and
Limitations. Specialized
reference topics that describe
commonly encountered
problems and their solutions,
and list limitations of a feature
or product area.

Increase your awareness of
important issues before
working with a feature, or
if you encounter usability
problems in the software.

Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on
the HP Software Support Web site where you can search the Self-solve
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site
enables you to browse the Self-solve knowledge base. You can also post to
and search user discussion forums, submit support requests, download
patches and updated documentation, and more. Choose Help > HP Software
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user
and sign in. Many also require a support contract.

15
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:

http://h20229.www2.hp.com/passport-registration.html

HP Software Web site accesses the HP Software Web site. This site provides
you with the most up-to-date information on HP Software products. This
includes new software releases, seminars and trade shows, customer support,
and more. Choose Help > HP Software Web site. The URL for this Web site
is www.hp.com/go/software.

Documentation Updates

16

HP Software is continually updating its product documentation with new
information.

To check for recent updates, or to verify that you are using the most recent
edition of a document, go to the HP Software Product Manuals Web site
(http://h20230.www2.hp.com/selfsolve/manuals).
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Introducing Business Process Insight

This chapter includes:

Concepts

» BPI Within Business Service Management Overview on page 18
» What is a Business Process? on page 21

» What is a BPI Process? on page 22

» Business Events on page 27

» IT Processes on page 28

» Summary of Defining Models for Your Business Processes on page 29
» Instances of Business Processes on page 30

» Operational and Business Data on page 32

» Business Scenario for a Stock Control System and BPI on page 34
» What BPI Provides on page 37

» Using BPI Within Business Service Management on page 39
Tasks

» How to Manage User Permissions on page 45

Reference

» Configuration Items Stored in the RTSM on page 48
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Concepts

& BPI Within Business Service Management Overview

18

BPI is a Business Service Management Application that enables you to make
better business decisions by improving the quality of the business
information available to you. BPI provides you with visibility into the
health and performance of the Business Processes that are running over your
IT infrastructure. Using this information, you can assess the financial and
business impact of delays or blockages in a process due to an IT performance
problem or other incident such as an IT outage.

BPI achieves this by linking and relating the information held for your
business and its IT infrastructure. It takes information, in the form of events,
from both business applications and from the IT infrastructure, and presents
these events in business terms; for example, rate of loss of orders, backlogs
accumulating, value of these backlogs and potential impact on key
customers. In other words, BPI enables you to visualize and then track the
state, or health, of Business Processes within your organization.

Specifically you can use BPI to:

» Model Business Processes and then measure key business data associated
with these processes; for example, value of order.

» Correlate each Activity in the Business Process with the IT infrastructure
on which it depends and provide IT with the visibility to show its
contribution to the business.

To achieve this, BPI uses business data events and IT infrastructure events to
monitor the status of all the Business Processes that you have modeled. As a
result, when a problem occurs within the IT infrastructure, BPI reports on
the instances of the processes that are being monitored and that are
impacted; for example, BPI might report on the number of orders that are
affected for a specific customer, for all customers or for a group of customers
(gold, silver, bronze-level customers).
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The key business data associated with the process are then used to
determine the business impact of the problem. Business impact typically
takes the form of financial impact, but it can also be the number of key
customers affected, or the number of urgent orders affected, and so on.

You then use Service Health to do the following:

» Proactively monitor your service level agreements (SLASs).

Service Health enables you to see which SLAs are at risk and enables you
to navigate to see which specific configuration item (CI) is potentially
causing you to breach a service contract. For more information about the
BPI CIs see “Configuration Items Stored in the RTSM” on page 48.

» Calculate whether the measurements of an SLA are within the limits set
out in a service level agreement (as defined in Service Level Management).

» Calculate whether an SLA is in breach of contract, or might be in breach
in the near future.

19
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The following diagram shows the structure of the BPI Business Process
models as CIs within the RTSM (Run-Time Service Model).
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Each of the elements in this diagram is represented as a CI within the RTSM.
The BPI application sends data samples for the Business Process Cls that you
define and these data samples are then displayed on the Business Process
Diagram in Service Health and in the Business Process Application.

Enabling/Disabling BPI Through BSM Server Deployment

When BSM is deployed, you can enable the applications that you require
through the BSM Server Deployment page. You must enable Business
Process Insight through the BSM Server Deployment page to be able to
access the BPI application from both the Applications and Admin menus. To
access the BSM Server Deployment page, select Admin > Platform > Setup
and Maintenance > Server Deployment.

20
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If you disable BPI through the BSM Server Deployment page, even if the BPI
license is installed, BPI cannot be accessed. For details on using the BPI
Server Deployment, see Platform Administration.

Note: If you enable/disable Business Process Insight through the BSM Server
Deployment page, the BSM Gateway and Processing Servers should be
restarted, for this change to take effect.

& What is a Business Process?

Business Processes are a set of Business Activities within your business; for
example, Business Activities for a telecom service provider might include
line provisioning, customer billing and equipment repairs. These Business
Activities might not always be obvious, and they might not be formally
recognized, but they always exist within a business. A Business Process (or a
set of Business Activities) typically includes all the activities of the business.

For an insurance company, business activities might include setting up a
new policy for a customer and processing an insurance claim. In addition to
these line-of-Business Processes, a Business Process can also be an internal
administration process, such as HR processes, payroll, and so on.

Business Processes are not necessarily exclusive to one company; many
Business Processes involve customers and suppliers. Business Processes can
be automated, using Business Process management software; however, only
a fraction of Business Processes are fully automated. Most Business Processes
are manual and some exist only in the behavior of the organization, that is,
they are not formally documented.

21
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& What is a BPI Process?

A process (for BPI tracking purposes) does not need to include all the
activities in a Business Process; it need contain only those activities that you
need to understand to determine that your business is functioning
optimally. As an example, a vehicle dashboard presents a summary of the
key activities that you need to be aware of for the vehicle; it does not present
all the information about all the vehicle operations.

The business activities that you need to model within BPI for your business
are those required to obtain meaningful impact data about the health of
your business. The fewer business activities that you track, the easier the BPI
processes are to create and manage and visualize.

Structure of a BPI Process

Within BPI, a process is presented as a series of Activities and connections,
which are called Arcs. The Activities represent the business activities and the
arcs connect the Activities to show the expected direction of flow within the
process; this is shown in the following diagram.

Activity 1 Activity 2 Activity 3

Start of | End of
BPI process E - E i |E =~ brocess

1

tiviti
An activity in a Business Process might represent one or more business

activities, according to how much detail of the Business Process you are
modeling to track it.

22
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BPI enables you to represent a business process in a graphical form. This
permits you to show the logical structure of the elements of the process. The
graphical representation also provides visual information relating to the
progression of the process.

Using the graphical processes enables you to more easily connect business
activities into a logical sequence using as few activities as possible. However,
make sure that your structure of the process model is sufficient to report the
impact of problems in the process.

23
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Example BPI Process

The following diagram is an example of a Business Process for an
organization that provides building materials primarily for professionals,
but it also has a store where the public can purchase building supplies. This
diagram shows the hierarchy of the IT operational resources and how they
relate to the applications that provide the resources.

Stock Control ; b |
Process n . e e

Business Service
Management RTSM

L

Stock Control CRM Accounts
application application application
1 [
i« ¥ ¥
database Metwork database database
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The organization is structured as a front office, middle office and back
office:

> Front office — includes the following:
» Web site for online access
» Shop
» Call center

An ISP hosts the Web site and the shop has a dial-up connection through
a point-of-sale checkout. The Call Center is out sourced.

> Middle office — where orders are processed and validated.
» Back office — where billing and the execution of the orders occur.

In this example, the middle and back office operational systems are
managed using HP Business Service Management.

Also, in this example, the Stock Control System is used at several points in
the Business Process and the Stock Control process diagram shows this
interaction.

The following diagram shows the significant activities of the Business
Process represented graphically in a BPI process. This is how they might
appear within the BPI Modeler, which is the graphical tool for creating BPI
processes.

25
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As mentioned earlier, you do not need to include all the Activities in the
Business Process. The Activities that you include are those that relate to the
key business activities that need to be tracked.
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The process shown in this diagram uses undetlying business applications
and also includes IT operational resources. Some of the business applications
might be operationally tracked and therefore represented as IT operational
resource CIs within Business Service Management.

There might also be other business applications that are not being
operationally tracked, but are still providing business application data for
BPL. In this example, information about the health of the Stock Control
System is used at several points in the BPI Business Process and the diagram
below shows this dependency. Within the BPI Modeler, these resources are
properties of the Activities in the process.
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& Business Events

To integrate, or import, business event data from your business applications,
you use the BPI adapter technology. This technology enables you to
generate business events from sources such as files and databases, and
business applications including PeopleSoft and JMS. These adapters enable
business data to be accepted as the source data for BPI business events,
which are received through the BPI Business Event Handler component.

In the context of BPI, an event is the notification of some change to the
underlying system that is being monitored and where this state change
causes a subsequent change in state of the modeled Process instances. This
might be directly through the data within the event or through some
transformation of the data.

The following section describes a business event component for BPI.

Business Events and openadaptor

The Business Event Handler is based on the openadaptor technology and
openadaptor is the underlying mechanism for receiving business events.
openadaptor is an open-source Java/XML-based software platform, which
provides business system integration with little or no programming.
openadaptor provides many ready-built interface components including
adapters to capture business events from sources such as files, databases,
JMS, LDAP, Tibco and MQ Series.

BPI also provides file and database adapters for use specifically with BPI;
however, openadaptor is an open source product and easily configurable;
therefore, you can extend the number of adapters for use with BPI as
required.

For more information about openadaptor refer to:
http://www.openadaptor.org/

BPI uses a specific version of the openadaptor platform, and the version
used is available as part of the BPI software.
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& IT Processes
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Within many organizations the IT processes and transactions are often
hidden within the environment in which they have been automated. The
processes might have started as fully documented process models, but as
they are adapted to the needs of the organizations, the processes change and
the related documentation becomes out of date. Using BPI helps you
visualize IT processes that are hidden within the organizational structure
and then set measurements on the IT operational resources that make up
the processes to report on the status of the operation of these resources.

You model your IT operational resources within BSM (as Cls) and then use
BPI to link the ClIs to process Activities. BPI can then obtain status
information relating to these operational resources for Business Processes
that you have modeled within BPIL.

TransactionVision

BPI can also use the transaction models produced by TransactionVision as
input for a Business Process model. TransactionVision tracks and measures
individual transactions as they progress through your organization.
TransactionVision provides the link between low-level systems and network
monitoring, and high-level Business Process monitoring to link your IT
objectives with your business objectives.

TransactionVision does not assume that a model exists to describe all
possible transaction flows. TransactionVision monitors transactions and
discovers the transaction paths as it observes them being executed across the
organization. You do not need to configure TransactionVision with
information describing how you think your transactions flow;
TransactionVision tells you how they flow based on observing real
transactions as they are processed. You do have to configure
TransactionVision to send the required transaction events to BPI. For details,
see "How to Send Events to BPI" in chapter 15 of Using Transaction
Management.

The discovered transaction events are then available for use by BP]I, as input
for Business Process modeling.



Chapter 1 ¢ Introducing Business Process Insight

& Summary of Defining Models for Your Business Processes

By defining models for your Business Processes and mapping these models
to the underlying IT operational resources modeled within Business Service
Management, you can be notified when Activities in the process are
impacted by a failure in the underlying infrastructure.

There are significant benefits to visualizing your Business Processes and
relating resources to these processes; for example, you can identify the
impact a resource failure has on the process and how other Activities in the
process might also be impacted.

However, understanding only the impact of resource status changes does
not enable you to answer questions such as:

» What is the financial impact of the resource failure?

» How many transactions are waiting to be processed at a particular point
in the process?

To answer these types of question, you also need business data from your
business applications, plus you need the BPI system to maintain data on
individual instances of the Business Processes.

Using rules, filters and database queries, BPI can provide monitor data based
on each instance and groups of instances. This, plus the business data that
BPI receives through business events, enables BPI to present business-related
information related to how your business is impacted by a failure in an IT
operational resource, or how your Business Processes are running with
respect to the objectives set on health indicators (HIs).
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& Instances of Business Processes

30

To get more detail from your business systems, you need to model the
individual instances of the process and see how these are being impacted. A
process instance is a specific occurrence of a particular process that you have
defined, for example, a specific customer transaction, or a specific flight
arrival.

To model instances of your processes, you need to define data objects. A
data object usually represents a known object within your organization; for
example, an order, an employee record or flight details, or indeed it might
also be an aggregation of a number of properties. In the case of
TransactionVision, these data objects are created automatically when the
transaction events that you have identified are imported.

The data captured from the business events, which are being processed by
your BPI system, can be used directly to change the status of a Business
Process, or can be used to update the status of the data objects that you have
defined. In the latter case, rules are used to evaluate how the Business
Process is progressing, based on the changing status of the data object.

You can also add Business Process Monitors to the instance-level
information and use them to provide business measurements to indicate the
health of the process instances that you are tracking.

Using the data collected for the defined Business Process Monitors, BPI can
present the state of the business back to the business manager. The data is
presented according to the instances of the processes being tracked and the
data collected. You can also use BPI to indicate to IT how they are meeting
the needs of the business, for example, you can use the Business Process
Insight Application Health page to show information about how many
orders are waiting to be processed, or information about the value of orders
that are waiting to have payment details checked.

You can also use the instance information that is recorded by BPI as follows:

» View historical data recorded from BPI data using the Business Process
Insight Application Reports page.
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» Monitor SLA violations using the reporting feature of the Service Level
Management Application.

» Create your own portlets using MyBSM.

As a result of modeling these process instances and setting Business Process
spans, the business manager can see the impact of the critical business
events on the Business Processes.

Modeling Business Processes

The most effective way to model a Business Process is to base it around the
primary documents and Business Processes in your organization, for
example, orders or insurance claim applications. As part of defining the
process you need to identify the following:

» Data that will be used to drive the process.

These are the data that define the conditions under which a business task
is deemed to have started and to have finished, and used to progress the
process.

You can also use data directly from your Business Events to start, stop and
progress your Business Process.

» Data required to answer the business questions that you want to track.

These data are obtained from your underlying business applications and
can be thought of in terms of the data required for the business
measurements that you want to report on for the process.

» Data required to characterize process instances.

In addition to data that can be used to infer process Activity state, or that
is used in calculations against business criteria, you might also want to
include Data properties that will be useful later when you want to
distinguish between Business Process instances. As an example, you might
want to group data by a specific location; in this case, the data relating to
the location is not used to determine whether a process Activity has
started or completed. It is also not used to calculate any sort of business
metric; however, it is useful to have the location as a category in
analyzing business performance.
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» Events, which are required to obtain the data to drive the process and
answer the business questions.

Events are defined in cooperation with the IT personnel who own the IT
infrastructure and who you work with to obtain the data that you need.

» Key Business Process Monitors that you want to measure for your Business
Processes.

& Operational and Business Data

32

This section discusses the types of data used by BPI in more detail.

The following diagram shows how the Activities in a process can be related
to the IT operational resources of your business, and that these resources,
when combined with the business data and events received through the
Business Event Handler, become the basis for tracking the health of your
Business Processes.

Take Process Update
order order order

Stat —— - (- --» - -—» - —-—-= Finish

businezs events operatioral everts

The BPI system also manages the data required for the process (the data
models), as Data definitions. In the Stock Control example, it maintains
information about the account business data and within that, information
about value, customer name, and customer type data.
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BPI does not need to know about all the data related to a process, just
enough to give a business manager information about the business impact
of the affected Business Processes. For example, in the Stock Control process
(see the diagram in “Example BPI Process” on page 24), the account business
data might also contain data relating t customer address and customer
preferences, but this data is not required for process tracking purposes, so it
does not need to be defined or tracked within BPI.

The following is a summary of the two types of events received into the BPI
system:

» Events that carry the data to move the process through its Activities.
These are the business events.

You configure the business events that you need for the business
applications that can access (or hold) the data required for the Business
Process.

» Events that report business impact information related to the IT
infrastructure; these are the operational events, which are linked to the
Business Process Cls.

You need to model business events for your solution. The events from
underlying business applications can provide the business data focus.

The data from these underlying systems is defined as part of the Business
Process and the resultant information used for reports and analysis.

A methodology, described later in this guide, takes you through the
Activities that help you define and then refine your Business Process and its
data.
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& Business Scenario for a Stock Control System and BPI

Continuing with the example of the Stock Control system, the following

describes the scenario in more detail and shows how BPI can be used, by the
business manager, to indicate the business impact of failures reported
through Business Service Management.

The scenario describes what happens when the stock control system fails -
the business can accept orders, but it is unable to confirm that it can fulfill
them. As can be seen from the Business Process diagram below, the Stock
Control System is accessed at the start of the Business Process to check the
stock when the order is placed, and at the end of the Business Process, when
the stock is dispatched.
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The business also has a Gold Customer scheme whereby key customers are
guaranteed their deliveries within a specified time, or significant penalties in
the way of discounts are incurred.

Using the BPI Application, the business manager receives information about
the following:

» Impact of the IT operational resource failures
» Impact of the business service failures

Using both these sets of information, the business manager now has the
Business Process data that can be used to better understand the business
impact of a failure. As an example, the business manager could define a
Business Process Monitor that records how long it takes a specific instance of
a process to move between two activities in the process. The Business
Process Insight Application shows this monitor information in terms of
statistical information relating to the process instances and their progress.
The business manager can view the information in tabular and graphical
form according to their requirements.

In addition to monitors, the business manager can request for annotations
to be added to the processes as they are displayed on the Process Diagram on
the Application Health page. These annotations can show information such
as the current value of orders waiting to be processed.

The business manager also has the option to define instance thresholds for
the Business Process Monitors and have BPI generate instance threshold
violations when the instance thresholds agreements are not achieved. The
instance threshold violations can inform them of critical business events,
due to event such as the failure of the stock control system. On receipt of a
violation, the business manager uses the BPI Application Health page or My
BSM portal (whatever their usual reporting tool might be) to query the BPI
system and obtain more information.
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As an example, they could determine the following:

» There are 200 customer orders waiting to be processed and 10 of these
customers are Gold Account Customers.

» The impact of the current rate of orders, for example, given historical
information about the rate of orders, the current number of 200 is likely
to be 1,000 within a couple of hours, and 20,000 by the end of the day.

» Using historical information, the stock float should be good for today and
tomorrow and most orders can be dispatched without incurring any
delay.

» If required, temporary manual stock control can be put in place using the
business data provided by the BPI system.

» Information about the stock levels

The stock counters configured in the BPI system can be used temporarily
whilst the stock control system is offline, so the business manager has an
ongoing count of the stock and can monitor the situation. The business
manager also knows the levels of stock in the shop, so they have the
option to fulfill orders from the stock held at the shop if necessary.

The business manager is now in a position to make a business decision to
prioritize the orders such that the Gold Customers and the high value orders
are processed first. If any of the stock levels start to get low, the business
manager can suspend the transactions, or inform customers that there
might be some delay. They can also order additional stock manually based
on the BPI data presented to them.

The introduction of BPI means that the business manager now understands
the business impact of the stock control failure and as a result can:

» Continue to process from stock in shop and redirect that stock to Web
orders if necessary.

» Use the BPI data to manage the stock float manually.
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» Aggregate shop and warehouse stock as required.

» Monitor the Gold account customers and minimize the penalty
payments.

The business events that provide this information come through the BPI
Business Event Handler components and the operational events are defined
in the RTSM as IT operational resource Cls.

& What BPI Provides

BPI provides the modeling tools that enable you to build a Business Process
and associate key business services, data and events with the process. As part
of defining the process, you need to consider what business measurements
you are likely to want to take. Later, you can add Business Process Monitors
to these processes to record these business measurements.

Using Business Process Monitor information, BPI can notify the business
manager when significant events occur and when Business Process Monitor
instance thresholds are violated; this notification can be done through
email, through the Notification Server, through the BPI Application or
through a My BSM portlet. In addition, you can create reports using the
Business Process Insight Application Reports pages.

Business managers can also receive the BPI impact reports through their
own reporting tools, if they choose to. BPI writes all its Business Process
Monitor data to database tables, which are designed and structured to
maximize the effectiveness of user and application queries.

BPI enables you to:

» Track instances of Business Processes defined and deployed within the BPI
Modeler.

» Monitor the Business Processes and Business Process Activities using the
instance-based data samples, which are sent by the BPI Server to BSM.

» Create monitors for your Business Processes and Business Process
Activities using the Monitor Definer.
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» View the health of your Business Processes, Business Process Activities and
Business Process Monitors according to objectives that you set using the
Business Process Insight or Service Health.

» View reports based on the history of the Business Process using the
Business Process Insight Application.

» View details of the Business Process instances, Activity instances and
instance threshold instances using the Business Process Insight
Application.

» Configure notification emails, HPOM messages and scripts for process
instance violations using the Notification Administration.

» Use the BPI Server Administration Console to manage the BPI Server
components.

The individual components of the BPI Server system, and their purpose, are
more fully described in the “BPI Server Architecture” chapter in the Business
Process Insight Server Administration Guide.

BPI is intended to help you raise the visibility of your Business Processes and
better understand integration points between your Business Processes and
the IT infrastructure. This provides you with improved business data and
also enables you to make business decisions, based on this data, in a more
timely manner. For example, understanding the business impact if a
particular resource is made unavailable. This might not be direct financial
loss, but other losses, such as reputation, regulation breaches, poor delivery
times and so on.

Business disruptions such as these, and hundreds more that happen on a
daily basis, unexpectedly and negatively impact the normal business
operations of many companies. For example, if you are providing a resource
and there is a sudden increase in the volume of traffic, perhaps due to a
marketing promotion, it could have an impact on the network. The
response time for customers might be seriously compromised, which in turn
can cause anger, ill-will, and some customers taking their business
elsewhere. This is not a failure in any of the underlying systems and
applications, but a failure in the capacity of the system that has an impact
on your customers.
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& Using BPI Within Business Service Management

When you install HP Business Service Management (BSM), some BPI
components are also installed, namely the BPI Modeler and the Process
Repository. A Process Repository Database is also created as part of the BSM
installation. In this configuration, you can create Business Processes and
link the Activities in the Business Process to ClIs that represent IT
operational resources. This then enables you to monitor the health of the
Business Process and the Activities in the process relative to the IT
operational resources on which they depend.

When you install the BPI Server, the BPI Application is added as a new
component to the BSM Gateway Server that you have configured within the
BPI Server Administration Console. As a result, a new Process Repository is
installed on the BPI Server system and the existing Process Repository on the
BSM Gateway Server is disabled. Communication to the Process Repository
Database is now from the BPI Server system and the data in the Repository
Database is synchronized with the RTSM.

The addition of the BPI application enables you to monitor the health of
your Business Process and its Activities as before; in addition, it enables you
to:

» Map business events to Activities in your Business Process to enable you
to monitor the business impact when there are problems with the
Business Process.

» Monitor instances of your Business Process in near-real time.

» Determine how effective your Business Process is by defining Business
Process Monitors that measure thresholds that you define.

» View and report on the status of the health of your Business Processes.

» View detailed information about each process instance in the Business
Process, the Business Process Activities and the thresholds defined for the
instances.

» Model your business’s IT processes and your supporting business
applications services. It also provides the tools to help you prioritize
problems, based on business impact and service level compliance.
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> Report on the status of operational services and how they impact your
Business Processes.

» Set service level objectives (SLOs) for the BPI configuration items (Cls),
which are managed within Business Service Management.

» Configure alerts, within the Business Service Management SLM
component, based on the SLOs that have been set on the BPI Cls.

» Enable reports to be generated, based on the BPI ClIs.
» Use MyBSM components for views of the BPI Process and Monitor data.

The following sections describe in more detail how you can use the features
of BPI within BSM for designing, managing and tracking your Business
Processes:

» “Design-Time Integration” on page 40
» “Run-Time Integration” on page 41
> “Data Samples” on page 41

» “SLM and Reporting” on page 43

Design-Time Integration

You design and subsequently deploy your Business Processes and process
Activities using the BPI Modeler. The features of the Modeler that are
available to you when designing processes depends on whether you have:

» Installed the BPI Server.

» Enabled or disabled tracking individual process instances when defining
your process.

Note: If you do not have the BPI Server installed, then you do not have
the option to enable individual process instance tracking within the
Modeler; the option is disabled.
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For details about using the BPI Modeler without and with the BPI Server
installed, see:

> “Modeling with Tracking Individual Process Instances Disabled” on
page 70

» “Modeling with Tracking Individual Process Instances Enabled” on
page 71

Run-Time Integration

When you have defined and deployed your Business Processes and Business
Process Monitors, you can then track and monitor the health of your
Business Process relative to the status of the IT operational resources on
which the process Activities depend and on the values of the data being
captured by the Business Event Handler.

For details about using the Monitor Definer without and with the BPI Server
installed, see:

> “Monitoring - Tracking Individual Process Instances is Disabled” on
page 196

» “Monitoring - Tracking Individual Process Instances is Enabled” on
page 197

Data Samples

A data sample, in Business Service Management terms, is
application-specific data sent from an application, in this case, BPI. In the
case of BPI, these data samples can be used by Business Service Management
to show key performance indicators (KPIs), relating to the imported Business
Process Business Activity and Business Process Monitor definitions. The data
samples are taken from the values of specific values in the BPI Instance
database. Data samples are sent from the BPI Server to the Gateway server
that you configure within the BPI Server Administration Console. For details
on KPIs, see “Health Indicators, KPIs, and KPI Domains” in Using Service
Health.

Samples are sent on a per group basis to BSM.
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BPI sends data samples to Business Service Management by configuring the
Data Sample settings in the BPI Server Admin Console. Sending data
samples to Business Service Management enables you to use the BPI
application to report and view the health of the Business Processes that you
create. For details on configuring the Data Sample settings, see “Component
Configuration - HP Business Service Management Settings” in the Business
Process Insight Server Administration Guide.

All the BPI data samples are mapped to the following KPIs within Business
Service Management:

KPI Description

backlog (600) The data sample for this KPI is taken from the active
value of the Business Process, Business Process
Activity, or Business Process Monitors.

business impact (602) This KPI shows the overall health of the Business
Activities in the Business Process within Business
Service Management. It is based on the number of
blocked, at risk and healthy instances reported in
the Business Process Insight data samples. This KPI
applies to processes only.

business performance The data sample for this KPI is taken from the
(631) duration of a Business Process, Business Activity, or
Business Process Monitor.

value (1311) The data sample for this KPI is taken from the
Process Activity and Process Monitor values.

volume (1050) The data sample for this KPI is taken from the
throughput value (Volume) as calculated as part of
the Business Process, Business Activity, or Business
Process Monitor statistics.

These data samples include as much information as is possible to give the
KPI context. In the case of the business health for a Business Process, the
health of the specific Business Process is reported. When reporting the
overall health, any Groups that you have defined in the Monitor Definer are
ignored, it is the overall monitor statistic that is reported.
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The time interval between data samples can be configured using the Data
Sample send interval (seconds) parameter in the BPI Server Administration
Console.

If you have not modified the BSM configuration, Service Health is
configured to show KPIs (Backlog, Volume, Value, Business Performance,
and Business Impact) based on the process value from your process
definition.

You can add or modify a KPI that you want to show within Service Health.
To add or modify a KPI:

» Select Admin > Service Health > View Management > Ci Indicators

> In the CI Types panel, navigate to the Business Process Activity that you
want to modify.

There are a range of KPIs that are available for you to configure as objectives
for your Business Processes.

SLM and Reporting
The data samples sent to Business Service Management are written to an

offline data repository.

The Business Service Management Service Level Management (SLM)
component uses the data stored in the offline data repository as a source for
building Service Level Agreements and setting Service Level Objectives, and
for creating reports.

In terms of Service Level Management, you can:

» Enable service level objectives (SLOs) to be set for the BPI configuration
items (CIs), which are managed within Business Service Management.

» Configure alerts, within the Business Service Management SLM
component, based on the SLOs that have been set on the BPI Cls.
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For information about setting Service Level Objectives, see Using Service Level
Management.

In terms of reporting, you can configure the Business Service Management
Report Administration component to generate reports based on the BPI Cls.

Refer to the Business Service Management documentation related to custom
reporting and alerting for more information.
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Tasks

P How to Manage User Permissions

User permissions determine what operations a user can perform in the
Business Process Insight application and administration pages. User or
group permissions can be set by assigning a predefined role or by granting
individual permissions on specific resources. The predefined roles relevant
to Business Process Insight are described in the subsections below.

BSM enables you to fine tune user permissions by applying permissions at
the resource level. All of the resources on which permissions can be applied
have been identified and categorized in a hierarchical tree, representing the
BSM platform. You can restrict which BPI processes BSM users can view in
the BPI application. BPI-specific resources are described in the subsections
below.

The user’s permissions in a particular session within BSM are determined by
the user’s login and authentication. User permissions are set up and
maintained on the User Management Administration page at Admin >
Platform > Users and Permissions > User Management. For information
about the related workflow, see Platform Administration. Permission changes
go into effect the next time the user logs in.

The following sections describe the BPI and BSM permissions:

» “Business Process Insight Roles and Operations” on page 46

> “BSM Predefined Roles Relevant to Business Process Insight” on page 47
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Business Process Insight Roles and Operations

Within the Business Process Insight context, the following roles and
associated operations are available:

Role Operations that can be granted
BPIAdministrator Full Control of all BPI processes.
BPIUser View all deployed BPI processes.

BPIRestrictedViewUser

View only those deployed BPI processes to which
View permission has been granted.

To grant permission to view a process:

1 Select Admin > Platform > Users and Permissions
> User Management.

2 Select a group or user in the groups and users
pane and select the Permissions tab.

3 Under Context, select Business Process Insight.

4 Open the Process Definitions folder to see the list
of BPI processes.

5 Select the required process, and then select the
Operations tab.

6 Check the View check box and click Apply
Permissions to confirm.

You must grant View permission for each process

that you want the user to be able to view in the BPI

Application.

NOTE: BPIAdministrator and BPIUser roles by
definition already have View permissions for all
processes.

Inherit

Enabled for selected Resources. When enabled,
select the check box for the operation to be
inherited to all the child resources within the
selected resource.

Due to the sensitive nature of User Data and to minimize the possibility of
accidentally granting access, only the (BSM) Administrator has User Data
access (Full Control permission).
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BSM Predefined Roles Relevant to Business Process Insight

Users and groups can be created and used to manage access to Business
Process Insight resources. However, BSM has these built-in roles that are

relevant to BPI.

Role Operation

Superuser Full Control on all BPI resources listed in the
previous table.

Administrator Add on the application resource and Full Control on

any application instances added.

System Modifier

View and Change on all BPI resources listed in the
previous table.

System Viewer

View on all BPI resources listed in the previous
table.
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Reference

@ Configuration Items Stored in the RTSM

The following table describes the BPI data that is stored in the RTSM as a
result of the synchronization. This sharing of information between BPI and
Business Service Management enables Business Service Management to
access the BPI data from the RTSM. The BPI data is stored in the RTSM as a
configuration item (CI) of several types. For more information about CI
types, see “CI Type Manager” in the Modeling Guide.

Following are the BPI CI types:

Cl Type Description
BusinessProcess Stores the Process Name and Process Description
(business_process) as entered using the BPI Modeler.

A business_process CI is created for each
Business Process in BPI.

Data samples are sent to BSM for each
business_process CI.

business_process Cls are logical ClIs.

BusinessActivity Stores the Activity Name and Description as
(business_activity) entered using the BPI Modeler.

A bpi_activity Cl is created for each Activity in
all Business Processes.

Data samples are sent to BSM for each
business_activity CI.

bpi_activity ClIs are logical ClIs.

48



Chapter 1 ¢ Introducing Business Process Insight

Cl Type Description
Business Process Scope Stores the Monitor Name, Description, Type,
(business_process_scope) Units, Collection Interval, Threshold Operator,

Server Name and Instance Threshold limits
(where specified) as defined with BPI.

Monitor data samples are sent for each Business
Process Monitor.

The value for the bpi_monitor_type attribute
defined on this CI identifies the Business Process
Monitor type. It can have one of the following
values:

» Duration

» Value

» Custom

As with any synchronization, or sharing of data, there must be a master
copy of the data to synchronize from. In this case, the BPI Server holds the
master copy of the data. This means that any changes to the data within the
Business Service Management Ul Framework are overwritten by BPI when
the data models are synchronized. If you delete a CI in the RTSM, it is
created again when the data models are synchronized.

Data synchronization occurs as a result of any one of the following:

» Business Process is deployed, redeployed, or undeployed.
» Business Process Monitor definition is created, modified or deleted.

» Related configuration changes are made within the BPI Server
Administration Console.

» Synchronization is forced using the Synchronize with the RTSM option in
Admin > Business Process Insight > Process Intervention.

As part of the synchronization process, BPI creates mapping tables, which
are used to provide the references between the BPI data and the
corresponding CI within the RTSM. The BPI unique identifiers for the data
(GUIDs) are mapped to the RTSM GUIDs for the BPI-related Cls. This
enables BPI to send data samples to Business Service Management as well as
manage the synchronization process.
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Viewing BPI Cls Within BSM

To see the Cls defined within Business Service Management:
1 Select Applications > Service Health > Service Health.

2 In the 360° tab, select Business Processes from the Hierarchy drop-down
list.

This is the list within Business Service Management that groups together
all BPI Business Processes.

3 Select a Business Process listed under Business Processes, for example,
Phone Provision.

The Phone Provision Business Process and its Activities are listed.
4 Select the Top View tab.

The root view for the Phone Provision CI and the dependent Activity Cls
are shown in the graphical view.
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The following figure shows the Business Process named Phone Provision
and its associated Activities within Service Health.
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In this example, you can see that there are also other processes deployed
and you also see these other processes within the Business Processes.
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General Administration

This chapter includes:

Concepts

» BPI Administration Overview on page 56
Tasks

» How to Administer BPI on page 58
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Concepts

& BPI Administration Overview

This section provides an overview of the key features of the BPI
Administration pages and explains how to use BPI to track and monitor
your Business Processes.

The BPI Administration pages enable you to track all the Business Processes,
Business Process Monitors and Monitor Thresholds that you have defined
and deployed, including their associated data. You can also track the status
of the IT operational resources that the Business Process relies on.

The BPI Administration pages can be accessed from the following menu
option:

Admin > Business Process Insight

Note: The Business Process Insight Administration pages are available when
you have enabled BPI on the BSM Server Deployment page, installed a valid
BPI license and the BPI Server. If you have not installed a BPI license, you
can still access the Modeler with limited functionality. For more details on
what limited functionality is available, see “Modeler Capabilities” on

page 67.
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The BPI Administration pages enable you to:

» Map business events to Activities in your Business Process to enable you
to monitor the business impact when there are problems with the
Business Process.

» Monitor instances of your Business Process in near-real time.

» Determine how effective your Business Process is by defining Business
Process Monitors that measure thresholds that you define.

» Model your business’s IT processes and your supporting business
applications services. It also provides the tools to help you prioritize
problems, based on business impact and service level compliance.
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Tasks

* How to Administer BPI

58

The following steps describe how to administer BPI.

» “Create the Business Process Definitions, Data Definitions and Event

Definitions” on page 58

» “Define Business Process Monitors and Monitor Instance Threshold

Definitions for Deployed Processes” on page 59

>» “View, Print, and Manage the Contents of the Process Repository Schema”

on page 59

» “Use the Process Intervention Client to Manage Process Instances and

Data Instances” on page 59

» “Configure the Notifications that You Want to Generate” on page 59

1 Create the Business Process Definitions, Data Definitions and

Event Definitions

You use the Modeler to create your Business Process definitions, Data
definitions and Event definitions. The Modeler is a graphical editing tool
and provides a unified interface for all the definition types that you are
creating.

The Modeler has two modes of operation, according to whether you have
a valid BPI license and have installed the BPI Server. For more
information, see Chapter 3, “Modeler Management” and the Business
Process Insight Integration Training Guide - Modeling Processes.
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2 Define Business Process Monitors and Monitor Instance
Threshold Definitions for Deployed Processes

You use the Monitor Definer to define Business Process Monitors and
Monitor instance Threshold definitions for deployed processes.

These Monitors and instance Thresholds are then used to gather statistical
information, and instance thresholds relating to the health of your
Business Processes. The results are shown using the BPI Application pages.
For more information, see Chapter 4, “Monitor Definer,” the Business
Process Insight Integration Training Guide - Defining Business Monitors, and
the Monitor Definer online Help.

3 View, Print, and Manage the Contents of the Process
Repository Schema

Use the Repository Explorer to view, print and manipulate the contents of
the Process Repository schema. The Process Repository schema is a set of
database tables that hold the data for the Business Processes that you have
defined and modeled using the BPI Modeler. For details, see Chapter 5,
“Process Repository Explorer.”

4 Use the Process Intervention Client to Manage Process
Instances and Data Instances

In specific circumstances, you can use the Process Intervention Client to
access processes that you have deployed to modify or delete Process
instances and their associated Data instances. For details see Chapter 6,
“Process Intervention.”

5 Configure the Notifications that You Want to Generate

Use the Notification option to configure the notifications that you want
to be generated for the Business Processes that you have deployed and the
Business Process Monitors and Monitor instance Thresholds that you
have defined. For details see Chapter 7, “Notification.”

After the Notification Server is configured, it can then notify you of the
process impact, out-of-sequence and monitor threshold violations that
are generated by the Business Impact Engine.
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Modeler Management

This chapter includes:

Concepts

» Modeler Overview on page 63

» Modeler Capabilities on page 67

» BPI Modeling Implementation on page 68

» Components of a Business Process on page 74

» Process Repository on page 88

» Progression Rules on page 92

Tasks

» How to Model Your Business on page 101

» How to Create a Process Diagram on page 102

» How to Define Activity Properties on page 107

» How to Define Data Definitions on page 111

» How to Define Event Definitions on page 114

» How to Deploy Business Processes on page 115

» How to Copy Definitions on page 118

» How to Delete and Restore Definitions on page 120
» How to Import and Export Definitions on page 121
Reference

» Coercion Rules on page 127

» Data Types in the BPI Instance Database on page 131
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» Expression Grammar in Process, Data, and Event Definitions on page 132

» BPI Modeler User Interface on page 146
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Concepts

& Modeler Overview

The BPI Modeler is a BPI component that you use to create your Business
Process definitions, Data definitions and Event definitions. It is a graphical
interface that provides the canvas that you use to define these definitions.
When you are satisfied that the business models are complete, you can
deploy them to the Business Impact Engine. You can also import BPEL
definitions into the Modeler and use them as the starting point for your
business Processes (see “Import BPEL Processes” on page 124).

The definitions are held in the Process Repository. The BPI Process
Repository is fully described in “Process Repository” on page 88. The BPI
Modeler provides a graphical view for accessing the definition data held in
the Process Repository.

The BPI Modeler is installed when you install Business Service Management
and is accessed from Admin > Business Process Insight > Modeling tab > BPI
Modeler.

To use the full capabilities of the Modeler, you need to enable BPI on the
BSM Server Deployment page, install a valid BPI license and the BPI Server.
Without the license and BPI Server, you can model Business Processes and
map process Activities to IT operational resource Cls; however, you cannot
create process models that enable you to monitor individual process
instances within Business Service Management. All options are visible
within the Modeler interface, but some options are unavailable unless you
have installed the BPI license and Server. For more details, see “Modeler
Capabilities” on page 67.
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64

Note: BPI must be enabled on the BSM Server Deployment page to access
the Modeler. If BPI is disabled, the Business Process Insight Application is
deactivated. For information about accessing and enabling/disabling BPI on
the Server Deployment page, see “Using BPI Within Business Service
Management” on page 39.

This section includes the following topics:

“Using Multiple BPI Modelers” on page 65
“BPI Modeler Log File” on page 65
“Exporting and Importing” on page 66

Y Y VYV Y

“Business Process Monitors” on page 67
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Using Multiple BPl1 Modelers

There can be more than one BPI Modeler connected to the Process
Repository at any one time. However, the Process Repository only supports
one person making changes to a particular process definition at any one
time. If there are multiple users connected to the Process Repository, and
making changes to definitions through the Modeler, the last person to save
their changes overwrites any changes made to the same definitions by other
users. For more information, see “Process Repository” on page 88.

The BPI Modeler has an option to enable you to export business processes,
including their dependencies (Data definitions and Event definitions) as an
XML file. This enables you to create business processes on one BPI Server for
testing and then move or import the processes to a production system when
they are fully verified. For more details, see “How to Import and Export
Definitions” on page 121.

BPI Modeler Log File

There is a Modeler log file located on the machine where the Browser is
running in the user directory as follows:

<user_dir>\.hp_bpi

The following log files are the most significant files:

hpbpi_modeller0_0.log
This log file is the most useful.
hpbpi_modeller_m.log

This log file is less informative, but does contain communication errors, if
they occur.

In addition, there are Modeler related log messages contained in the Process
Repository log file. If the BPI Server is installed, the Process Repository log
file is located as follows:

bpi-install-dir\data\log\bia_model_repository0_0.log

If the BPI Server is not installed, the Process Repository log file is located as
follows:

bsm-install-dir\log\bpi_process_repository
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The log files are text files that you can open using a text editor. Use the log
files to identify problems with your BPI system.

You can also modify your Java settings to show the Java console while the
Modeler is running. You should do this only if you are trying to isolate a
problem. You can access the Java Console options as follows:

Start > Programs > Settings > Java > Advanced > Java Console

Exporting and Importing

The BPI Modeler has an option to enable you to export and import Business
Processes, including their dependencies (any Data and Event definitions) to
a .zip file that contains XML files. This enables you to create Business
Processes using one Modeler for testing and then move the processes to a
production system when they are fully verified. You can also export and
import any Business Process Monitor definitions that you have defined for
your processes as described in “Export and Import Monitor Definitions” on
page 206.

You can also export a process definition to make a copy of the process, or
import definitions, including BPEL definitions using the import option.

You use the File > Import Definitions and File > Export Definition menu
options from the BPI Modeler to export and import your Business Process
definitions.

Make sure that you have a naming policy for Process, Data and Event
definitions across your organization to minimize the possibility of a name
clash when the Business Processes are imported for deployment to the
Business Impact Engine. You have the option to rename your definitions
when you import them; however, you might prefer to have a standard
naming scheme.
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Business Process Monitors

A Business Process Monitor is a business measurement that is meaningful to
your business and is an additional indication of the health (in business
terms) of the processes that you are tracking.

You create Business Process Monitors for your processes using the Monitor
Definer. The Monitor Definer is a Web-based interface that you access as
follows:

Admin > Business Process Insight > Monitor Definer

Full details about the Monitor Definer and using it can be found in the
Monitor Definer online Help and Business Process Insight Integration Training
Guide - Defining Business Process Monitors. See also, Chapter 4, “Monitor
Definer.”

& Modeler Capabilities

After BPI has been enabled in Server Deployment, the Modeler can be used
in the following two ways:

Partial Modeler Capabilities

Without a BPI license (and whether the BPI Server is installed), you can
create and model Business Processes and map process Activities to IT
infrastructure Cls. However, the ability to create and modify Event and Data
definitions is disabled. Tracking individual instances of the Business Process
is not permitted and some options related to this in the Modeler interface
are not enabled. You can delete any previously created data and event
definitions, but editing the same or adding any new data or event
definitions is not supported.

Note: If BPI is not licensed, you can delete any previously created data and
event definitions, but editing the same or adding any new data or event
definitions is not supported.

67



Chapter 3 * Modeler Management

Full Modeler Capabilities

To use the full capabilities of the Modeler, you need BPI enabled on the BSM
Server Deployment page, a valid BPI license installed, and the BPI Server
installed and integrated with BSM. (Application licenses are installed
through the Business Service Management License Management page at
Admin > Platform > Setup and Maintenance > License Management. For
licensing information, see the "Licenses" chapter in Platform Administration.)

When you can access the Modeler’s full functionality, you can create and
edit Business Process definitions, Data definitions and Event definitions.
And when your definitions are complete, you can use the Modeler to deploy
them to the Business Impact Engine.

In addition, you can import Business Process Execution Language (BPEL)
into the Modeler and use the BPEL definition as the start point of your
Process definition.

A local repository cache in the BPI Modeler holds Process definitions,
including Data and Event definitions until they are saved in the Process
Repository schema as a set of database tables. Definitions might also need to
be redeployed. The tables are managed by the Process Repository, which is
described in “Process Repository” on page 88.

& BPI Modeling Implementation

68

You can consider your BPI implementation for modeling Business Processes
as having three different stages:

» Design-time modeling — Enables you to design and develop your
Business Processes using the BPI Modeler. You can create, delete and
modify Process, Data and Event definitions, and link Process Activities to
IT operational resources using the BPI Modeler, but until these definitions
are deployed to the Business Impact Engine they cannot be monitored.
For details, see “Design-Time Modeling” on page 69.

» Deployment — Deploys the Business Process to the Business Impact
Engine. For details, see “Deploying Definitions” on page 73.
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> Run-time integration — Progresses the definitions that you have
developed and deployed by the events received through the Business
Events Handler, and enables you to track and monitor the health of your
Business Process. For details, see “Run-Time Integration” on page 195.

The BPI Modeler does not play any part in the run-time aspect of the BPI
system. However, any changes that are made to definitions that are
deployed, result in new and revised processes being available for tracking.

& Design-Time Modeling

You design and subsequently deploy your Business Processes and process
Activities using the BPI Modeler. The Modeler is a design-time tool,
therefore any changes that you make do not affect a run-time system until
you have deployed the changed definitions.

The features of the Modeler that are available to you when designing
processes depend on whether you have:

» Installed a valid BPI application license and the BPI Server.

» Enabled the BPI option on the BSM Server Deployment page on the BSM
user interface. For more information, see “Using BPI Within Business
Service Management” on page 39.

» Enabled or disabled tracking individual process instances when defining
your process.

Note: If BPI is not licensed, you do not have the option to enable
individual process instance tracking within the Modeler; the option is
disabled.

This section includes the following topics:

» Modeling with Tracking Individual Process Instances Disabled on page 70

» Modeling with Tracking Individual Process Instances Enabled on page 71
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70

Modeling with Tracking Individual Process Instances
Disabled

This section describes the concepts for modeling Business Processes,
including mapping IT operational resources to process Activities when the
BPI application is not licensed or you have not enabled individual process
instance tracking.

The following diagram shows design-time process instance tracking
disabled.
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The following steps describe the communication between Business Service
Management components as shown in the diagram above:

> You create your Business Processes using the Modeler. When you deploy
the Business Processes, the Modeler completes its consistency checking on
the Business Process.
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» The Processing Server forwards the RMI command to the Process
Repository, which manages how the process models are stored in the
Process Repository Schema, including synchronizing the models with the
RTSM.

» As part of creating your Business Processes, you can map IT operational
resources, which are defined as CIs within the RTSM by applications such
as SiteScope, to the Business Process Activities. BSM can then evaluate the
status of the IT operational resource Cls for later presentation within the
Business Process Diagram in Service Health.

Modeling with Tracking Individual Process Instances
Enabled

This section describes the steps for modeling Business Processes when the
BPI application is licensed and the BPI Server is installed, and you have
enabled individual process instance tracking. These steps extend the
modeling steps described in “Modeling with Tracking Individual Process
Instances Disabled” on page 70.
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The following diagram shows design-time process instance tracking enabled.
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The following steps describe the communication between Business Service
Management components when you have chosen to model processes to
track and monitor individual process instances, as shown in the diagram
above. You can model Business Processes and map IT operational resource
ClIs to the process Activities as described in “Modeling with Tracking
Individual Process Instances Disabled” on page 70.
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In addition, you can model processes to track individual process instances as
follows:

» Create your Business Process using the BPI Modeler and select the option
to Track individual process instances.

» Create the Data Definitions, Progression Rules, Event Definitions and
Event Subscriptions for your Business Processes.

» Deploy the Business Process, at which point the Modeler completes its
consistency checking on the Business Process. The Modeler sends the
definition to the Gateway Server (or load balancer) using RMI over HTTP
and the Gateway Server sends the Model definitions to the Process
Repository on the BPI Server using RMI.

» Use the Process Repository to manage how the process models and their
components are stored and synchronized in the Process Repository
Schema; this includes creating the Java class files and the Process Instance
tables in the BPI Instance database.

» Define Monitors and instance thresholds for the Business Process when
the Business Process is successfully deployed. These definitions are stored
in the BPI Instance database and are synchronized with the RTSM.

& Deploying Definitions

When you have completed the development phase of your Process
definition, you can deploy the process to the Business Impact Engine. The
Engine then creates instances of the process and tracks these instances
according to the events that are received from the underlying systems and
the status of any associated IT operational resources.

You can also deploy individual definitions, for example, you can deploy an
Event definition. In this case, the Event definition is deployed and if
necessary all the Event definition's parent definitions are deployed, plus all
the Data definitions that depend on the Event definition. If you deployed a
Data definition, the BPI Modeler deploys that Data definition, plus any (as
yet undeployed) Event definitions that the Data definition is subscribed to,
and similarly the parent Process definition.

For instructions on deploying definitions, see “How to Deploy Business
Processes” on page 115.
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Running Deployed Processes

You can consider your BPI implementation as having three different stages.
The design-time or modeling stage, the deployment stage and the run-time
stage.

The run-time stage is where the definitions that you have developed and
deployed are progressed by the events received through the Business Events
Handler. It is also where the business manager tracks their Business Process,
or processes, through the BPI Application.

The BPI Modeler does not play any part in the run-time aspect of the BPI
system. However, any changes that are made to definitions and that are
deployed result in new and revised processes being available for tracking.

Redeploying Definitions
The BPI Modeler redeploys definitions where there have been changes, it
does not redeploy definitions that are unchanged and already deployed.

When you redeploy a Process definition through the BPI Modeler, any
existing process and data instances are preserved and migrated to the new
definition.

You can remove definitions from your BPI system using the Intervention
Client. For details, see Chapter 6, “Process Intervention.”

& Components of a Business Process

74

The Business Process represents the key business activities that you want to
track from your Business Processes. A Business Process consists of the
following main components:

> “Process Definitions” on page 75

» “Data Definitions” on page 84

» “Event Definitions” on page 87
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CQ) Process Definitions

Process definitions are the graphical representations of the key business
activities that you want to track within your business. In the context of BPI,
a Business Process is presented as a series of steps and connections. The
connections are referred to as arcs. The steps are referred to as Activities.
The Activities represent the business activities and the arcs are used to show
the direction of the process. There are Start Activities, End Activities,
Business Activities and Junction Activities. The graphical Process definitions
are created through the Process Editor tab (see “Process Definition Page” on
page 170).

The components of the Process definition model are shown in the following
diagram.
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The following sections describe the Process definition components:
> “Activities” on page 76

» “Arcs” on page 80
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Activities

Each Activity type has a particular set of characteristics, but in general terms
an Activity is a component of a process and identifies one or more key
activities in the Business Process that you want to track.

An Activity in a Business Process might represent one or more business
activities, according to how much detail of the Business Process you are
modeling in order for the Business Process that it represents can be tracked.
Typically, when tracking a Business Process, you only need to identify the
key (or critical) business activities, you do not need to model the whole
process.

Activities also provide a visualization of the process (as a Process Diagram)
for development purposes and later on for tracking purposes, where the
Process Diagram is presented through the BPI Application. In particular, a
Junction Activity provides a structure to your Process diagram, indicating
logically related activities. Junction Activities are added to imported BPEL to
clearly show the start and end of structural elements of within the BPEL
process.

Example of a Stock Processing Business Process Model

The following diagram shows an example of part of a stock processing
Business Process model.
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In the example, if the stock control system is unavailable for any reason, the
process is unable to move beyond the Check Stock Available Activity. In this
case, the process is stalled until the Stock Control System is available again.
The BPI Application can show the process diagram and the impact of the
Stock Control system being unavailable.

It is through this visualization that you can present and measure the effects
of an incident in an underlying system on the process. Using this
information you can then assign, or reassign, resources to target the areas
that provide maximum business benefit.

Business Activity

This activity is a normal activity within the process that gets activated and
deactivated according to its start and complete conditions. The start and
complete conditions are the rules that you define to progress a process.

If a Business Activity is expected to be active for a period of time, while an
activity within the Business Process occurs, set different start and complete
conditions for the activity; for example, in the case of checking account
details.

If the Business Activity is instantaneous, and deactivated as soon as it is
activated, you need only set one of a start or a complete condition for the
Business Activity; for example, in the case of reducing a stock total. In this
case, the Business Impact Engine maps the start condition to the complete
condition and vice versa. When the start and the complete conditions are
the same, a Business Activity has a duration of zero (0) milliseconds when
evaluated by the Business Impact Engine.

Business Activities can, but do not have to, have arcs entering and leaving
them.
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Start Activity

This is a normal starting point for a process. The start condition for the Start
Activity must be based on the Data definition for the process, which is set
through the Related Data option for the Process definition.

You can choose to log a warning if one (or more) attempt is made to start a
process for a second time. This is where the start conditions for the Start
Activity are met more than once. If you select this option, and a second Start
Activity is activated after the process has started, the Business Impact Engine
issues a warning as the process is not progressing as expected.

This might be the case where an instance of the process has been created by
a different Start Activity, or by a Business Activity with the following flag set:

OK to start the process if not already started

If the Start Activity is instantaneous, set the start and complete conditions
as described for the Business Activity as the Business Impact Engine treats
the Activities in the same way. If your Business Process expects that the
activity related to the Start Activity is not a transient activity, set different
start and complete conditions for the Activity.

Start Activities cannot have arcs leading into them. Start Activities can, but
do not have to, have arcs leaving them.

End Activity

This is a normal end point for a process. When an End Activity meets its
complete condition the whole process is deemed to have completed, and
the Business Impact Engine is free to stop tracking it.

However, it is possible that out-of-sequence events can still arrive after this
point, so the Business Impact Engine marks the process as completed, but
continues to track it for out-of-sequence events.

If the End Activity is transient, set the Start and Complete conditions as
described for the Business Activity. The Business Impact Engine treats the
Activities in the same way. If your Business Process requires that the End
Activity is active for a period of time, set a different start and complete
conditions for the Activity.
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If a process has parallel paths, these paths should be merged before the End
Activity. If the paths are not merged, the process ends when an End Activity
is first activated, which might not be the intended behavior.

End Activities can, but do not have to have arcs entering them; however,
they must not have arcs leaving them.

Junction Activity

A Junction Activity is used to visually define the structure of the process.
Junction Activities can be used to show the start point and the end point of
specific structural elements within a process. You can also use Junction
Activities to make your process diagrams more self-explanatory; for
example, to indicate parallel paths or split paths and where the decision
points are.

A Junction Activity does not have any Start and Complete conditions, nor
can you link a Junction Activity to a CL

When you import a BPEL process, the Modeler creates a Junction Activity
for the start of each BPEL structural element, and another Junction Activity
at the end of each structural element. The Activities that represent the
activities for the process are placed within the Junction Activities.

Junction Activities cannot have a Checked-Sequence arc either entering
them, or leaving them.
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Arcs

Activities in a process are visually linked using arcs. Arcs are used to indicate
the direction of your process and the expected order that Activities are to be
executed. The fact that the Activities in your process are connected with arcs
does not imply any sequence or processing order, but it does imply an
expected order. Arcs do not influence how the process is progressed; they are
not enforced; however, Arcs are used to determine the status of a process, for
example, whether it is blocked or impeded. If you do not include arcs in
your process, BPI is unable to make as accurate a judgment of the process
state as it can when arcs are included.

This means that in most cases the arcs do not have a functional impact on
the behavior of the process and could be omitted (although the
recommendation is to include them to make it easier to view the process). If
you want to make sure that your process does progress from one Activity to
the next as shown by the arcs in the process, make sure that the end
condition for one Activity is the same as the start condition for the next
Activity in the sequence.

The exception to this is the Check-Sequence arc. If you want to be informed
when Activities in your process are executed in an unexpected order, you
can create an arc type of Check Sequence (see “Check Sequence Arc” on
page 82).

You can have many Arcs from Business Activities, indicating that there is
more than one route through the process.
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In the following example there is more than one path from the Initial
Review Activity through the process. Also note that there is a Check
Sequence arc (see “Check Sequence Arc” on page 82) defined between the
Request Report Activity and the Review Report Activity. The

Check-Sequence arc is shown as a solid line.
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Check Sequence Arc

A Check Sequence Arc is represented as a solid line between two Activities
and causes the Business Impact Engine to raise a violation if the Activities,
which are connected by the arc, are not activated in the correct order. The
connect order is determined by the direction of the arc between the
Activities. You change the properties of an arc by right-clicking the mouse
on the arc that you want to modify.

When either the start condition or the end condition for an Activity is
executed, the Business Impact Engine validates whether the complete
condition for the previous Activity has also been executed. If the complete
condition for the previous Activity has not been executed, and a Check
Sequence arc has been defined, a violation is raised.

Violations that result from a Check Sequence arc being activated are sent to
you through the BPI Notification Server, which is described in Chapter 7,
“Notification.”

An example of using Checked Arcs might be where you want to ensure that
an insurance report is not reviewed until it has been requested.
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In the following diagram, a violation is raised by the Business Impact Engine
if the Review Report Activity end condition is executed before the complete

condition for Request Report is executed. In this case, you want to make
sure that the report is definitely requested before sending it for review.

-

o
L

.

Ragues!
=~ _ FRepon

-

Dispute
Claim

~ Settle
~ Claim

=

Reject
Claim

You are advised to set Check-Sequence Arcs with care, as events can
legitimately be received out of sequence by the BPI system (and are
subsequently resolved when the complete set of events are received).
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Using Check-Sequence Arcs might result in the sequence arcs being triggered
excessively for cases where events are legitimately received out-of-order.
Out-of-order events are most likely to be received in a recovery situation,
following a system failure.

Note: You cannot use a Check-Sequence Arc with a Junction Activity.
Junction Activities do not represent activities within the Business process,
they are there to represent the logical structure of the process. It is therefore
not appropriate to have a Check-Sequence Arc entering or leaving a
Junction Activity.

CQ) Data Definitions

Data definitions are the representations of the data models for the processes
that you have defined and are held in the Engine as Business Data Objects.
As an example, in your Business Process there might be a Data definition for
a customer, for an order, or for an insurance claim. You create Data
definitions to progress a process, using progression rules (see “Progression
Rules” on page 92), or to create Business Process Monitors (see Chapter 4,
“Monitor Definer”).

Data definitions can also represent business impact data, for example, the
value of an object, and how many of a particular type of object are waiting
to be processed. This information is used when presenting the impact data
to the business manager through the BPI Application; for example, total
value of a particular customer's orders that are impacted.

You create the Data definitions in the Date Definition Editor, described in
“Data Definition Page” on page 181.
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Process Progression

As part of modeling your process, you define the data that is used to drive it.
This is the business data used to show the status of Business Activities at
particular points in the process. It is also includes IT operational resource
information; the operational resource information enables the business
manager to understand the business impact when an IT operational resource
that the process relies on fails.

The Business Impact Engine receives business events as a result of changes to
data or states in the underlying applications through the Event Handler. The
Business Impact Engine then uses the data in these events to update the
Data definitions that are defined in the Modeler.

Within the Modeler, the Data definitions are subscribed to incoming events.
The Business Impact Engine then uses this subscription information to
update attributes of instances of the Data definitions and then publish new
internal events. An internal event is one that is specific to the BPI
components and not directly related to any external activities.

The internal events are used to create or progress the process instances,
based on start and complete conditions that are defined for each Activity in
the process.
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The following diagram shows an example of an event, which is providing
the Claim Handler identifier for a particular claim, being received from a
Claim's Handling System.
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The event shown in the above diagram is signaling a change of state to an
instance of Claim data.

» In Activity 1, the Claim Event from the Claim Handling System is
intercepted by the adapter that you have developed using the BPI Event
Handler component. The Claim Event data is used to create an
update_claim event within the BPI system.

» In Activity 2, the Claim Data definition, which is subscribed to the
update_claim event, receives the event. The event details are mapped to
the Claim Data instance, including the ClaimHandlerID property, which
is derived from the claim_handler property of the update_claim event.
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» In Activity 3, the ClaimHandlerID property of a specific claim instance
has changed. The Claim Data definition publishes a business event
signaling this change. This event is called the Instance_Modified event
and is an internal business event generated by the BPI components. It
informs other BPI components of a change in the data that is being
tracked.

The Claims process subscribes to this business event and the event is used
to signal progress within the Business Process, for example the Initial
Review Activity has finished and a new Activity is starting. In this case,
the Instance_Modified event contains the ClaimState property with a
value of Reject, which in turn progresses the process instance to the
Activity Reject Claim. (Claim State was also updated from the
update_claim event.)

» In Activity 4, the BPI Application makes its periodic check of the database
to determine if there are any changes in states for the process instances it
is tracking.

> In Activity 5, the BPI Application refreshes the process instance details
that are being presented, to show the progression of the process to the
Reject Claim Activity, as a result of the Claim data being updated.

CQ) Event Definitions

The Event definitions are the business events that provide the data to
update the properties of the Data definition and indirectly progress the
Business Process. This data is used to populate the Data definitions that you
have created for your process.

These business events provide the Business Impact Engine with business
data from business applications. This business data is then used by the BPI
Application to add impact information, in the form of annotations, to the
Business Processes and by the Monitor Engine to generate the required
Business Process monitor. As an example, the BPI Application Health Page
might show the monetary value of an Activity not being available for a
period of time, or it might show how many transactions are queued and
awaiting processing at a particular Activity in the Business Process, both as
annotations on the Business Process.
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Events are received by the Business Impact Engine through the Business
Event Handler.

You can also use the BPI Event Importer to import transaction events
directly from TransactionVision. For details of integrating BPI with
TransactionVision, see “Connecting BPI With TransactionVision” in the
Business Process Insight Server Administration Guide.

You create the Event definitions in the Event Definitions Editor, as described
in “Edit Definition Page” on page 189.

& Process Repository

88

The Repository schema and the Process Repository are the server-based
components that manage the data as it is entered through the Modeler. The
details that you enter using the BPI Modeler are held in the BPI Process
Repository, which is a series of tables defined in the BPI database. The BPI
Modeler is the graphical tool for creating and viewing the model data held
in the Process Repository. These components manage the model definitions
in the database and ensure that the details are consistent and deployable.

If the Process Repository finds inconsistencies, it reports them using the
Todo List within the Modeler. The Todo List is associated with each
definition type. The Todo List reports on the consistency of the definition
and keeps track of all the outstanding issues and tasks required to ensure
that the definition is consistent and complete. A definition cannot be
deployed unless it is consistent.

Note: There can be only one BPI Modeler connected to a BPI Server
(specifically the BPI Process Repository) at any one time; otherwise, when
more than one change is made at there same time, only the last change is
saved.




Chapter 3 * Modeler Management

If you want to relate the Activities in the Business Processes that you create
to the status of the underlying operational services in your organization,
you can use Business Service Management to map the Business Processes
and Activity ClIs that are created from the process, and Activities that you
define in the Modeler.

The deployer component of the Process Repository deploys the different
definitions to their destinations as follows:

» Process definitions, including any imported BPEL definitions, are
deployed to the Business Impact Engine as compiled Java code.

» Data definitions are deployed to the Business Impact Engine as compiled
Java code.

» Event definitions are deployed to the Business Event Handler to be
mapped to events from underlying business applications.

In addition, there is a Repository Explorer, which is a Web-based interface
that you can use to view and manage some aspects of the data stored in the
Repository Database. For more information, see Chapter 5, “Process
Repository Explorer”.

Databases

When you install Business Service Management, you configure the Process
Repository schema for BPI. This schema is used to maintain the data for the
Process Definitions that you create using the BPI Modeler.

If you subsequently install the BPI Server, you configure the BPI Server
schema. This schema is used to maintain the data relating to of all the
Process and Data instances that BPI is tracking, plus Business Process
Monitor instances and their related instance threshold data. In addition, the
Process Repository schema is extended to maintain data for the Data and
Event that you create using the BPI Modeler.
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The BPI Server schema is also used to maintain status information relating
to all the Process and Data instances that it is tracking, plus Business Process
Monitor instances and their related statistical and threshold data.

BPI ClIs for Business Process CI types are stored in the RTSM.

Note: When creating Event definitions for BPI, make sure that the data you
are defining for the Business Events is within the range permitted by the
database that you are using.

Repository Explorer

The Repository Explorer is a Web-based application that enables you to view,
print and manipulate the contents of the Process Repository. The Process
Repository holds the data for the Business Processes that you have defined
and deployed using the BPI Modeler.

Specifically, the Repository Explorer enables you to:

» Browse and print definitions.

» Export the latest versions of a definition.

» Export the latest version of all definitions.

» Remove definitions and move them to the Recycled folder.

> Restore a definition that has been deleted using the BPI Modeler or
Repository Explorer.

» Permanently remove deleted definitions from the Recycled folder.

» Undeploy and permanently remove definitions that have completed from
the Recycled folder.

For more details of the features of the Repository Explorer, see Chapter 5,
“Process Repository Explorer.”
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Setting Modeler Options

Use the Modeler Options dialog to change the configuration of the BPI
Modeler. To access, select File > Options.

You can also click Options on the BPI Modeler logon dialog to change the
Modeler configuration.

Use Options to set the details related to the background grid within the
Process Definition Editor. Using the snap to grid option enables you to align
the Activities in your process more accurately and reduces the possibility of
moving Activities to bring them into alignment, which could require you to
redeploy the process.

There are three settings that you can edit:
» Snap to grid
Select the check box to activate the Snap to Grid option.
» Show grid
Select the check box to show the grid lines on the Process Editor page.
» Grid size (pixels)

Enter the number of pixels for the grid size that you want to use. The
changes take effect immediately, but do not impact the location of the
existing Activities on the Process diagram.
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& Progression Rules
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In order for a Business Process to progress, you need to define rules that
indicate the conditions under which an Activity starts and completes. These
rules are called progression rules.

BPI is a monitoring application that accepts events from business
applications and records the time at which these events satisfy progression
rules that you specify. Each Activity in a process has properties that describe
the Activity and the conditions for this process progression — these are the
Start and Complete conditions for the Activities.

The progression rules are evaluated every time a new Event is received into
the BPI system and the Data definition, which is related to the process, is
updated. Specifically, the start and complete conditions specify the
conditions for an Activity being started and completed (or activated and
deactivated). It is these conditions that provide the information to progress
the process.

This section includes:

» “Start and Complete Conditions for an Activity” on page 92
> “Styles of Progression Rules” on page 94

» “Using TransactionVision Events in the Modeler” on page 98

& start and Complete Conditions for an Activity

The start and complete conditions are based on the properties of the Data
definition that you have related to the process. The instances of these Data
definitions are populated by the Event data. You cannot create the start and
complete conditions for an Activity until you have identified the Data
definition to be used by the process, as the properties of this Data definition
are used as input for the start and complete conditions.

Note: You cannot create the start and complete conditions for an Activity
until you have entered the Related data definition for the process.
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The behavior of the Activities in the process varies according to the start and
complete conditions that you define:

» If the start and complete conditions for an Activity are the same, the
Activity is entered and exited instantaneously. This is typically the
behavior you expect for a Start or an End Activity.

» If the start condition differs from the complete condition, then typically
there is time spent on the Business Activity that the Activity represents.
This behavior is more typical of a Business Activity.

» If the Activity does not have either a start or a complete condition set,
there is no Business Activity for the Activity; however, if the Activity has a
CI assigned to it, you can track the IT operational resource status for that
Activity in the process.

The rules for the start and complete conditions are not evaluated in any
specific order, so no assumptions can be made about the position of the
Activity within the process relative to how the progression rules are
evaluated.

You also have the option of defining progression rules, which are based
directly from the properties of a Business Event; these are referred to as
Event-driven progression rules.

There is a grammar that must be used for the start and complete conditions,
and the data used to evaluate these conditions is obtained from the Data
definition related to the process. The grammar for the process progression is
explained in detail in “Grammar” on page 133. More examples of using the
grammar are provided in the Business Process Insight Integration Training
Guide - Modeling Processes.
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& Styles of Progression Rules

There is a grammar for defining progression rules, which is described in
detail in “Grammar” on page 133. However, the BPI Modeler also has some
preset styles of progression rules, which are useful for some of the more
common start and complete conditions. These are:

“Complete on First Assignment” on page 94
“Complete on Transition” on page 94

“Start and Complete on TransactionVision Events” on page 97

Y Y VY Y

“Start and Complete on Transitions” on page 96
» “Advanced Conditions” on page 97

For start and complete conditions that cannot be expressed using the preset
styles, you need to use the Advanced Condition style. Expressions that are
testing for more than one value for a property need to be entered through
the Advanced Condition style. This style is where you enter the start and
complete conditions using the full grammar.

Examples of defining these conditions are given in the Business Process
Insight Integration Training Guide - Modeling Processes.

Complete on First Assignment

This style of progression rule signals the Activity as Complete when you
assign a value to the Data property defined in the Property drop-down list.

Complete on Transition

This style of progression rule enables you to select a data property (from the
Property drop-down list) and specify the transition from one value to
another. The transition values are entered in the From: and the To: fields.
The activity for the Business Activity is signaled as Complete when a single
data property changes from one value to another value.

If you want to enter string values in the From: and To: fields, you need to
enter the string value within double quotes, for example: "string-value".
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You can also use the keyword null in either the From: or To: fields. Null
represents the property having no assigned value (the status of the property
before a value is assigned). Whereas an empty (blank) From: or To: field
represents any value as long as there has been a transition.

The following are examples of this style of progression rule:

Example 1

The following example shows the values that you enter if you want to the
process to progress from the Activity when the property MyOrder changes
from a null value to any value:

Property: MyOrder

From: null
To:
Example 2

The following example shows the values that you enter if you want the
process to progress from the Activity when the property MyOrder changes
from any value to a null value:

Property: MyOrder

From:
To: null
Example 3

The following example shows the values that you enter if you want the
process to progress from the Activity when the property MyOrder changes
from a null value to the string value "Received":

Property: MyOrder

From: null
To: "Received"
Example 4

The following example shows the values that you enter if you want the
process to progress from the Activity when the property MyOrder changes
from the string value "Received"; to one of: "Processed", "Fixed" or "Solved".

Property: MyOrder

From: "Received"
To: "Processed", "Fixed", "Solved"
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Start and Complete on Transitions

In this style, the activity for the Activity is signaled as start and complete
when a data property changes from one value to another. This can be the
same data property, or two different data properties. One data property
change is for the Activity start condition and the other data property change
is for the Activity complete condition.

This style of progression rule enables you to select different properties and
transition criteria as the basis for the Activity's start and complete
conditions.

You select a data property (from the Property drop-down list) and specify the
transition from one value to another. You select the property that you want
to use to signal when the Activity starts, and a property that you want to use
to signal when the Activity completes. This can be the same data property or
two different properties.

If you want to enter string values in the From: and To: fields, you need to
enter the string value within double quotes, for example: "string-value".

You can also use the keyword null in either the From: or To: fields. null
indicates that the property has no assigned value (the status of the property
before a value is assigned). An empty (blank) From: or To: field represents
any value as long as there has been a transition.

The following are examples of this style of progression rule:

Example 1

The following example shows the values that you enter as Start and
Complete Transitions if you want the Activity to start when MyOrder
transitions from null to any value, and complete when ShipID transitions
from null to any value:

"Start Transition
Property: MyOrder
From: null

To:

" Complete Transition
Property: ShiplD
From: null

To:
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Example 2

The following example shows the values that you enter as Start and
Complete Transitions if you want the Activity to start when Priority
transitions from O to the value 1, and complete when Priority transitions
from 1 to any of the values 5, 6, 7 or 8:

"Start Transition
Property: Priority
From: 0

To: 1
"Complete Transition
Property: Priority
From: 1

To: 5,6,7,8

Start and Complete on TransactionVision Events

If the arrival of a particular event is all that is needed to progress a Business
Process, then this information can be obtained directly from the business
event. Using this option, you can select from a list of previously defined
business events, and progress your Business Process Activities based on the
arrival of a particular Business Event.

This style of progression rule can be used in any scenario and not only with
TransactionVision.

You can also add progression rules that progress based on data within the
Business Event; this is done using the Advanced Conditions option as
described in the Integration Training Guide - Modeling Processes.

Advanced Conditions

In this style, you can enter start and complete conditions of your choice.
This gives you complete flexibility and control to enter more complex start
and complete conditions. You use this condition if your progression rule
cannot be represented by the other styles. Specifically for expressions where
you are testing for more than one value of a property.
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You need to use the Advanced conditions option if your Activity start or
complete condition is dependent on the values in two or more data
properties. Using this condition, you can enter start and complete
conditions of your choice. This gives you complete flexibility and control to
enter more complex start and complete conditions.

& Using TransactionVision Events in the Modeler

You can use the Transaction Management editor to define BPI rules and the
events that are to be sent to BPI. After the events are defined using the
Transaction Management editor, they are automatically exported to BPI, and
the Event definitions are available in the BPI Modeler. For details on
connecting BPI with TransactionVision, see “Connecting BPI With
TransactionVision” the Business Process Insight Server Administration Guide.

The events from TransactionVision that are available in the Modeler can be
used in any of the Business Processes by updating the Data definition of the
Business Process to subscribe to these events.

You can then use these events with any Activity in the Business Process to
configure the Activity's progression rules.
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The following figure shows using the TransactionVision events in the
progression rules of the Activity Properties dialog:
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You can relate Business Transactions to an Activity using any of the tabs in
the Activity Properties dialog (right-click on an Activity in the Process
Editor). The Related Transactions tab displays a filtered list of only the
TransactionVision Business Transactions that are originating the events to
which the data object subscribes. TransactionVision event subscriptions are
created in the same way as you would set up any other event subscriptions.
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If alternatively, you want a more comprehensive list of the Business
Transactions (Business Transactions could be created by TransactionVision,
Real User Monitor or Diagnostics) in the RTSM, use the Related Cls tab.

For more details on each tab, see “Activity Properties Dialog” on page 147.

Linking Activities to TransactionVision

When events from TransactionVision are used in an Activity's event
progression rules, the Business Transactions that originated the event are
automatically linked to the Activity.

If the TranactionVision events are not used in the Activity's progression
rules, but the Data definition of a Business Process has been updated to
subscribe to the events, you can manually link the associated Business
Transactions to one or more Activities of the Business Process. For
instructions on linking Activities to business transactions, see “How to
Define Activity Properties” on page 107.

A single Activity can be linked with one or more Business Transactions.
Conversely, you can link a Business Transaction to one or more Activities.

The relationship between the Activity and the linked Business Transaction
Cl is persisted in the RTSM. These relationships are displayed on the Health
page. For details, see Chapter 10, “BPI Application Health.”
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Tasks

* How to Model Your Business

There is a methodology for how you model your business to determine the
answers to business impact questions. The methodology also provides
guidelines for creating processes and identifying the Data and the Event
definitions required to provide business information that you need.

Following is a suggested order in which to carry out the tasks of designing a
Business Process model using the Modeler.

To design a Business Process model:

1

Graphically design your high-level Business Process Model

Identify the Business Processes you want to track for business impact, and
use the BPI Modeler to graphically design your high-level Business Process
model, which is called a Process Diagram.

Define the data to be maintained for each process instance

Define the data attributes that you want to maintain for each process
instance. Define the data that you need to store in the business model to
ensure that you get the correct business impact information.

Define the progression rules

Define how a process instance progresses as the data attributes change
state during the life of the process instance.

Define the data events

Define the events that you expect to receive from the underlying
application systems. Define the name of each event and its data content.

You then need some consultation with the applications people to see if
these events can be generated as you expect. For more details on how to
generate these actual events see the BPI Integration Training Guide -
Business Events.
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5 Deploy the process and test it

Use the BPI Modeler to deploy the process definition into the Business
Impact Engine. You can use tools such as the Process Simulator
(contributed utility in the contrib directory) and the BPI Application to
test out the behavior of your process, before connecting in the actual
application system adapters to generate the real data events. For details on
the contributed utility, see the HP Business Process Insight - Using the HP BPI
Process Simulator Guide, located in the contrib directory as procsim.pdf.

6 Define how you want the impact information presented to you

This is just a suggested order for defining processes. You might find that
your preference is to interchange steps 3 and 4, and define the events before
defining the progression rules. It does not matter. Each person can develop
the order that best suits them. But you can use the above steps as your
starting point.

Be aware that this process is iterative. You will revisit steps (perhaps multiple
times) as you discover more about your process and as you determine more
about the data that comes from the underlying application systems.

P How to Create a Process Diagram

102

You create your Process Diagram using the Process Editor, which is in the
Process Definition page. The Process Editor provides the canvas for creating
your process definitions. For more details about the Process Editor see
“Process Definition Page” on page 170.

Following are the tasks to create a graphical representation of a Business
Process, called a Process Diagram:

> “Create a New Process” on page 103

> “Add Activities” on page 103

> “Add Arcs” on page 104

> “Optionally, Add Check Squence Arcs” on page 105
> “Define Related Data” on page 106
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Create a New Process

1 In the Navigator pane, select File > New > Process or click the Create a
new process icon.

S

Create a new process

The Process Definition page opens with the Identity tab.

2 Assign the process a name and (optionally) a description. For example,
you might name the process Orders.

» A Process Name must be unique (within the list of Process definitions)
and must be between 1 and 40 characters.

» The Process description is an optional free-form field that you can use
to document details of the definition that you want to record.

Add Activities
To add a Start Activity:
1 Click the Process Editor tab and click the Start Activity icon B

The cursor changes to a move cursor and remains this way so that you
can continue to move Activities until you have placed them all.

2 Move the cursor to the location where you want to place this Start
Activity, and single click.

To add Business Activities:
1 Click the Business Activity [ icon.

2 Move the cursor to the location where you want to place the first Business
Activity and single click.

3 Move to the location you want to place the second Activity and single
click.
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To add an End Activity:
1 Click the End Activity < icon.

2 Move the cursor to the location where you want to place the End Activity
and single click.

To stop adding Activities:
» Click the Select mode M icon.
Your cursor returns to a selection cursor.
To move Activities:
1 Click the Select mode icon.

2 Move the cursor to the edge of the Activity - but not within the center
section of the Activity.

The cursor changes to a cross with arrow heads icon.

As you move the cursor over the Activity, the center of the Activity is
highlighted, but do not place the cursor over the highlighted center part.
The central part of the Activity is used for drawing an arc (see “Add Arcs”
on page 104).

3 Cick-and-hold down the mouse while you drag the Activity to its new
location.

4 Release the mouse when the Activity is in the location you want.

Example of Placed Activities

|| | | <

Activity Activityl  Activity2 Activity3

Add Arcs
Complete the following steps to add Arcs:
1 Click the Select mode M icon to connect the Activities with arcs.

2 Display the process that you want to create through the Process Editor.
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3 Hold the mouse pointer over the center of the Activity that is the start
point for your Arc; the shape of the cursor changes from an arrow to a
Cross.

4 Left-click in the center of the Activity and drag the pointer to destination
Activity for your arc. An arc is then created between the two Activities.
The arc is shown as a broken line and has an arrow head to show the
direction of the process.

5 Save the process.

6 If you are adding arcs to a previously deployed Business Process, redeploy
the process.

Example of Placed Activities with Arcs

|| ][ <

Ackivity Activityl Activity 2 A ctivity 3

Complete the following steps to delete an Arc:
1 Display the process that you want to modify through the Process Editor.
2 Left-click the Arc that you want to delete.
The Arc changes color when it is selected.
3 Select Delete from the menu.

4 Save and redeploy the process.

Optionally, Add Check Squence Arcs

Complete the following steps to create a Check-Sequence arc:
1 Add a regular Arc.

2 Right-click on the newly created Arc.

A menu list is displayed, which includes a Check Sequence option.
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3 Select Check Sequence and the arc changes to a solid line to show that it
is a Check Sequence arc.

You can change a regular Arc to be a Check-Sequence Arc and a
Check-Sequence arc to be a regular arc by right-clicking on the arc between
two Activities and toggling the menu item on and off.

Define Related Data

The properties for Related Data enable you to relate the Data definition that
you have defined to this process. You need to supply details of the Data
definition whose content is used to progress this process. If you do not relate
a Data definition to the process, there are no properties to select from when
entering progression rules. For detailed descriptions of each option, see
“Process Definition Page” on page 170.

To define related data:
1 Select whether you want to track individual process instances.

2 Select the Data definition that you want to relate to the process from the
drop-down list of Data definitions that have been defined through the
BPI Modeler.

3 Enter the name that you want to give to the relationship and is referenced
within the start and complete conditions. The Relationship name must be
between 1 and 40 characters and must begin with an alpha character and
thereafter can contain only alphanumeric characters and the underscore
character.

4 Select the Identity property from a drop-down list containing all of the
properties of the related Data definition. You must select one of these to
be used to identify different instances of the process and it can be any
property of the Data definition.

5 Select the property that you want to define as the Process Value property
from the drop-down list. This list contains all of the Process Value
properties of the related Data definition. You can select only numeric
properties to be Process Value properties; non-numeric properties are not
available for selection.
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6 Optionally select a Group.

The Group Property list contains all of the properties of the related Data
definition, but only the string properties can be selected. Select the
property that you want to use as the Group Property from the drop-down
list. A Group Property drop-down list appears on the client pages with
your pre-defined groups already collecting data (for example, East Coast,
West Coast, and so on). If the Group Property was not set, or set to None,
the Group Property drop-down list does not display in any of the client
pages.

T How to Define Activity Properties

You define Activity properties in the Activity Properties dialog.

1

Right-click on the Business Process Activity you want to define and select
Properties.

The Activity Properties dialog opens.

Select the following tabs to define the Activity’s properties:
» “Activity Tab” on page 107.

» “Progression Tab” on page 108.

» “Related CIs Tab” on page 109.

> “Related Transactions Tab” on page 110.

Activity Tab

To add the Activity name, complete the following steps:

1

Enter the Activity Name and (optionally) a description. For example, you
might name the Activity, Review Report.

> An Activity Name must be between 1 and 40 characters.

» The Activity description is an optional free-form field that you can use
to document details of the definition that you want to record.

2 Select the Type of Activity in the Activity drop-down list: Start Activity,

Business Activity, End Activity or Junction Activity.
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Optionally, select a file name from the drop-down list of an image that
you want to be displayed in place of the standard Process Activity image.

The drop-down list provides the file names of images that you placed in
the BSM Gateway Server and the BPI Server. For complete details, see,
“How to Customize Your Process Diagram” on page 403.

Progression Tab

From this tab, you define the Progression Rules to progress the Business
Process. For details, see “Progression Rules” on page 92.

To add Advanced start and complete conditions to an Activity, complete the
following steps:

1

From the Progression Rules tab, select the Advanced conditions style of
progression rule.

Click the ellipses next to the box labeled Start Condition. You are
presented with an Activity Start Condition dialog.

Enter the expression for the start condition for the Activity.

You can use the tree structure to navigate to the Data properties that you
want to include in the expression to save time and typing errors. Use the
grammar rules to construct your expressions. The grammar rules are
described in Reference Information for Business Process Insight. Add the
Data definitions into the Entry window using the Paste button.

4 Click OK to add the start condition to the Activity.

5 Click the ellipses next to the box labeled Complete Condition. You are

6
7

presented with a Activity Complete Condition dialog.
Enter the expression for the complete condition for the Activity.

Click OK to add the complete condition to the Activity.

You can see how the various styles of progression rules are specified by first
entering parts of the rule using a simpler rule option and then selecting the
Advanced option. This gives you a starting point for your more complex
rule.
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When entering property values for progression rules in the BPI Modeler be
aware that the Oracle Server does not distinguish between a zero-length
string and a string with a value that has not been assigned (null string). This
means that if you want to test a zero length string within a start or complete
condition, you are advised to use a single blank space (" "), and not an
empty string ("").

Related Cls Tab

This is where you can link the Activity in the Business Process to IT
Operational Resource Configuration Items (Cls) within the RTSM.

To link Activities to IT Operational Resource Cls, complete the following
steps:

1 From the Related ClIs tab, browse or search for one or more Cls you want
to relate to the Activity.

2 Move one ore more CIs to be linked, to the right pane using the right
arrow.

3 Deploy or redeploy (if already deployed), the Business Process to commit
these CI dependencies to the RTSM.
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Related Transactions Tab

From the Related Transaction tab, the Business Transactions that originated
from the TransactionVision event are listed.

To link Activities to Business Transactions, complete the following steps:

1 Open the Transaction Selector dialog by clicking the Transaction Selector
o icon.

| Acinity || Progression || Relsted Cls || Fedsted Trandactons

L3 Transaction Selactar

[This nctinvity is related fo the folowing business transcations The related dota definition must
pubscribe to Tranagction\ision everts to make the associsted Business Transactions
ervadabie here

Seieci Business Transactions:

.
Bond Trade Tratinte Cunly Trads

{1 Bord Trade Submit Foem
8] BondTrade/Process Trade Successiul
1] Bond Trade/Cunly TradeFallre
B BoruITrade Raques Trade

Bord Trae/Trade Succes sl

Borid Trace/Cualily Trade Success
(Bl Bord Tiadde il sProcass Trade
- -EI:I Bond Trade/Frocess TrodeDropped

2 Select the Business Transaction and click OK.
The Business Transaction is now linked to the Activity.

3 Follow steps 1 - 3 to link other Activities to Business Transactions.
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* How to Define Data Definitions

The following steps describe how to define the Data definition that is related
to the Process definition:

> “Add a New Data Definition” on page 111
» “Define Data Properties” on page 112

» “Define Subscriptions” on page 112

Add a New Data Definition
1 Select File > New > Data.

The right-hand pane displays a new Data Definition page and a new Data
definition entry is added to the tree view in the left-hand Navigator pane.

Note: If the menu option for creating a new Data definition is not
available, you need to install the Server component of HP Business
Process Insight and a valid BPI license. Without this Server component
and license, you can model Business Processes and map process Activities
to IT operational resource CIs. However, you cannot create process models
that enable you to monitor individual process instances within Business
Service Management. This includes creating Data definitions. All options
are visible within the Modeler interface, but some options cannot be set
or modified unless you have installed the BPI Server component of
Business Service Management.

2 In the Identity tab, enter the Name and (optionally) Description of the
Data definition. For details, see “Data Definition Page” on page 181.
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Define Data Properties

Click the Properties tab to define the data properties/attributes that make
up this Data definition.

You can create and delete properties, or you can copy details of a property
from another Data or Event definition. For descriptions of the Data
properties, see “Data Definition Page” on page 181.

Define Subscriptions

A Business Data definition needs to include references to the Events that it
subscribes to in order that the properties of the Data definition can be
updated from the data in the event.

To create an Event Subscription for a Data definition, you first need to create
the Event definition that the Data definition will subscribe to. This event
includes the data that you expect to obtain from underlying business
applications. You now need to configure how these events update, or
populate, the Data definitions that you have defined. It is possible that one
event is used to update more than one Data definition, so it is not an
automatic one-to-one mapping between an Event and Data definition.

The events that you define also need to be associated with the appropriate
Data definition (or Data definitions) - this is achieved through the
Subscriptions tab. When an event is received into the BPI system, the values
of the properties of the event are used to populate the properties of the Data
definition and subsequently progress the process based on the progression
rules.

When you select the Subscriptions tab for a specific Data Definition, the
names and descriptions of all the subscriptions currently assigned to the
Data Definition are listed. From this page, you can create and delete
subscriptions and you can also view the properties of a subscription to create
or moditfy it.
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To create a subscription:

1 Click in a new row of the subscription table, or click the Insert a new row
into a table :*; icon. This opens the Event Subscription dialog. Use this

dialog to create the properties of the subscription.

If you want to edit an existing subscription, select Edit > Properties (or
click the Properties icon above the subscription table) to open the
Event Subscription dialog. Use this dialog to modify the properties of the
subscription.

Note: When entering property values for subscriptions be aware that the
Oracle Server does not distinguish between a zero-length string and a
string with a value that has not been assigned (null string). This means
that if you want to test a zero length string within a subscription, you are
advised to use a single blank space (" "), and not an empty string ("").

2 Add the following information to create an Event subscription for a Data
definition:

> Event

This is the name of the Event that the Data definition is subscribing to.
» Description

This is an optional free-form description of the subscription.
» Event is for a specific instance of this data object

This specifies whether the Event data updates a specific instance of this
Data definition, or whether the Event updates many instances of this
Data definition. Typically, the Event is for a specific instance of the
Data definition. When this option is selected, additional data is also
required. For detailed descriptions of the additional data, see
“Subscriptions Tab” on page 185.
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* How to Define Event Definitions
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When creating Event definitions for BPI, make sure that the data you are
defining for the Business Events is within the range permitted by the
database that you are using.

The following steps describe how to define the Event definition that is
related to the Process definition:

> “Add a New Event definition” on page 114

» “Define Event properties” on page 114

Add a New Event definition
1 Select File > Event.

A new Event definition is opened in the right-hand pane with a default
event name.

2 Enter the name and an optional description of the Event definition
through this dialog.

This is a unique name (within the list of Event definitions) and must be
between 1 and 40 characters.

Define Event properties

You enter the details of the individual properties of the Event through this
dialog.

1 Enter a unique Name for the property. An Event property name must be
between 1 and 40 characters. The name must start with an alpha
character, roman numeral, currency symbol or underscore (_); thereafter
the name can consist of the same set of characters, plus numeric
characters. Property names must not contain spaces.

2 Enter the Type, which can be a string, double, integer, currency, date,
long and Boolean.
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P How to Deploy Business Processes

Before deployment, you have either created a new definition in the
repository that the Business Impact Engine does not know exists, or have
created a new undeployed revision of a definition by making changes to it.

The following steps describe how to deploy and undeploy Business Process
definitions:

» “Deploy Definitions” on page 115
» “Undeploy Definitions from the BPI Modeler” on page 116

Deploy Definitions

To deploy the Process, Data and Event definitions to the Business Impact
Engine, complete the following steps:

1 Open the Modeler.
2 Select the Process from the left-hand Navigator pane.
3 Select File > Deploy.

You are prompted to save all currently unsaved changes, if you have not
saved them already. Click Yes.

The Deploy dialog opens, which lists the definitions that are to be
deployed as a result of issuing this command.

If you have previously deployed the process, the Deploy dialog lists the
definitions that are to be deployed. The dialog also indicates that a
previous version of the process is already deployed. In this case, you need
to select one of the following options for deployment:

> Replace the existing definition.

This replaces the definition and retains all the instances of the
definition. Any statistical information collected for the instance is also
retained.
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> Deploy the definition with a different name.

This enables you to deploy the definition using a different name, and
therefore preserving the instance information for the existing
definition. If you select this option, select Next to make a copy of the
definition.

The Modeler checks the state of all the definitions that you selected to
deploy. A dialog box appears to prompt you to confirm that you want to
deploy all currently undeployed changes to the Business Process and all
its dependencies.

4 Click Deploy to confirm your request and continue with deployment.

The process and all its dependencies (Data and Event definitions) are
deployed to the Business Impact Engine and appropriate Cls are created
in the RTSM. A dialog lists all the definitions that are deployed.

5 Click Close when the Deployer indicates that it has finished deploying the
definitions.

You have now deployed the process and its dependencies.

The process (and all other deployed definitions) change status in the
Navigator pane, indicated by the icon.

Undeploy Definitions from the BPl Modeler

There are circumstances where you might want to undeploy one or more of
your Business Processes. In addition, you might need to undeploy individual
definitions from the BPI Process Repository; for example, you might need to
undeploy Event definitions when an Event becomes out of date.

Note: If you undeploy a definition, existing instances using the definitions
are still running in the Business Impact Engine until completion, or until
the Instance Cleaner deletes them. New instances of any undeployed
definitions are no longer created. The definition is removed by the Model
Cleaner as described in the "Modifying the BIE Model Cleaner Settings" in
the Business Process Insight Server Administration Guide.
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You can undeploy a definition that is referenced by another definition, so
you need to make sure that you maintain consistency within your Business
Processes.

To undeploy a Process, Data or Event definition complete the following
steps:

1 Open the Modeler.
2 Select the definition that you want to undeploy from the Navigator pane.
3 Select File > Undeploy.

The Undeploy dialog opens with a list of the definitions to be
undeployed.

4 Click the Undeploy button to continue.

The Deployed? status of the definition changes from Yes to No, but can
be deployed.

The Summary Window in the BPI Modeler now shows the revised status
of the definition, which is the time the definition was last saved.

If you have modified a definition, it is shown as not being deployed;
however, an earlier version is deployed. If you want to know what the
deployed status of definitions is (as opposed to a development status), use
the Repository Explorer, see Chapter 5, “Process Repository Explorer”.

You can also use the Process Intervention Client to show you the status of
the definitions, as described in Chapter 6, “Process Intervention.”
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The following steps describe how to copy definitions:

» “Copy Process Definitions” on page 118

» “Copy Properties Between Data and Event Definitions” on page 119

Copy Process Definitions

To make a copy of an existing Process definition, complete the following
steps:

1 Complete steps 1 to 5 from the steps in “Export Process Definitions” on
page 122 to export the Process definition.

2 Sclect File > Import Definitions.
3 Select the exported Process definition that you are copying and click Next.

You are presented with an Import Definitions dialog, which presents a
number of import options and actions. The default action is Import
Original Definition; however, in this case, you want to make a copy of the
definition. To do this, you need to select the Create new copy of
definition action from the drop-down Import Action list provided.You
can also choose to exclude specific data or event definitions from the
copy that you are making.

4 Configure the Import Action on the Import Definitions dialog to make
the required copy of the definitions that make up the Process definition
that you are copying.

5 Double-click the name of each definition in the New Name column of the
dialog and enter a new and unique name for each definition that you are
copying. Make sure that you rename the Process, Data and Event
definitions.

6 Click Import to import the new copy of the Process definition. The new
copy of the Process definition appears in the Navigator Pane.
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Copy Properties Between Data and Event Definitions

Using this option enables you to create properties in your Data definition
that match the properties of an Event definition that it subscribes to.
Similarly, it can be used to create properties of an Event definition that
match those in a Data definition.

Using the copy function saves the need to define identical properties for
your Data and Event definitions multiple times.

To copy properties from one definition to another definition, complete the
following steps:

1 Open the definition whose properties you want to define.

The properties that you select in the following steps are copied to this
definition.

2 Select the Properties tab for the definition.
3 Select the Copy Properties option from the Tools menu.

You are presented with a Copy Properties dialog that has a tree definition
of all the Data and Event definitions currently defined.

4 Select the definition whose properties you want to copy.
You cannot copy a property that already exists in the selected definition.

5 Select the properties within the definition that you want to copy. You can
use the Select All option to select all the properties.

6 Click OK and the selected properties are copied to the definition that you
opened in step 1.

You have now copied properties from one definition to another definition.
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T How to Delete and Restore Definitions
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You delete and restore defintions using the Process Repository. For more
details, see Chapter 5, “Process Repository Explorer.”

Delete a Definition

You can select and delete any definition from the Navigator pane.

To delete a definition:

1
2

4

Select the definition that you want to delete from the Navigator pane.
Select Edit > Delete.

The BPI Modeler displays a message asking you to confirm that you want
to go ahead with the Delete action. The message also informs you if the
definition your are attempting to delete is currently deployed.

Click Yes to continue with the Delete action.

The definition is removed from the Navigator pane in the Modeler and is
added to the Recycled folder, which can be viewed from within the
Repository Explorer. If the definition was deployed within the Modeler it
is set to be undeployed when it is moved to the Recycled folder.

Click No if you want to abort the Delete action.

The definition has now been removed from the Modeler. You can restore the
definition at a later date if you want.

Note: You must also modify any other definitions that reference the
definition that you have deleted and redeploy the processes if appropriate.
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Restore a Definition

When you delete a definition from the BPI Modeler, it is moved to the
Recycled folder, which can be viewed from the Repository Explorer.

You can restore the definition back to the Modeler from the Recycled folder
using the Repository Explorer at any time, assuming you have not
permanently deleted the definition from the Recycled folder.

For more details and instructions on restoring definitions, see “How to Use
Repository Explorer to Complete Tasks” on page 215.

T How to Import and Export Definitions
The following steps describe how to import and export definitions:

“Export Definitions to Recover Unsaved Changes” on page 121
“Export Process Definitions” on page 122

“Import Process and BPEL Definitions” on page 123

Y VY VY Y

“Import BPEL Processes” on page 124

Export Definitions to Recover Unsaved Changes

If the BPI Modeler loses its connection to the Process Repository for any
reason; for example, the BPI Server has been shutdown to reconfigure a
component, you cannot continue and modify your Process definitions.

If you have made changes to your definitions, but not saved the changes,
you have the opportunity to export these changes to a recovery file before
closing the BPI Modeler.

Note: If you close the BPI Modeler without exporting your unsaved changes,
the changes are lost.
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As soon as the BPI Modeler realizes that it has lost its connection to the
Process Repository, it presents a dialog for you to enter the name of the file
where you want to save your modifications. The next time that you start the
BPI Modeler and the Modeler successfully connects to the Process
Repository, you are presented with a dialog that enables you to select the file
where you saved your changes to import them back into the Process
Repository.

If the BPI Modeler loses its connection to the Process Repository, and all
your definitions are up-to-date, you are informed that the BPI Modeler must
exit, and that no data is lost.

When you have exported the unsaved modifications, the file that is created
is the same as the files created using the Export option and you can import
the file at a later time if required or preferred.

The file used to store the definitions for recovery purposes is not deleted
after the recovery process is complete. It is therefore available in the future if
you wanted to import your modifications again for any reason.

Export Process Definitions

Use the File > Export Definition option to export the Business Processes to an
XML .zip archive file. When you have exported the file, you can copy the
file to the system where the BPI Modeler that you want to import the file to
is installed. Finally, use the Import option to import the Process definitions
as described in section “Import Process and BPEL Definitions” on page 123.

To export a definition, complete the following steps:
1 Select the definition that you want to export from the Navigator pane.
2 Click File > Export Definition.

3 Specify the directory and file name where you want to create the .zip file
for the definition.

4 Click Export.
5 Close the Export Definition dialog.
6 Copy the file to the target system.
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7 Click File > Import Definitions in the Modeler on the target system to
import the definition. When the Process definitions are successfully
imported they are shown as being undeployed in the BPI Modeler.

8 Make any necessary amendments to the definition.

9 Click File > Deploy to deploy the definition to the target BPI Server
system.

Import Process and BPEL Definitions

You can use the BPI Modeler to import Process definitions and Business
Process Execution Language (BPEL) definitions. You import a zip archive file
containing a previously exported definition from the Modeler, or a BPEL
process file. In order for the Modeler to recognize the files, the zip archive
file must have a file extension of .zip, and the BPEL process file a file
extension of .bpel. If your BPEL process file has a .xml file extension, you
can rename it to .bpel before importing it into the Modeler.

To import a previously exported Process, Data or Event definition, or to
import a BPEL file, complete the following steps:

1 Select File > Import Definitions.
The Import Definitions dialog opens.

2 Navigate, or browse, to the location of the previously exported definition
file you want to import and click Open.

The file must be either a zip archive file or a BPEL process file.

» If you import a zip archive file, the content of the Description field
that you entered in the Modeler to describe the process is displayed as
the Description.

» If you import a BPEL process files, the name of the process is displayed
in the Description field. If this information is not available in the file
to be imported a suitable message is displayed instead, for example:
This BPEL file contains an un-named process.

123



Chapter 3 * Modeler Management

124

3 Click Next to move to the next option.

The next step that is displayed in the Import Wizard depends on the type
of file you are attempting to import: a zip archive file containing a
previously exported definition, or a BPEL definition file.

You are presented with a dialog that lists the content of the definition file
that you are importing.

From this dialog, you can:

>» import a listed definition and overwrite any existing definition of the
same type that has the same name.

> create a new copy of a listed definition or rename an existing
definition. For this option, you provide a new name for the definition
in the Save As column.

» choose not to import a listed definition.
When you have tailored your import requirements, click Import.
4 Click Close to complete the import.

When the Process definitions are successfully imported they are shown as
being undeployed in the BPI Modeler. You now need to deploy the imported
Processes and their dependencies to the target BPI Server system.

Import BPEL Processes

You can use the BPI Modeler to import Business Process Execution Language
(BPEL) definitions.

You import the structure of a BPEL definition using the BPI Modeler;
however, you cannot import the associated BPEL logic. When you have
imported the BPEL definition, you can use the structure as the basis of a
Business Process, which you can then modify to suit your reporting and
tracking requirements. You also need to create the Data and Event
definitions required to track the imported BPEL definition.

Details of importing BPEL definitions, and the options available for tailoring
the definitions when importing them are provided in Business Process Insight
Integration Training Guide - Importing BPEL.
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If you are importing a BPEL process file, you are presented with an Import
Definitions dialog that presents a number of options that you can use to
determine how the BPEL file is imported and also how the resulting process
is presented within the BPI Modeler.

To import BPEL processes, complete these actions as follows:
1 Replace existing Process definition:

You can either create a new Process definition using the imported BPEL,
or you can replace a process that already exists within the Process
Repository. To do this, either select the option to create a new Process
definition, or select the name of the Process definition that you want to
replace.

The default option presented is to create a new process. This means that if
you import a BPEL process more than once, you create multiple copies of
the process, all with the same name. If you have modified the Name
Generator file to specify your own naming convention, then the option
to create a new process is the option you need. You can also select a
process from the drop-down list provided, but you need to make sure you
are not overwriting a different process definition.

2 Include optional parts of the process?

BPEL provides a wide range of features, not all of which are appropriate
for monitoring purposes. You have the option to remove some of these
functions when the BPEL is imported into the Modeler. Specifically, you
can include, or remove, fault handlers and compensation handlers from
the imported BPEL. Select or clear the check boxes as appropriate for your
requirements.

3 Name generator file:

The name generator file is optional, but when specified is used as a source
for building the name of the process and the names of the Activities as
the BPEL process is imported into the Modeler. If no name generator file
is specified, a default name is assigned to each Activity and to the process.
For details of how to use a name generator file for building Activity names
see the Business Process Insight Integration Training Guide - Importing BPEL.

125



Chapter 3 * Modeler Management

126

4 Process diagram layout.

You can influence how the BPEL diagram is displayed on the Modeler
canvas when it is imported. This is done by modifying the values of the
layout attributes as follows:

a Grid cell size: The size (in pixels) of the cell border used for each

Activity on the process diagram. If you have particularly long Activity
names, you might need to increase the grid cell size to prevent the
Activity names overlapping other Activities.

Gaps between Activities: The size (in pixels) of the gap between the
Activities on the process diagram.

Page border: The size (in pixels) of the border that is created around
the process diagram. If you intend to expand the process diagram, you
are advised to create a reasonably sized border for the additional
Activities. The additional space is added to the left-hand side and
right-hand side of the diagram and to the top and bottom of the
diagram.

Minimum page size: The minimum size (in pixels) of the canvas for
your Process diagram. If you set these values to be very low, the page
size for your canvas will be the same size as the Process diagram;
therefore, if your Process diagram consists of only one Activity, the size
of the canvas remains the same. In this case, you might not leave
sufficient room to add to or modify your Process diagram.

5 Click Import to import the new copy of the definition.

The new copy of the definition appears in the Navigator Pane and the
import is complete.
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Reference

®. Coercion Rules

This section describes the rules for how properties are coerced when
evaluating binding, filter and assignment expressions. This is an enforced
evaluation by the BPI Modeler, based on the rules described in this section.

Valid data types for use within BPI are:

> String
» Numeric, which can be one of:
> Integer
> Long
» Double
» Currency
> Boolean

» Date
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Assignments

The following table shows how assignments are coerced:

Data Type

Assigned from...

String

Any type

Numeric

Any other numeric value (with possible
truncation if assignment is to an integer), or
from Strings provided that the string is numeric.
If the assignment does not produce a valid
number, you receive an error similar to the
following in the Business Impact Engine log file:

Cannot assign value prop-name to property
prop-name as it is not a compatible type.

Boolean

Other Boolean values, or from Strings provided
that the string is either true or false. If the
assignment does not produce a valid Boolean
expression, you receive an error similar to the
following in the Business Impact Engine log file:

Cannot assign value prop-name to property
prop-name as it is not a compatible type.

Date

Other Dates or a Numeric value (treated as
number of milliseconds since 1970).
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The following table shows how values within expressions are coerced.

Operator Behavior

Arithmetic: Supported between Numeric properties or values

+ that can be coerced to numeric using the
assignment rules described in “Assignments” on

) page 128.

/

%

Comparison: The comparison operators can be used to

< provide the following:

<= » Numeric comparison between Numeric

properties or values that can be coerced to

- numeric using the assignment rules described

I= in “Assignments” on page 128.

> » Date comparison between Date properties.

>= » Alphabetic comparison (locale-specific)

between String properties or values that can
be coerced to Strings using the using the
assignment rules described in “Assignments”
on page 128 (including Boolean).
The result of a comparison is always a Boolean
value.

String tests:
starts()
ends()

contains()

in()

Performs a test on a String property.

Note that these tests cannot be applied to
non-string properties.
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Operator Behavior

Logical: Supported between Boolean properties or values

I (Not) that can be coerced to Boolean using the
assignment rules described in “Assignments” on

&& (And) page 128.

Il (Or)

Conditional value if, then,
else:

?:

First operand must be Boolean or be coerced to
Boolean, other operands can be any type;
however they must be the same each other.

Using null Within an Expression

The BPI Modeler permits only the equals and not-equals tests with the null
constant. However, there might be expressions using other operators
involving values that are null when these expressions are executed. For
example, how is the following expression evaluated when index is null?

index + 1

The following table shows the rules that apply when comparing data items
within an expression where one data item contains a null value.

Operator

Comparison

I=

Returns TRUE if the other operand is (or is not)
null.

All other comparison operators

Always return FALSE.

For example the following expressions both
return FALSE if index is null:

>» index > 10
» index <= 10

Arithmetic operators

Arithmetic operators for expressions containing
a null value always return null as the result, for
example:

index + 1 returns null if index is equal to null
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Note: The null constant is case sensitive and when used in Java expressions,
should always be lowercase.

%@ Data Types in the BPI Instance Database

When handled as instances by the Business Impact Engine, these data types
are stored in the BPI Instance database as shown in the following table:

Descriptive SQL SErver Oracle Data Descrintion

Data Type Data Type Type P

string nvarchar varchar2 Variable length character field

date datetime date Fixed-length data and time
field

integer int number(10) | Single-length integer

long bigint number(20) Double-length integer

text text clob Variable-length single-byte
character data

float float float Real Number

currency decimal number Decimal number with a fixed
number of decimal places

variable-length | ntext clob Variable-length text up to

text 1GM (ntext) and 4GB (clob)

variable-length | image blob Variable-length binary file up

binary to 2GB (image) and 4GB (blob)
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® Expression Grammar in Process, Data, and Event
Definitions

132

This section lists the rules for the grammar that can be used for Business
Process progression rules and expressions, and expressions within Business
Process Monitor filter definitions.

The progression rules and expressions are within the BPI Modeler for the
start and complete conditions for Activities, and for filter expressions for
Data definitions when subscribing to events.

Business Process Monitor filter expressions are used within the Monitor
Definer to optionally specify the conditions for collecting statistical data for
the Business Process Monitors.

The grammar used for expressions is similar to Java expressions. The
following sections describe the grammar and its construct. Further examples
of using this grammar are provided in the Business Process Insight Integration
Training Guide - Modeling Processes.

» “Grammar” on page 133
» “Example Expressions” on page 134

» “Function Return Values” on page 138
» “Process Progression Rules” on page 139
>

“Case Sensitivity for Expressions” on page 145
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Grammar

The following is an informal description of the grammar, showing how
expressions can be constructed. Note that this construct is subject to specific
limitations according to how it is being used. Examples of using the
grammar are provided in the following sections.

expression =>
property-value = expression
| expression + expression

| expression - expression

| expression * expression

| expression / expression

| expression % expression

| - expression

| expression && expression
| expression || expression

| expression

| expression == expression
| expression > expression

| expression >= expression
| expression < expression

| expression <= expression
| expression != expression

| (expression)

| expression ? expression : expression
| value

value =>
constant_value
|property_value
|function_return_value

See “Function Return Values” on page 138 for possible values for
function_return_value.

constant_value =>
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string_contant
|integer_constant
|real_constant
|true

|false

|null

property_value =>
root_object.relationship_name.property_name
where:

> root_object is this or event.
If no root_object is specified, the expression assumes this.

> relationship_name can be included zero or more times, depending on
how the property relates to the root object.

Possible property_value expressions are:

» this.property
> this.data.property
» event.property

> property

Example Expressions

You cannot enter an expression that is contained in parentheses and follow
it with one or more function calls. For example, the following expression is
not accepted by the BPI Modeler:

(this.property).after() > 3;

The following shows the same example in a form that is acceptable to the
BPI Modeler:

this.property.after() > 3;



Chapter 3 * Modeler Management

The following table shows some examples of the Progression Rules that you
can use:

Progression Rule Example Description

this.data.created(); This is an example of an expression that starts
the process. It evaluates to true when the Data
instance that fulfills the condition is created.
This expression enables the start condition for
the Activity to be met when a business event
is received that creates an instance of the
related data definition for the Activity.

You can also use .terminated() to test a data
instance status.

this.data.Call_Status.changed(); | This expression tests whether a data property
has changed. The expression evaluates to true
if the data property has changed as a result of
a data event being received.
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Progression Rule Example

Description

this.data.Call_Status.before() ==
"Assigned";

This expression tests the value of a data
property when a data event is received. Using
.before()enables you to test the old value of
the data property, following a change in the
value of a data property, when a new data
event is received.

This expression evaluates only if the data
property does change when the new data
event is received. If the new data event does
not change the value of the data property,
then the expression evaluates to false. It is
also the case that where the new data event
does not change the value of the data
property, any expression containing the rule
.before() within an expression evaluates to
false; as a result, the following expressions are
equivalent:

» this.data.Call_Status.before() ==
"Assigned";
» this.data.Call_Status.changed() &&

this.data.Call_Status.before() ==
"Assigned";
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Progression Rule Example

Description

this.data.Call_Priority.after > 3;

This expression tests whether a data property
has changed when a data event is received.
Using .after() enables you to test the existing
value of a data property, following a change
in the value of the data property, against a
new data event property value.

This expression evaluates only if the data
property does change when the new data
event is received. If the new data event does
not change the value of the data property,
then the expression evaluates to false. It is
also the case that where the new data event
does not change the value of the data
property, any expression containing the rule
.after() within an expression always evaluates
to false; as a result, the following expressions
are equivalent:

» this.data.Call_Priority.after() > 3;

» this.data.Call_Priority.changed() &&
this.data.Call_Priority.after() > 3;

this.data.property1.after().conta
ins(" AbC");

This expression tests whether the data
property contains a specified string; note that
is expression can be used only with string
properties. The expression evaluates to true if
property1l has changed and the value after the
change contains the characters AbC; the test
is case sensitive.

You can also use the following expressions to
test the content of data properties that are of
type string:

> . starts()

> . ends()
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Progression Rule Example

Description

this.data.property2.after().in(1,
2,3);

This expression enables you to test whether a
data property is set to any one of a set of listed
values. You can use this expression for all data
property types. The expression evaluates to
true if the numeric property property2 has
changed value and is now set to one of the
numeric values 1, 2 or 3.

onEvent("Start Credit Check");

This expression enables you to test that a
specific business event (Start Credit Check) is
processed by the data event.

onEvent("Order Updated") &&
event.Status== "Credit Check
Done";

This expression enables you to test that a
specific business event (Order Updated) is
processed by the data event and for the value
of a specific property (Status) within the
event.

Function Return Values

The following sections describe the data and string values that can be
returned from the value expression.

These functions can be used in filter expressions, binding expressions,
progression rules and assignment actions.

Functions for Dates and Times

The following functions convert expressions into milliseconds:

» hours (number)
> minutes (number)
» seconds (number)

» days (number)

These functions convert number to the equivalent number of milliseconds
(which are the Business Impact Engine time units).
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Functions for Identifying String Values

The following functions take a string parameter and return a Boolean result.
» string_property.contains(value)
Returns true if value is found in the property value.
» string_property.starts(value)
Returns true if the property value starts with value.
» string_property.ends(value)

Returns true if the property value ends with value.

Functions for All Property Types

The following function takes one or more parameters and returns a Boolean
result:

property.in(value,value,...)

This expression returns True if the value of property is one of the listed set of
values (value,value,...), and False if it is not.

Process Progression Rules

The grammar for process progression rules is slightly different from the
simple expression grammar, as it is used to describe deltas or changes to
Data definition properties.

There are four styles of progression rule provided in BPI as follows:

» Complete on first assignment

» Complete on transition

» Start and complete on transitions
» Advanced conditions

The Advanced conditions style of progression rule requires you to enter the
methods for the progression rules directly as described in section “Methods
for Progression Rules” on page 142.
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For the remaining progression styles, you do not need to enter the methods,
you just select the style of the progression rule that you want for the
Activity. Ultimately, each style uses a subset, or selection of the methods
described in section “Methods for Progression Rules” on page 142. You can
see these methods if you define a progression rule using one of the styles
and then change the style to Advanced conditions to view the methods
created for the style.

More detailed information about using these progression rules in your
processes is provided in the Business Process Insight Integration Training Guide
- Modeling Processes.

The methods used for the progression rule styles are listed in the following
table.

Style Methods Used Comments
Complete on first before()==null This style of progression
assignment rule uses the method listed

to determine when the
property value changes
from Null to any other
value.




Chapter 3 * Modeler Management

Style Methods Used Comments

Complete on transition Complete Condition: This style of progression
before().in() and rule uses the methods
after().in() listed to determine when

the Activity complete
condition is met. It does
this by testing the original
and modified value of a
property against one or
more values in the rule.
Use of the in() method
enables you to enter a
selection of values that can
be tested. If you do not
enter a value, any value for
the property can satisfy the

condition.
Start and complete on Start Condition: This style of progression
transitions before().in() and rule uses the methods
after().in() listed to determine when

the Activity start and
Activity complete
before().in() and conditions are met. It does
after().in() this by testing the original
and modified value of a
property against one or
more values in the rule.
Use of the in() method
enables you to enter a
selection of values that can
be tested. If you do not
enter a value, any value for
the property can satisfy the
condition.

Complete Condition:
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Methods for Progression Rules

To express progression rules using the Advanced Conditions option in the BPI
Modeler, there are methods for Data definitions and their properties. A
method represents the value relating to the data object or property at a
point in time.

The methods are described in the following table and apply only to a
property in a process progression rules.

Method Description

this.data.property.changed() This function is used to test when the
property value changes. When the
property value changes it returns a
result of True.

this.data.property.before()== This evaluates to the value of the
property before a change and is
executed only when the property values
changes. It is implicit in this expression
that the property value was as stated by
prop-value and is now no longer that
value.

“prop-value”

The type returned is the same as the
type of the property.

this.data.property.after()== This evaluates to the value of the
property after a change and is executed
only when the property value changes.
It is implicit in this expression that the
property value was a value other than
prop-value and is now prop-value. The
type returned is the same as the type of
the property.

“prop-value”

this.data.created() This evaluates to true when the data
definition is created. This method is
executed only when a new Data
definition is created.

The method returns a Boolean result.
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Method Description
this.data.property.in( This evaluates to true when the value of
the propery is set to any of the listed

“prop-valuel”, “prop-value2”, ...)
values.

The method returns a Boolean result.

this.data.terminated() This evaluates to true when the data
definition is terminated, specifically
when the Data definition received an
event that is flagged as terminating it.
This is specified in the Event
Subscription dialog for the Data
Definition; Terminate this instance of
the Data Definition after handling the
event.

The method returns a Boolean result.

onEvent(“event-name”) This evaluates to true when the
specified event is processed by the Data
definition. It evaluates to false if the
event does not match.

Example of Complete Condition for Start Activity When Data
Definition is Created

The following shows an example of the expression that you use when you
want a process instance to be started when a Data definition for the process
is created. In this case, a new process instance is started only when the start
and complete conditions for the start Activity in the process are met, for
example:

this.order.created();
where:

> this is the reference to the process, in this case the Order process.
» order is the Data definition.

» created() is a method that evaluates to true when the order Data
definition is created.
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Example Start Condition for Start Activity When Data Definition
Modified

The following shows an example of the expression that you use when you
want a process instance to be started when the Data definition for the
process is modified. In this case a process instance is started not when the
Data definition is created but when there is a change to the Data definition

property.
this.order.priority.before() == null && this.order.priority.after() <= 3;
where:

> this is the reference to the process, in this case the Order process.

» order is the primary Data definition.

» priority is an integer property.

> before() is a method, which returns the value of the property before
the change.

\

null indicates that the property was not initialized before the change.
» after() is a method, which returns the value of the property after the
change.

Example Start Condition using a Method on a Method

The following example is similar to the example above; however, shows an
example of the expression that you use when you want a process instance to
be started when the Data definition for the process is modified and the Data
definitions contains a specific string.

this.order.customer_id.after().contains(“X");
where:

> this is the reference to the process, in this case the Order process.
> order is the primary Data definition.

> customer_id is a string property that is a unique identifier for the
customer.
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» after() is a method, which returns the value of the property after the
change.

» contains() is a string function, which returns a Boolean result
depending on whether the string “X” is present in the customer_id.

Example Start Condition for an Activity Based on Event Properties

The following example shows an expression where a you want a process
Activity to be started when the business event Order Updated is received and
the business events contains a Status attribute of Credit Check Done.

onEvent(“Order Updated”) && event.Status == “Credit Check Done”;

Case Sensitivity for Expressions

This section describes case sensitivity for expression properties and for
expressions containing string constants.

Expression Properties

Properties and methods in expressions are case sensitive, which means the
following expressions are not equivalent within your BPI system:

this.order.priority.before() == null && this.order.priority.after() <= 3;
this.Order.Priority.before() == null && this.Order.Priority.after() <= 3;

Expressions with String Constants

Expressions containing string constants are case sensitive, which means the
following expressions are not equivalent within your BPI system:

this.order.status.after() == “a”;

this.order.status.after() == “A”;
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Subtracting Dates in Filter or Binding Expressions

When you create a filter or binding expression where you want to subtract
dates, you need to make sure you create expressions using the following
format:

(this.dateProp + days (2) + hours (12) > event.dataProp

In this example, the duration is added to one date and tested against the
second date to achieve the required result.

You cannot use expressions such as the following:
(event.dateProp - this.dateProp) > days (2) + hours (12)

This expression tests whether the difference between two dates is greater
than two days and 12 hours.

%@ BPI Modeler User Interface

146

This section describes:

» Activity Properties Dialog on page 147
» Modeler Page on page 154

» Process Definition Page on page 170
» Data Definition Page on page 181

» Edit Definition Page on page 189
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@, Activity Properties Dialog

This dialog enables you to define the attributes for each Activity.

To access From the BPI Modeler > click a Process definition to open
the Process Definition page > click the Process Editor tab
> right-click on the Activity you want to define

Important The form of the Activity Properties dialog depends on
information whether you have selected the option to Track individual
process instances when defining the Related Data for the
Business Process (see “Related Data Tab” on page 177).

If you have cleared the option to track individual
instances, you cannot modify the properties of the
Activity and the options for progressing the process from
this Activity are set and cannot be modified.

Relevant tasks “How to Define Activity Properties” on page 107

See also Chapter 12, “Annotations for Process Diagrams”

Activity Tab

This is where you provide details of the Activity name and text to describe
the Activity.

User interface elements are described below:

Ul Elements Description

Name Name of the Activity, for example, Review Report, and
must be between 1 and 40 characters.

Description Optional description of the Activity.

Type of Activity One of the following:
> Start Activity

» Business Activity
» End Activity

> Junction Activity
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Ul Elements Description

Image You can specify a file name of an image that you want to
be displayed in place of the standard Process Activity
image. A drop-down list provides the file names of
images that you placed in the following directories:

» On the BSM Gateway Server:
BSMe-install-dir\AppServer\webapps\bpi.war\custom
images

» On the BPI Server:
BPl-install-dir\nonOV\jakarta-tomcat-5.0.19\webapp
s\hpbpi-bpd\customimages
and

BPl-install-dir\nonOV\jakarta-tomcat-5.0.19\webapp
s\ovbpimetricdefiner\customimages

NOTE: Keep the following in mind when customizing the
images of the Activity icons:

» If you have defined images in the annotation.xml file,
the Health and Process Instance pages show those
images, but the Modeler does not.

» If you have different images selected in the Modeler,
those images take precedence over the images in the
annotation.xml file.

» The following image file types are supported: .jpeg,
.jpg, .gif, and .png.

For more information about customizing the Activity

icons and the annotation.xml file, see Chapter 12,

“Annotations for Process Diagrams.”
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Ul Elements

Description

<check boxes>

There are up to two check boxes offering additional
options according to the Type of Activity. The number of
check boxes depends on the Activity types and the
options are:

» OK to Start the Process if not Already Started

When this option is selected, BPI starts a process
instance when the start conditions for the Activity are
met even if the start conditions for the Start Activity
have not been met.

This represents an abnormal start to the process;
however, there might be a situation where events
arrive out of sequence in cases where different
applications are generating the events, which are then
used at different Activities.

» Log a Warning if the Process has not Already Started

This option is available only if you have selected the
check box for OK to Start the Process if not Already
Started. Select this option if you want the Business
Impact Engine to log a warning message if the Process
starts when it meets the start condition for the
Activity. You want to be alerted to the fact that this is
happening as it is an abnormal situation.

Progression Tab

This is where you enter the Start and Complete Conditions for the Activity.

When entering property values for Progression Rules in the BPI Modeler be
aware that the Oracle Server does not distinguish between a zero-length
string and a string with a value that has not been assigned (null string). This
means that if you want to test a zero length string within a start or complete
condition, you are advised to use a single blank space (" "), and not an

empty string ("").
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User interface elements are described below:

Ul Elements

Description

Style of Progression

If you have chosen not to enable tracking of process
instances, the progression rule is set and cannot be
modified.

If you have selected the option to track individual
process instances, there are a number of styles of
progression rules that you can select from and the data
required to complete them varies according to the style
that you select. Each style requires you to enter
progressively more details of the rules that you want to
specify, with the final style requiring you to enter
complete conditions using the grammar described in the
“Expression Grammar in Process, Data, and Event
Definitions” on page 132.

Following are the styles of progression from which you
can select (for detailed descriptions of each rule), see
“Progression Rules” on page 92):

» Start and complete on TransactionVision events

» Complete on first assignment

» Complete on transition

» Start and complete on transitions

» Advanced conditions

Start Condition

Click the ellipses to the right of the Start Condition area
to open the Activity Start Condition dialog.

You can use the tree structure to navigate to the Data
properties that you want to include in the expression to
save time and typing errors. Use the grammar rules to
construct your expressions. The grammar rules are
described in “Expression Grammar in Process, Data, and
Event Definitions” on page 132. Add the Data definitions
into the Entry window using the Paste button.

Complete Condition

Click the ellipses to the right of the Complete Condition
area to open the Activity Complete Condition dialog.

Add the expression for the complete condition for the
Activity.
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Related Cls Tab

This is where you can link the Activity in the Business Process to
Configuration Items (Cls) within the RTSM.

If the Business Process has not been deployed, you are presented with a CI
selection dialog for the Business Activity. When you have selected a CI, it is
added to the list of Cls that this Activity is linked to.

Use this dialog to link a selected CI to a Business Process Activity so that you
can model and populate CI dependencies between Business Process
Activities and existing IT operational resource CIs in the RTSM, using the
Modeler.

If the Business Process has not yet been deployed, Cls can be selected for
Business Process Activities, but the CI links are not synchronized to the
RTSM until the Business Process is deployed. If the Business Process has been
deployed, the CI links are synchronized with the RTSM as soon as the
Business Process changes are saved.

You can use CI Selector to select views and to locate CIs. You can select a
view and browse through the list of CIs (Browse Views), or you can search
for a CI (Search) if you do not know in which view the CI is included.
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User interface elements are described below:

Ul Elements Description

Browse Views Tab in the left pane where you can browse Cls in RTSM
and associate CIs that represent dependent IT operation
resources with Business Process Activities. These Cls are
already populated in the RTSM by the person responsible
to IT operations. This is done either manually or through
automated means, such as discovery.

Within the Browse Views select ClIs as follows:

» Click the drop-down list to select a View from the
alphabetical list presented, for BPI CIs select Business
Processes.

» Open a Business Process to display the list of Cls
provided.

» Select one or more CIs and click the right arrow to
place the CIs in the right panel.

You can only select CIs within the current Browse view.

Search Tab in the left pane where you can search for one or more
ClIs in the views or the RTSM, search for all occurrences
of a CI, or filter the list of CIs that is displayed.

The Search ClIs option enables you to find the CI you
need. You can set up searches based on any combination
of the filter criteria based on CI Type and CI Name.

When searching for ClIs by name, you enter a string, or
partial string in the CI Name list box. The search returns
all CIs that contain the entered string somewhere in the
name (within the boundaries of the other search criteria
that you define).

When using this search option, note the following:

» The search by CI name option is not case sensitive.

» You can search just for the name by using the first few
letters of the name or first part of the name. Wildcards
do not work.
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Ul Elements Description

Search (continued) » You can search just for the CI type by entering the
type, such as business_activity.

If there are more than one CIs beginning with that
name or of that CI type, a list displays in the left
panel.

» You can select one or more ClIs and click the right
arrow to put the CIs in the Related ClIs right panel.

Related Cls right Lists the ClIs that are linked to the Business Process
panel Activity, by CI Name, CI Type, and Relationship Source.

Related Transactions Tab

This is where you can link the Activity in the Business Process to Business
Transactions. A single Activity can be linked with one or more Business
Transactions. Conversely, you can link a Business Transaction to one or
more Activities. The relationship between the Activity and the linked
Business Transaction CI is persisted in the RTSM. These relationships are
displayed on the Health page.

User interface elements are described below:

Ul Elements Description
o Click to insert a new row into the table to add a Business
""" ! Transaction.

The related transactions are only available if BPI is
connected with TransactionVision. For details, see
“Connecting BPI With TransactionVision” in the Business
Process Insight Server Administration Guide.

* | Click to delete the selected Business Transaction.
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@ Modeler Page

This page enables you to create and manage your Process, Data and Event
definitions.

Note: The performance of the Modeler can be impacted by having too many
definitions open simultaneously. If you find the BPI Modeler is not
responding in a timely manner, try closing some of the definition windows
that you have open. You can see how many definitions are currently open
using the Windows menu option, or the Status bar, described below.

154



Chapter 3 * Modeler Management

Following is an example of the Modeler when it is first opened:

¢ HPBPI Modeler 9[=1t9

File- Edit: Tools-  Window=  Help~

Summary

JOpen defintions; 0. Definitions reguiring save: 0,
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To access

Admin > Business Process Insight> Modeling tab > BPI
Modeler

Wait for the Modeler to launch as a Java Web Start
application. You might be asked to confirm that you
want to download the files to open the Modeler within
your web page. If required, confirm that you want the
download to proceed.

Important
information

The interface is slightly different for each of the different
definitions; however, the overall layout is the same.

To create a Business Process that you can track within
BPI, you need to understand more about defining
Process, Data and Event definitions using the BPI
Modeler, see “Components of a Business Process” on
page 74.

If you have installed the BPI Server component, you also
need to make sure that the Process Repository
component is started on the BPI Server system and the
Infrastructure settings are completed for BPI (access the
infrastructure settings from: Admin > Platform > Setup
and Maintenance > Infrastructure settings > Business
Process Insight).

Use the BPI Server Administration Console on the BPI

Server system to start the Process Repository as described
in “Starting and Stopping the BPI Server Components” in
the Business Process Insight Server Administration Guide.

NOTE: If you logout of BSM and leave the Modeler
running, the Modeler no longer has access to the Process
Repository. In this case, when you next try to use the
Modeler, you are prompted to save any currently unsaved
changes to the models that you have been editing and
the Modeler closes.
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Relevant tasks “How to Model Your Business” on page 101

“How to Create a Process Diagram” on page 102

See also “Modeler Capabilities” on page 67

“BPI Modeling Implementation” on page 68
“Process Repository” on page 88
“Progression Rules” on page 92

“Coercion Rules” on page 127

YYYYYYVY|VYY

“Expression Grammar in Process, Data, and Event
Definitions” on page 132

The BPI Modeler consists of the following:

“Editor Pane” on page 157
“Navigator Pane” on page 158
“Summary Pane” on page 160
“Status Bar” on page 161
“Todo List” on page 161
“Menu Options” on page 163

Y Y Y Y Y Y Y

“Import Definition Dialog” on page 168

Editor Pane

The top right-hand pane of the BPI Modeler interface contains the Editor
pane. The content (or tabs available) on this pane varies according to the
definition that you have selected in the Navigator pane.

The Editor panes are:

» Process Definition, which consists of the following tabbed pages (see
“Process Definition Page” on page 170):

> Identity
» Process Editor

» Related Data
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» Data Definition, which consists of the following tabbed pages (see “Data
Definition Page” on page 181):

> Identity
» Properties
» Subscriptions

» Events Definition, which consists of the following tabbed pages (see “Edit
Definition Page” on page 189):

> Identity

» Properties

Navigator Pane

The top left-hand pane of the BPI Modeler interface is called the Navigator
pane. This pane shows a tree view of your Process, Data and Event
definitions. At the root of the Navigation tree is the Process Repository,
which is where the definitions listed in the Navigation tree are stored.

The Navigation pane has a Summary pane beneath it and whenever you
change selection in the navigation tree, the content of the Summary pane
changes. The Summary pane provides details of the selected object.

There is a menu option that toggles the Navigator pane (and the Summary
pane) between their normal and collapsed sizes. You can also change the
size of the Navigator pane using the vertical split bar between the left and
the right-hand panes. When collapsed, the navigation and summary panes
disappear, and the vertical split bar is pushed to the left. Manually dragging
the split to the far left will have the same effect as toggling the Show
Navigator option on the Window menu.

Each definition in the Navigator tree has an icon to identify its type and also
is color-coded to indicate its deployment status. The following are the
possible states for deployment:

> Yes deployed - the latest version of the process model definition has been
deployed.
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» No not deployed - the latest version is not the same as the deployed
version and potentially needs deploying.

» No, has Todo list errors - the definition cannot be deployed until the
errors are corrected.

User interface elements are described below:

Ul Element Description
o Show/hide Navigator. Toggles between showing and
&= hiding the Navigator and Summary panes.
: Create a new process definition. Enables you to create a
P y

new Process definition. When created, a new definition is
added to the Navigator tree with a default name ready for

modification.
Create a new data definition. Enables you to create a new
Data definition. When created, a new definition is added

to the Navigator tree with a default name ready for
modification.

Create a new event definition. Enables you to create a
new Event definition. When created, a new definition is
added to the Navigator tree with a default name ready for
modification.

(&

Deploy to the Engine or the Event Layer. Attempts to
deploy the definition that you have selected, plus any
other definitions on which the definition depends.

Undeploy to the Engine or the Event Layer. Attempts to
undeploy the definition that you have selected.
) Undo. Reverses the last action that you completed using
| this option.
u Redo. Reverses the action of the last Undo Delete

command.

Properties. Enables you to define the properties of the
selected definition.
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Summary Pane

Lower-left-hand pane, which provides details of the Processes, Data or Event
definition selected in the Navigator frame. The Summary pane keeps these
details in view when you are editing definitions on the right-hand frame.
The content of this frame matches what is selected in the Navigator pane
and not what is being displayed in the right-hand frame.

This pane also shows the dependencies between the definitions and enables
you to quickly move between the definitions (using hyperlinks) to better
understand how the definitions relate to each other.

The Summary operates in a similar way to a web page, for example, it has
hyperlinks for the dependencies and consumers of the definition.

The following information is available through the Summary pane:

Summary Details Description

Type This is an indication of whether the selection is for a
Process, Event or Data definition.

Name The name that has been assigned to the definition.

Deployment state An indication of the current deployment status of the
definition.

Description The free-form description of the definition, where it is
provided.

Last saved date and The date and time that this definition was last saved.

time

Used by A list of the definitions that have this definition as a
dependency. There are hyperlinks to each definition in
this list.

Uses A list of definitions that are dependencies of the selected
definition. There are hyperlinks to each definition in this
list.
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The hyperlinks for Used by and Uses provide the base name of the related
definition, in addition there are tool tips that include the group of the
related model, plus any other relevant information. Clicking the hyperlink
selects that definition in the Navigator tree, and as a result the new
definition is also shown in the Summary pane. Select Shift and click the
hyperlink and the definition is opened in the Editor pane, or if it is currently
open, displays it in the Editor pane.

To aid navigation, there are back and forward buttons to the Summary pane,
shown as arrows. These behave like Web browser back and forward buttons.
Pressing the back arrow takes you one back down the stack of the definitions
that you have selected.

You can change the relative sizes of the Navigator pane and the Summary
pane by using the split bar between them.

Status Bar

There is a status bar at the bottom of the BPI Modeler window. The status
bar includes a panel to show you the following:

» Number of definitions that you have open and have modified
» Total number of definitions you have open
» Number of deployed processes

The Status Bar also notifies you of anomalies, for example, when there are
errors importing a Business Process definition.

Todo List

There is a Todo List associated with each definition type. The Todo List
reports on the consistency of the definition and keeps track of all the
outstanding issues and tasks required to ensure that the definition is
consistent and complete.

Note: A definition cannot be deployed unless it is internally consistent.
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The Todo List is located on the right-hand side of the BPI Modeler window
below the Definition pane and represents the to-do actions related to the
definition that appears in the Definition Pane.

You can sort on Severity, Location or Description by clicking the appropriate
column header.

There is a caption that shows the highest level of problem in the Todo List,
for example, if a definition has errors it will show the error icon. This
caption also includes summary counts for all of the Todo List severity
warnings.

You can use the split bar to shrink the Todo List; however, the caption is
always displayed, that is, you can hide the Todo List, but not the summary
information shown in the caption.

The Todo List user interface elements are described below:

Ul Elements Description

Severity This indicates the severity of the action and can be either
an error or a warning. You can deploy a definition that
contains warnings, but you cannot deploy a definition
that contains errors.

Loation This indicates the definition type where the problem
exists, for example Process definition.

Description This is a description of the problem.
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The following menu options are available through the BPI Modeler. Note
that some menu options are enabled in specific contexts. These contexts are
indicated in the table describing each menu option.

File Menu

Menu

Context

Description

New

Always enabled.

Enables you to create a
new Process, Data, or
Event definition. When
created, a new definition
is added to the Navigator
tree with a default name
ready for modification.

Open

Enabled when you select
a definition that is not
currently open in the
right-hand pane, or if an
already opened editor is
accessed.

Opens the currently
selected definition from
the Navigator pane and
displays the identity data
for the definition.

Close Active Editor

One or more Process,
Data or Event editors is
open for modification.

Closes the editor for the
currently open definition
in the right-hand pane.
This is the editor that has
input focus. You are
prompted to save any
unsaved modifications.

Close All Editors

One or more Process,
Data or Event editors is
open for modification.

Closes all the open
definition editors. You are
prompted to save any
unsaved modifications.

Save

One or more Process,
Data or Event editors is
open for modification.

Attempts to save changes
to the currently selected
definition.
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currently deployed
definition.

Menu Context Description
Save All One or more Process, Attempts to save changes
Data or Event editors is to all definitions.
open for modification
Deploy You have selected a Attempts to deploy the
currently undeployed definition that you have
definition. selected, plus any other
definitions on which the
definition depends.
Undeploy You have selected a Attempts to undeploy the

definition that you have
selected.

Import Definitions

Always enabled.

Opens a dialog that
enables you to specify a
zip file that you have
previously exported using
the Export Definition
menu option. For details,
see “Import Definition
Dialog” on page 168.

Export Definition

You have selected a
Process, Data or Event
definition.

Attempts to export to a
zip file the selected
Process, Data or Event
definition.

Options

Always enabled.

Opens a dialog that
enables you to configure
the name of the system
where the BPI Server is
installed and the snap to
grid parameters.

Exit

Alway enabled.

Closes the BPI Modeler. If
there are unsaved
changes, you are
prompted to save them.
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Edit Menu
Menu Context Description
Undo Always enabled. Reverses the last action
that you completed using
this option.
Redo Enabled following an Reverses the action of the
Undo Action. last Undo Delete
command.
Delete Enabled when a Deletes the currently
definition is selected that | selected definition or
can be deleted. property.
Properties Enabled when an object Shows the properties of

is selected that has
properties.

the selected definition.

Tools Menu

The Tools menu has different options according to the context of the

right-hand pane.

If you have the Process Editor tab for a Process definition selected, the
following options are available from the Tools menu (see “Process Editor

Tab” on page 171):

selected in right-hand
pane.

Menu Context Description

Select Process Editor tab Changes the mode of
selected in right-hand editing the Process
pane. Diagram to Select.

Start Activity Process Editor tab Changes the mode of

editing the Process
Diagram to Start Activity.

Business Activity

Process Editor tab
selected in right-hand
pane.

Changes the mode of
editing the Process
Diagram to Business
Activity.
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Menu

Context

Description

End Activity

Process Editor tab
selected in right-hand
pane.

Changes the mode of
editing the Process
Diagram to End Activity.

Junction Activity

Process Editor tab
selected in right-hand
pane.

Changes the mode of
editing the Process
Diagram to Junction
Activity.

Check Sequence

Arc selected on Process
diagram.

Toggles the properties of
the arc between a Check
Sequence arc and a
regular arc.

If you have the Properties tab for a Data or Event definition selected, the
following options are available from the Tools menu:

Menu

Context

Description

Insert New Row

Properties tab selected for
Data and Event
definitions.

Inserts a new row in the
properties table for the
definition.

Copy Properties

Property selected in Data
or Event definition table.

Open the Copy Properties
dialog where you can
copy properties of Data
and Event definitions.

Junction Activity

Process Editor tab
selected in right-hand
pane.

Changes the mode of
editing the Process
Diagram to Junction
Activity.

Check Sequence

Arc selected on Process
diagram.

Toggles the properties of
the arc between a Check
Sequence arc and a
regular arc.
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If you have the Subscriptions tab for the Data definition selected, the
following option is available from the Tools menu (see “Subscriptions Tab”

on page 185):

Menu

Context

Description

Insert New Row

Subscriptions tab selected
for Data definition.

Opens the Event
Subscriptions dialog.

Window Menu

Menu

Context

Description

Show Navigator

Always enabled.

Toggles between showing
and hiding the Navigator
and Summary panes.

Navigator Always enablede. Takes input focus to the
Navigator tree.
Summary Always enabled. Takes input focus to the

Summary Pane.

<List of open editors>

You have selected one or
more definitions for
editing.

Lists the definitions that
are currently open for
editing and that are saved
as a result of selecting
Save All from the Edit
menu.
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Import Definition Dialog

If you are importing a zip archive for a definition file, when you have
selected the zip archive to import, you are presented with an Import
Definitions dialog, which contains a number of columns, one of which is an
Import Action column.

Some import actions show additional drop-down menu items when you
select them and some of the import actions cannot be modified. The actions
that you can complete depend on the type of definition that you are
importing and also whether a copy of the definition already exists on the
machine where you are importing the definitions file.

When you have completed setting the options for importing the definitions,
click Import to import the new copy of the definition.

When importing a zip file containing one or more Process definitions, the
BPI Modeler checks to ensure that there are no name clashes with existing
Process, Data or Event definitions. If there are clashes, you can decide
whether to overwrite, rename or ignore the definition.

If you are importing a newer version of an existing Process definition, the
imported process overwrites the existing process.

When the import has completed successfully, the new copy of the definition
appears in the Navigator Pane and the import is complete.
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The options for the Import Action are as follows:

Ul Elements Description
Import Action The following options are available from a drop-down
drop-down menu for all Data, Process and Event definitions.

Configure the action as required for the definition:

» Import original definition — Use this option to import
the Process, Data or Event definition directly with no
change to its name and without modification.

» Create a new copy of the definition — Use this option
to make a copy of the Process, Data or Event
definition. The new copy is then unrelated (has a new
unique identifier) to the definition that was exported.

» Exclude from import — Use this option to remove the
Process, Data or Event definition from the imported
Business Process and not import it into the Process
Repository.

Cannot be imported | This is a non-editable action. This definition is not
recognized as a definition type that the Modeler can
import. Make sure you are importing only a definition
type that can be created within the Modeler and that the
definitions are not Business Process Monitor or Monitor
Threshold definitions.

Overwrite existing A definition with this name already exists and will be
definition overwritten when this definition is imported. Rename
the definition if you do not want the existing definition
to be overwritten

Import definition Import the definition with the same identity (unique
unchanged identifier) as the originally exported definition. Rename
the definition if you do not want the definition to have
the same identity.

Keep existing A definition with this name already exists and will be left
definition unchanged.
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. Process Definition Page

This page enables you to define the Process definition and create a Process

Diagram.
To access Use one of the following:
» From the BPI Modeler > File > New > Process
» From the BPI Modeler Navigator pane > double-click
an existing Process definition
Important Use the Process Definition editor to create and modify
information your Process definitions. You can have multiple editors
open for Processes, Data and Events. You can see your
active editors by selecting the Window menu option.
Relevant tasks » “How to Model Your Business” on page 101
» “How to Create a Process Diagram” on page 102
» “How to Define Activity Properties” on page 107
See also “Process Definitions” on page 75

The Process Definition Page consists of the following tabs:

> “Identity Tab” on page 170
» “Process Editor Tab” on page 171
» “Related Data Tab” on page 177

Identity Tab

This is used to define the name and optional description of the Process
definition.

» A Process Name must be unique (within the list of Process definitions)
and must be between 1 and 40 characters.

» The Process Description is an optional free-form field that you can use to
document details of the definition that you want to record.
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Process Editor Tab

The Process Editor provides the canvas for creating your Process Diagram.
When you click the Process Editor tab, you can see that additional icons are
enabled on the Toolbar described below. Using these icons, or the menu
options (see “Menu Options” on page 163), you can start creating your
processes.

User interface elements are described below:

Ul Elements Context Description
[ The Process Select Mode. Move you out of editing
Editor is the mode and into select mode. This

active window. | enables you to select objects on your
canvas, or draw arcs between

activities.
B The Process Start Activity. This is a normal starting
Editor is the point for a process.

active window | 1, 544 a Start Activity on your Process

diagram, select Start Activity from the
Tools menu option, or click the Add
start Activities icon on the toolbar.

You can have more than one Start
Activity in your process, or no Start
Activity; you can configure a Business
Activity to start a process if the process
is not already started. The Start
Activity aids the visual layout of the
process.
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Ul Elements Context Description
B You can choose to log a warning if an
attempt is made to start a process a
second time; this is where the start
(continued)

condition for the Start Activity is met
more than once. If you select this
option, and a second Start Activity is
activated after the process has started,
the Business Impact Engine issues a
warning as the process is not
progressing as expected. This is the
case where an instance of the process
has been created by a different Start
Activity, or a Business Activity with
the following flag set:

OK to start the process if not
already started

If the Start Activity is instantaneous,
and deactivated as soon as it is
activated, you need only set one of a
start or a complete condition for the
Activity. The Business Impact Engine
then maps the start condition to the
complete condition and vice versa.
When the start and complete
conditions are the same, the Start
Activity has a duration of zero (0)
milliseconds when evaluated by the
Business Impact Engine. If your
Business Process expects that the
activity related to the Start Activity is
not instantaneous, set different start
and completed conditions for the
Activity.

Start Activities cannot have arcs
leading into them. Start Activities can,
but do not have to, have arcs leaving
them.
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Ul Elements

Context

Description

e

The Process
Editor is the
active window.

Business Activity. This Activity is a
normal activity within the process
that gets activated and deactivated
according to its start and complete
conditions.

To add a Business Activity to your
Process diagram, select Business
Activity from the Tools menu option,
or click the Add Business Activity icon
on the toolbar. You can have more
than one Business Activity in your
Process diagram.

If the Business Process is such that the
Business Activity is active for a period
of time while the activity occurs, set
different start and complete
conditions for the Activity.

If the Business Activity is
instantaneous, and deactivated as
soon as it is activated, you need only
set one of a start or a complete
condition for the Business Activity.
The Business Impact Engine then
maps the entry criteria to the exit
criteria and vice versa. When the start
and complete conditions are the same,
the Business Activity has a duration of
zero (0) milliseconds when evaluated
by the Business Impact Engine.
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Ul Elements Context Description
The Process End Activity. This is a normal end
E Editor is the point for a process.

active window. | 1 adqd an End Activity on your

Process diagram, select End Activity
from the Tools menu option, or click
the Add End Activities icon on the
toolbar. You can have more than one
End Activity in your process. You can
also omit the End Activity, although
this is not recommended as the End
Activity is used by the Business Impact
Engine to indicate that a process
instance has completed. If you omit
the End Activity, process instances
never complete.

(continued)

When an End Activity meets its
complete condition, the whole
process is deemed to have completed,
and the Engine is free to stop tracking
it. However, it is possible that
out-of-sequence events can still arrive
after this point, so the Engine marks
the process as completed, but
continues to track it for
out-of-sequence events.
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Ul Elements Context Description
If the End Activity is instantaneous,
E and deactivated as soon as it is

activated, you need only set one of a
start or a complete condition for the
Activity. The Business Impact Engine
then maps the start condition to the
complete condition and vice versa.
When the start and complete
conditions are the same, the End
Activity has a duration of zero (0)
milliseconds when evaluated by the
Business Impact Engine. If your
Business Process expects that the
activity related to the End Activity is
not instantaneous, set different start
and complete conditions for the
Activity.

(continued)

If a process has parallel paths, these
paths should be merged before the
End Activity. If the paths are not
merged, the process ends when the
End Activity is first activated, which
might not be the intended behavior.

End Activities must not have arcs
leaving them.
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Ul Elements

Context

Description

The Process
Editor is the
active window
and you have
selected at least
one object.

Delete. Deletes the currently selected
object from the canvas.

v

At least two
Activities exist
in a Process
definition.

Arc. Arcs are used to indicate the
direction of process between Activities
in the Process diagram and show the
expected order that Activities are to be
executed. An Arc with a solid line
indicates an Arc type of Check
Sequence (see “Check Sequence Arc”
on page 82).

To add an Arc on your Process
diagram, hold the pointer over the
center of an Activity; you see it
changes color and shows you
properties of the Activity. Use the
mouse to left-click in the center of the
Activity and drag the pointer to
another Activity. An arc is created
between the two Activities. The arc
has an arrow head to show the
direction of the process.

An Arc with a dotted line is an
unchecked Arc and shows the
direction of the process, but does not
have any effect on how the process is
progressed.

If you want to be informed when
Activities in your process are executed
in an unexpected order, you can
create an arc type of Check Sequence.




Chapter 3 * Modeler Management

Related Data Tab

The properties for Related Data enable you to relate the Data definition that you
have defined to the associated Process definition.

If you see the following message in the Related Data pane, you are unable to
set the Related Data properties until you have purchased an HP Business
Process Insight license that enables you to use the full capacity of the
Modeler. When you have installed the license, you can define the Related
Data and other components of your business process.

Setting the data related to a Business Process is only available with an HP
Business Process Insight license. HP Business Process Insight permits you to
measure the availability, performance and effectiveness of your key business
processes, and view individual business process instances in BSM.

The Data definition that you want to use as the Related Data property
identifies the Data Definition that the process is based on. In the case of an
Insurance Claim process, this would usually be a Data Definition that
identifies the details of the claim. In the case of a Stock Control process, it
might be the Data Definition that details the customer order data. A
business event that triggers the creation of a Data definition is usually the
event that also triggers the process to be created.

In most cases, the life cycle of a process instance is related to a business
condition, for example the existence of a particular order, or the existence of
a particular insurance claim. In this case, changes to the Claim (or Order)
Data definition can cause a process instance to be created; for example, the
assignment of a new Claim number could trigger the start of a new instance
of the Claim process. There are some cases where the life cycle of a data
instance outlives the process instance; for example, where the Data
definition is Customer and the Process Definition is an Order. In addition,
the Data definition must be linked to the Process Definition by the identifier
of the specific instance of the Data definition. This ensures that the process
instance is progressed using the correct data.

You enter details of the related data using the Related Data dialog. You need
to supply details of the Data definition whose content is used to progress
this process. If you do not relate a Data definition to the process, there are
no properties to select from when entering progression rules
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User interface elements are described below:

Ul Elements

Description

Track individual
process instances

If have installed the BPI Server, you can choose to select
or clear the Track individual process instances as
required. You can create a business process with this
option set (or not set) and change it at a later time if you
want to. You cannot have two business processes with
the same name, one with this parameter set and one with
the parameter cleared.

If you create business process with instance tracking
cleared, and subsequently modify the process to enable
instance tracking, you need to redeploy the process.

NOTE: Unless you have installed the BPI Server, this

option is permanently cleared. As a result, you are unable
to define business processed that track individual process
instances. In addition, when this option is cleared, many
other Modeler features, which are also related to defining
processes for tracking instances, are unavailable. You can
view these options, but you are unable to edit them.

Data definition

This is the Data definition that you want to relate to the
process. You can select from a drop-down list of Data
definitions that have been defined through the BPI
Modeler.

Relationship Name

This is the name that you want to give to the relationship
and is referenced within the start and complete
conditions. The Relationship name must be between 1
and 40 characters and must begin with an alpha
character and thereafter can contain only alphanumeric
characters and the underscore character.
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Ul Elements Description

Identity Property The Identity property is used by the BPI Application and
shown with each instance of the process. Process
instances are ordered by the property entered in this field
within the BPI Application.

Select the Identity property from a drop-down list
containing all of the properties of the related Data
definition. You must select one of these to be used to
identify different instances of the process and it can be
any property of the Data definition.

Process Value The Process Value property is used from within the BPI
Property Application for display and tracking purposes; it is
displayed with each process instance. The Process Value
property is also used when defining Business Monitors
and Thresholds using the Monitor Definer. As an
example, you might have as a Process Value property the
current value of outstanding transactions and this value
is then displayed for each process instance.

Select the property that you want to define as the Process
Value property from the drop-down list. This list
contains all of the Process Value properties of the related
Data definition. You can select only numeric properties
to be Process Value properties; non-numeric properties
are not available for selection.
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Ul Elements

Description

Group Property

The Group property enables you to define a group by
attribute for which statistics are maintained. The various
client pages (Health page dialogs, Process and Monitor
instances pages) then permit you to view only instances
relating to a selected group, as well as view the combined
information.

During the modeling process, you can optionally select a
Group. The Group Property list contains all of the
properties of the related Data definition, but only the
string properties can be selected.

Select the property that you want to use as the Group
Property from the drop-down list. A Group Property
drop-down list appears on the various client pages with
your pre-defined groups already collecting data (for
example, East Coast, West Coast, and so on). If the Group
Property was not set, or set to None, the Group Property
drop-down list does not display in any of the client
pages.

If you had defined groups in the Modeler, but set the
Group Property to None, and you later decide you want
to collect data by groups on the client pages, you can
reset the Group Property value in the Modeler and
redeploy the Business Process. Changes to the Group
Property require redeployment of the process model.

You can limit the number of groups that can be specified
to optimize BPI's performance, in the BPI Server Admin
Console. For details on setting the group limit, see the
“Component Configuration - Business Impact Engine
(BIE)” section in the Business Process Insight Server
Administration Guide. If the number of groups specified in
the Group property field exceeds the group limit, the
data for the groups listed beyond the exceeded number
are combined into a group called Other.
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% Data Definition Page

This page enables you to define and modify Data definitions for your
process. You can also delete a Data definition.

To access Use one of the following:

» From the BPlI Modeler > File > New > Data

» From the BPI Modeler Navigator pane > double-click
an existing Data definition

Important The Data Definition Editor is enabled for Business
information Processes that are created with instance tracking enabled.
If you have not enabled instance tracking for a Process
Definition, you cannot create Data definitions for the
Process.

Relevant tasks » “How to Model Your Business” on page 101
» “How to Define Data Definitions” on page 111

See also “Data Definitions” on page 84
Identity Tab
This is used to define the name and optional description of the Data
definition.

» A Data definition Name must be unique (within the list of Data
definitions) and must be between 1 and 40 characters. The name of the
Data definition can include slash "/" characters to provide a logical
grouping — for example, Orders/My Data.

» The Data definition Description is an optional free-form field that you
can use to document details of the definition that you want to record.
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Properties Tab

Enables you to define the data properties/attributes that make up this Data
definition. You can create and delete properties, or you can copy details of a
property from another Data or Event definition.

User interface elements are described below:

Ul Elements Description
o Insert a new row into a table. Adds a new property row
in which you can create a new property.
Delete. Deletes the selected property.
Copy properties from another definition. Opens the
Copy Properties dialog from which you can select a

property from another definition to be inserted as a
property for the current Data definition.

Name Data property names must be between 1 and 40
characters. The name must start with an alpha character,
roman numeral, currency symbol or underscore (_);
thereafter the name can consist of the same set of
characters, plus numeric characters. Property names must
not contain spaces.
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Ul Elements

Description

Type

This can be one of the following:
» String

This says that the property contains a string value. If
you specify a string data type then you must also
specify the maximum length that this string can be.
You specify this length in the Constraint column for
this property.

» Double

This says that the property contains a double value.
You do not need to specify any constraint for this data

type.
> Integer

This says that the property contains an integer value.
You do not need to specify any constraint for this data

type.
» Currency

This says that the property contains a currency
(money) value. As far as the actual data inside this
field, it can be any of the supported numeric types -
Integer, Long or Double.

In the Constraint column for this property you must
then specify the type of currency that this field
contains. You specify the currency by typing in a valid
ISO 4217 currency code. For example:

EUR - Euro
USD - American dollars
AUD - Australian dollars
GBP - British Pounds

>» Date

This says that the property contains a date value. You
do not need to specify any constraint for this data

type.
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Ul Elements

Description

Type (continued)

> Long
This says that the property contains a long value. You
do not need to specify any constraint for this data
type.

» Boolean
This says that the property contains a string value
containing the word true (in any case - upper, lower or
mixed). Any other value is taken to represent false.
You do not need to specify any constraint for this data
type.

Constraint

The constraint is linked to the data type and is relevant
only to string and currency data types. For a string data
type, the constraint specifies the maximum length of the
string. For a currency data type, this column specifies the
ISO 4217 currency code, for example, USD, EUR and GBP.

Unique

This is a flag indicating whether the property value is
unique, that is, whether two or more, instances of the
Data definition can have the same value. Check the
Unique column if the property value is unique for all
instances of the Data definition. An example of where a
property value is marked as unique might be for an order
number, customer identifier or insurance claim identifier.
If you have two (or more) properties that are marked as
unique, any one of the properties can uniquely identify
the instance.

Description

Optional for your own documentation purposes.
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Subscriptions Tab

This is used to create references to the Events that it subscribes to in order
that the properties of the Data definition can be updated from the data in
the event. For details, see “Define Subscriptions” on page 112.

User interface elements are described below:

Ul Elements Description

. Insert a new row into a table. Opens the Event
fozizac Subscription dialog where you create the properties of
the subscription.

Delete. Deletes the selected Event definition.

Properties. Opens the Event Subscription dialog,
showing the properties for the selected Event definition.
For details, see “Event Subscription Dialog” on page 185
below.

You can also select Edit > Properties to open the Event
Subscription dialog.

Event Subscription Dialog
User interface elements are described below:

Ul Elements Description

Event Name of the Event that the Data definition is subscribing
to.

Description Optional free-form description of the subscription.
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Ul Elements

Description

Event is for a specific
instance of this data
object

This specifies whether the Event data updates a specific
instance of this Data definition, or whether the Event
updates many instances of this Data definition.

If the Event is providing data for a unique customer
identifier, the Event is for a specific instance, and you
need to define details of how the instance is identified.

If the Event contains more general information, for
example, pricing information, or currency information,
there might be many Data definitions that subscribe to it.
In this case, the Event is not for a specific instance of this
Data definition.

Typically, the event is for a specific instance of the Data
definition. When this option is selected, the following
additional data is also required:

» Unique Property of this Data Definition

This is the name of a property of the Data Definition
property used to match a specific Event property to
ensure that a unique instance of a Data definition is
identified. The property used to match the definitions
should be a property that has already been defined as
unique within the Data definition.

» Property of Event
This is the property of the Event that is used to match
against the unique property of the Data definition.

> In order to handle the event, should the data instance
already exist?

A Process definition does not necessarily start at a Start
Activity. You can start an instance of a process at any
Business Activity using this option. The options are:

An instance can already exist. Create if necessary.

An instance should already exist. Log a warning if one
does not. Create if necessary.

An instance must first be created by another event.
Retry this event later on.
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Ul Elements

Description

Event is for a specific
instance of this data
object (continued)

An instance must already exist. Discard the event if
one does not.

An instance should not exist yet. Log a warning if one
does. Create if necessary.

An instance must not exist yet. Discard the event and
log an error if one does. Create if necessary.

» Filter events for data definitions

This is how you further filter the Event data that is
used to update the instance of the Data definition; the
Filter Expression is optional. For example, you might
want to filter based on customer type (Gold, Silver or
Bronze customer and so on).

To enter a filter expression, click the ellipses next to
the option to open the Event Filter Expression dialog
and enter the expression for the filter. You can use the
tree structure to navigate to the properties that you
want to include in the expression to save time and
typing errors. Use the grammar rules to construct your
expressions. The grammar rules are described fully in
the Using Business Process Insight Guide.

» Actions

These are the actions that you want to set when the
Event is received. These are typically the actions
required to update the properties of the Data
definition with the data from the Event. The actions
are completed in sequence, so the order in which you
enter the actions is important. You can use the equals
(=) button as a short cut to assign each property of the
event to the equivalent property in the Data
definition. This is useful where the names and types of
properties in the Data and Event definition are the
same.
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Ul Elements

Description

Event is for a specific
instance of this data
object (continued)

Note that if you have a number of actions and there is
an error in one of the actions, the erroneous action
fails and subsequent actions are then ignored. All
actions up to the failure are completed. An example of
when an action might fail is when it is attempting to
coerce a string to an integer, when the string contains
characters.

Do not include semicolons as part of an action
expression for Event subscriptions as a semicolon is
always assumed to be an expression separator. Make
sure that you use semicolons only to separate the
expressions for the Data Definition Event Subscription
actions.

» Terminate the instance of the data definition after
handling the event

Use this option when the event subscription is for the
event that completes the process instance. When this
event is received, you want it to terminate the data
instance, otherwise the data instance remains in the
BPI system. The data instance is marked as Complete
and is deleted from the Engine at some point in the
future and according to when the Database Instance
Cleaner utility is configured to run.

Make sure that the data instance is not being used by
multiple processes when setting this option, otherwise
the data instance might be terminated before all the
process instances are complete.

You are advised always to have at least one event
subscription that terminates the data instance if
possible. If you do not have an event subscription that
terminates the data instance, the data instance
remains in the BPI Instance database marked as Active.
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Todo List

Lower part of the Data Definition page that appears when a definition is
being viewed or modified. The Todo List maintains a list of all the tasks that
need to be completed before the definition can be deployed. For details, see
“Todo List” on page 161.

@ Edit Definition Page

The Event Definition page is where you create and modify business Event
definitions for your process. These are the business events that provide the
data to update the properties of the Data definition and indirectly progress
the Business Process. This data is used to populate the Data definitions that
you have created for your process and consists of an Identity and a
Properties dialog, which are described below.

To access Use one of the following:

» From the BPlI Modeler > File > New > Event

» From the BPI Modeler Navigator pane > double-click
an existing Event definition

Important » When creating Event definitions for BPI, make sure

information that the data you are defining for the Business Events
is within the range permitted by the database that you
are using.

» If the menu option for creating a new Event definition
is not available, you need to install the Server
component of HP Business Process Insight. Without
this Server component, you can model Business
Processes and map process Activities to IT operational
resource Cls; however, you cannot create process
models that enable you to monitor individual process
instances within Business Service Management. This
includes creating Event definitions. All options are
visible within the Modeler interface, but some options
are cannot be set or modified unless you have installed
the BPI Server component of Business Service
Management
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Important » If the menu option for creating a new Event definition
Information is not available, you need to install the Server
(continued) component of HP Business Process Insight. Without

this Server component, you can model Business
Processes and map process Activities to IT operational
resource Cls; however, you cannot create process
models that enable you to monitor individual process
instances within Business Service Management. This
includes creating Event definitions. All options are
visible within the Modeler interface, but some options
are cannot be set or modified unless you have installed
the BPI Server component of Business Service
Management

» The Event Definition Editor is enabled for Business
Processes that are created with instance tracking
enabled. If you have not enabled instance tracking for
a Process Definition, you cannot create Event
Definitions for the Process. For details, see “Related
Data Tab” on page 177

Relevant tasks “How to Define Event Definitions” on page 114
See also “Event Definitions” on page 87
Identity Tab

This is used to define the name and optional description of the Event
definition.

» Name — This is a unique name (within the list of Event definitions) and
must be between 1 and 40 characters.

Within openadaptor, you can create hierarchies of Event names under
groups; however, using the BPI Modeler, you can enter only Event names.
If you are using groups within openadaptor, you can include the groups
in the Event definition name. The group is extracted from the Event
name (all the characters up to the final backslash). The Event name is
then all the characters following the final backslash. You can have
between 1 and 40 characters before the final backslash and between 1 and
40 characters after the final backslash.

» Description — Optional free-form field that you can use to document
details of the definition that you want to record.
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You enter the details of the individual properties of the Event through this

Properties pane.

The Properties user interface elements are described below:

Ul Elements

Description

Insert a new row into a table. Adds a new property row
in which you can create a new property.

Delete. Deletes the selected property.

Copy properties from another definition. Opens the
Copy Properties dialog from which you can select a

property from another definition to be inserted as a
property for the current Data definition.

Name

Name for the property. An Event property names must be
between 1 and 40 characters. The name must start with
an alpha character, roman numeral, currency symbol or
underscore (_); thereafter the name can consist of the
same set of characters, plus numeric characters. Property
names must not contain spaces.

Type

This can be a string, double, integer, currency, date, long
or Boolean.

Constraint

The constraint is linked to the Type and is relevant only
to strings and currency Types. For a string the constraint
specifies the maximum length of the string. For currency,
this column specifies the ISO 4217 currency code, for
example, USD, EUR and GBP.

Description

Optional for your own documentation purposes.
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Monitor Definer

This chapter includes:

Concepts

» Business Process Monitor Definer Overview on page 194
» Run-Time Integration on page 195

» BPI Database on page 199

» Monitor Engine on page 201

» Collection Interval on page 203

» BPI Monitor Definer Log Files on page 203

Tasks

» How to Manage the BPI Monitor Definer on page 205
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Concepts

& Business Process Monitor Definer Overview

194

This section describes tasks that are specific to the management of your
Monitor definitions using the Monitor Definer.

Note: You cannot open or use the Monitor Definer, unless you have
installed the BPI Server. The Monitor Definer options appear when the BPI
Server is installed and the connectivity between the BPI Server and the BSM
Gateway Server has been configured and the BPI Server components are
started. This configuration is described in the "Component Configuration -
HP Business Service Management Settings" section of the Business Process
Insight Server Administration Guide.

The Monitor Definer is a Web-based Ul that enables you to define Business
Process Monitors and monitor instance threshold definitions for deployed
processes.

A Business Process Monitor is a business measurement that has a specific
meaning within your business and can be used to record information about
the Business Process that you are monitoring. Monitor instance thresholds
are set on individual monitor instances. When monitor instance thresholds
are violated, instance threshold violations are generated and can be reported
through the Business Process Insight Application Health pages. You can also
configure the Notification Server to send violation messages when a
monitor instance threshold is violated.
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Within BP], the tool for defining Business Processes is separated from the
tool for defining Business Process Monitors for these processes. You use the
BPI Modeler to define your Business Processes and you use the Monitor
Definer to define the Business Process Monitors and monitor thresholds for
these Business Processes. You define Business Process Monitors for a Business
Process after the process has been deployed; this provides more flexibility
for defining and modifying Business Process Monitors without the need to
redeploy your Business Processes.

& Run-Time Integration

When you have defined and deployed your Business Processes and Business
Process monitors, you can then track and monitor the health of your
Business Process relative to the status of the IT operational resources on
which the process Activities depend and on the values of the data being
captured by the Business Event Handler.

The run-time integration progresses the deployed definitions by the events
received through the Business Events Handler. It is through the run-time
integration that the business manager tracks the Business Process, or
processes, through the BPI Application.

You can use the Monitor Definer without the BPI Server, but to use the full
capabilities of the Monitor Definer, you need to install the BPI Server
component of Business Process Insight. The following sections list the
Monitor Definer capabilities without and with the BPI Server:

» “Monitoring - Tracking Individual Process Instances is Disabled” on
page 196

» “Monitoring - Tracking Individual Process Instances is Enabled” on
page 197
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Monitoring - Tracking Individual Process Instances is
Disabled

The following diagram shows the components involved for displaying the
monitoring data when you do not have the BPI Server installed or you have
not enabled tracking of individual process instances.
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The following is a list of the key steps involved for monitoring your Business
Processes:

» Data collectors, such as SiteScope make their data samples available
through the Profile database. This data is then available for Reporting and
SLM.

» The data samples collected from other applications are also used for the IT
operational resource Cls, which can be mapped to Business Activities.

> You need to set health indicator objectives on your IT operational
resource CIs to be able to monitor status changes.
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» BSM calculates the status of the dependencies for the mapped IT

operational resource Cls and makes the results available to the Service
Health.

Service Health combines these results with the process definition model
information (obtained from the Process Repository) and the results are
displayed on the Business Process Diagram within Service Health.

Monitoring - Tracking Individual Process Instances is
Enabled

The following diagram shows the components involved for displaying the
monitoring data when you have the BPI Server installed and you have
enabled tracking of individual process instances.
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The following is a list of the key steps involved for monitoring your Business
Processes. These steps are in addition to those described in “Monitoring -
Tracking Individual Process Instances is Disabled” on page 196:

» In addition to the IT operational resource Cls that are monitored and
reported for your Business Processes, BPI receives business events through
the Business Event Handler.

» The business data relating to individual process instances is stored in the
BPI Instance database.

» At the same time as each new Monitor definition is created in the BPI
database tables, a Business Process Scope CI is created in the RTSM.

» Changes to process instance data that impact the Business Process
Monitors that you have defined are sent to the Monitor Engine, which in
turn updates the relevant tables in the BPI Instance database.

» The BPI Server periodically sends a set of data samples to the Business
Service Management Gateway Server.This period can be configured from
the BPI Server Administration Console; see “Component Configuration -
HP Business Service Management Settings” in the Business Process Insight
Server Administration Guide.

The data samples are held on the BPI Server for a configurable length of
time, until the Business Service Management acknowledges receipt. If a
data sample cannot be delivered in the required time, it is deleted. The
values of these data samples are used to evaluate KPIs within the Business
Service Management environment.

These data samples can also be used for reporting and SLM.
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» The BPI Server polls for the status of Cls to obtain details of the status of
the IT operational resources that the process Activities are linked to. This
period can be configured from the BPI Server Administration Console on
the BPI Server. For more information, see “Component Configuration -
HP Business Service Management Settings” in the Business Process Insight
Server Administration Guide.

» The business event data and monitor data for the process instances is
made available to other BSM components and displayed through the BPI
Application Reports, described in more detail in Chapter 8, “Introduction
to BPI Application Reports”.

Ongoing changes made to the Processes and Monitors in the BPI database
tables are automatically synchronized with the RTSM.

& BPI Database

You can also use filters to further target the statistical data that you want to
collect. This has the added benefit of reducing the amount of data stored in
the database and therefore maintaining the BPI system performance.

The following diagram shows the Business Process Monitor Definer relative
to the Business Monitor data stored in the BPI database.
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You can define monitors for:

» Single Activities
> Multiple Activities
» Whole process

These monitors can be duration based or Process Value based. In addition,
you can define a custom monitor.

Data are collected based on this configuration, and instance thresholds can
be defined to report on individual process instances.

You can also use the Monitor Definer to export Monitor and instance
threshold definitions to an XML file, and subsequently import these
definitions.

How the Business Process Monitors definer interworks with the Monitor
Engine is described in “Monitor Engine” on page 201.
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& Monitor Engine

The Monitor Engine is the component of the BPI Server that analyzes and
provides the statistical results from the Business Process Monitor and
monitor instance threshold data that you define. The Monitor Engine takes
data about the individual instances from the Business Impact Engine and
combines this data with the data you enter through the Monitor Definer to
collect and report on the required information about the process.

The following diagram shows the relationship between the process impact
data and the monitor data that you define.
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The Business Process Monitors and monitor thresholds are configured
through the Business Process Monitor Definer; see “Business Process
Monitor Definer Overview” on page 194.

201



Chapter 4 * Monitor Definer

The Monitor Engine maintains business data for the Business Processes that
are deployed according to the Business Process Monitors that you have
defined. It also maintains statistical information about the monitor
thresholds that are defined.

The following diagram shows how the monitor data is used by the Monitor
Engine to report statistics and instance threshold violations to other BPI
components.
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The statistics that the Monitor Engine calculates are stored in BPI database
tables and are used by the Business Process Insight Application Health pages.
The database tables also hold information used to determine if any monitor
thresholds have been violated. These violations are reported through the
Health pages and can also be reported through the Notification Server or
other HPOM applications.

Managing the Monitor Engine parameters is described in the "Component
Configuration - Monitor Engine" section of the Business Process Insight Server
Administration Guide, and the architecture for the Monitor Engine and
Monitor Definer is described in the "BPI Server Architecture" section of the
Business Process Insight Server Administration Guide.
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& Collection Interval

When you install the BPI Server and configure the integration between BPI
and Business Service Management Gateway Server, you configure the Data
Samples settings. One of the properties of these settings is Data samples send
interval (minutes); this is the time interval used to send data samples to
Business Service Management. The value for the Data samples send interval
becomes the value for the Collection Interval within BPI and you can no
longer modify the value for Collection Interval within the Monitor Definer.

If you import a previously exported Business Process Monitor.zip archive
file, the value for the imported Collection Interval is imported and recorded;
however, when the integration with Business Service Management is
enabled, the value for Collection Interval is not used. The value is imported
in order that it is available for use if the integration with Business Service
Management is subsequently disabled. The value used for the Collection
Interval, in the case of importing to a system where the Business Service
Management integration is enabled, is the value set for the Data samples
send interval.

& BPI Monitor Definer Log Files

There are two sets of log files that you need to be familiar with when
managing your Business Process Monitors:

» Monitor Engine log files

The Monitor Engine log files are managed in the same way as other BPI
Server components and are described in the "Component Configuration -
Logging" section of the Business Process Insight Server Administration Guide.

» Monitor Definer log files

The Monitor Definer logs messages to the BPI Servlet Engine log file.
These messages in the Servlet Engine log file are prefixed with the string
Monitor Definer. The Servlet Engine is considered as a component of the
BPI Server. The Servlet Engine log file is described in the "Component
Configuration - Logging" section of the Business Process Insight Server
Administration Guide.
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Warning Messages in Log Files

Each time a Business Monitor is created with an associated Monitor
Threshold or Group, a warning is generated in the Business Process Engine
log file. This warning is added by Hibernate and can be ignored; there is not
a problem with the Business Monitor.
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Tasks

P How to Manage the BPI Monitor Definer

The following are the management tasks that you can complete using the
BPI Monitor Definer.

> “Open the Monitor Definer” on page 205
> “Export and Import Monitor Definitions” on page 206

For details about creating and modifying monitors, see the Monitor Definer
online Help.

Open the Monitor Definer

Before trying to start the BPI Modeler, make sure that the Process Repository
component is started on the BPI Server system. Use the BPI Server
Administration Console to start the Process Repository as described in the
"Starting and Stopping the BPI Server Components" section of the Business
Process Insight Server Administration Guide.

To open the BPI Monitor Definer:
1 Select Admin > Business Process Insight.

You are presented with a tabbed page that includes a tab for Monitor
Definer.

2 Click the tab for the Monitor Definer and you are presented with a page
listing any processes that are deployed and any monitors defined for
these processes.
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Following is an example of the layout of the Monitor Definer when you
open it.
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Export and Import Monitor Definitions

The BPI Monitor Definer has options that enable you to export and
subsequently import the Business Process Monitors, monitor thresholds and
filters defined for a selected Business Process. You might want to export a
Business Process Monitor definition to enable you to create Business Process

Monitors for testing and then move these monitors to a production system
when they are fully verified.
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These definitions can be exported to a .zip archive file, which contains XML
files describing the definitions. The .zip archive contains a copy of the
monitor definition and some (but not all) information about the parent
Process definition. The information relating to the Process definition is that
required to uniquely identify the Process definition that the Business
Process Monitor applies to. The .zip archive file does not contain all the
information relating to files that you might have created for custom
Business Process Monitors; it contains the custom monitor definition, but
you need to separately manage and export any SQL you have created for the
custom monitor definitions.

Be aware that the .zip archive created from the Monitor Definer is not the
same as the .zip archive created from the BPI Modeler. You cannot
interchange the .zip archives between the two applications, you must import
the archive created from the appropriate application. This is because the .zip
archive from the Monitor Definer contains sufficient information about the
Business Process to enable the Monitor Definer to import the monitor; it
does not contain a full definition of the Business Process.

Note: You cannot import a monitor definition until the process definition
that the monitor applies to is deployed to the Business Impact Engine. Refer
to section “Exporting and Importing” on page 66 for details of exporting
and importing process definitions.

Exporting a Business Process Monitor

To export one or more Business Process Monitors, use the Export or Export All
options from the File menu in the Monitor Definer Navigation frame.

When you select a Business Process Monitor to export, all the associated
monitor instance threshold and filters are also exported. The export is based
around the identifier of the Business Process that the Business Process
Monitor is linked to. All the information, including monitor thresholds and
filters, is exported to XML files, which are then packaged into an overall .zip
archive file. The .zip file can then be copied to the destination system to be
imported.
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When you export a Business Process Monitor, you also need to make a copy
of any additional files that you might have created that are associated with
the Business Process Monitor; for example, you might have defined a
custom monitor. In the case of a custom monitor, you need to make sure
that you have a copy of any SQL files that you have created for the custom
monitor.

The name of the exported file is based on the Process name, machine name
and time that the monitor is exported, so that a unique name is provided for
the .zip archive file. If any of the elements of this constructed file name
contain non-ASCII characters, the elements are excluded from the file name.
This is because Internet Explorer permits only .zip archive file names that
contain ASCII characters.

Importing a Business Process Monitor

Before importing a Business Process Monitor, you must have already
imported and deployed the Business Process to which the Business Process
Monitor is linked.

In addition, if you have defined custom monitors, and you are moving the
definitions to a new machine, make sure that you also copy any files that
you have created for the custom monitor to the new machine. For example,
you might have created SQL files for your custom monitor and this SQL file
is not exported as part of the .zip file. If you do not copy the files relating to
any custom monitors before importing the Monitor definition and creating
the appropriate stored procedures, the import fails.

To import the Business Process Monitor, complete the following steps:
1 Select File > Import on the Monitor Definer navigation frame:

The right-hand pane provides a browse button that you can use to
navigate to the file where the file that you want to import is located.

2 Select the file that you want to import and click Open.
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3 Click the Import Definitions button.

The Monitor Definer provides a summary of the monitor definitions
contained in the zip file and how they will be applied to the processes
that are currently defined on your system. You need to check that the
monitor definitions in the zip file are being applied to the correct process
definitions before importing the file. As an example, you need to make
sure that you have not renamed a process since a monitor definition was
exported.

4 Select the checkbox next to each set of Business Process Monitors that
you want to import from the zip archive file.

5 Click Import Definitions.

The Monitor Definer displays a feedback message indicating whether it
successfully imported the selected monitor definition.

6 Click OK and the Monitor Definer returns to the Monitors and Thresholds
page for the process.

If you import monitor definitions which are named identically to monitor
definitions that are already defined within the Monitor Definer, they are
imported and renamed (appended with a number), to make them unique.
Instance threshold names are not changed as they need only be unique for
the Monitor definition that they apply to.
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Process Repository Explorer

This chapter includes:

Concepts

» Process Repository Explorer Overview on page 212

Tasks

» How to Use Repository Explorer to Complete Tasks on page 215
Reference

» Process Repository Explorer User Interface on page 220
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Concepts

& Process Repository Explorer Overview
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The Repository Explorer is a Web-based interface that enables you to view,
print and manage the contents of the Process Repository Database. The
Repository Database is a set of database tables that hold the data for the
Business Processes that you have defined using the BPI Modeler.

Note: You cannot open or use the Process Repository Explorer unless you
have installed the BPI Server. The Process Repository Explorer options appear
when the BPI Server is installed and the connectivity between the BPI Server
and the Business Service Management Gateway Server has been configured.
This configuration is described in the "Configuring the BPI Server to
Connect to a Gateway Server or Load Balancer" section in the Business
Process Insight Server Administration Guide.

The data presented by the Repository Explorer contains a super-set of
information. It shows definitions that were once deployed, are currently
deployed, and definitions that have been edited and not yet deployed.

This is because you might have modified the process within the BPI
Modeler, but not yet redeployed the process.

Using the BPI Modeler, you can create, modify and subsequently deploy a
definition. When you have deployed the definition, you might then go on
and revise the definition and significantly change it. This means that, unless
you have exported the version of the definition that you previously
deployed, you no longer have a copy of it within the BPI Modeler. You can
therefore be in the position of having a deployed process, but no copy of the
source for the process. For information about creating definitions using the
BPI Modeler, see Chapter 3, “Modeler Management.”

The Repository Explorer enables you to always access the source to versions
of processes that you have created and deployed.
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Using the Repository Explorer you can:

» See whether a process is defined for instance tracking or not.
» View all the details of your currently deployed processes in a tabular form.
» Browse and print definitions.

» Export the latest version of a deployed definition, or latest versions of all
deployed definitions.

» Import previously exported definitions.

» Remove definitions and move them to the Recycled folder within the
Repository Explorer. And permanently remove deleted definitions from
the Recycled folder.

» Restore a definition that has been deleted, but not permanently removed,
using the BPI Modeler or Repository Explorer.

» Undeploy and permanently remove definitions that have completed from
the Recycled folder.

The Repository Explorer is a view on the Process Repository data, which is
created using the BPI Modeler and stored in the Process Repository database
tables. You can browse and manage the data using the Repository Server as

shown below.
R epositary
Databaze

Fepositary Explorer Process Defintions

Process  |t— D ata Defintions
Repositary |7 ¥

Event Defintions

w
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Process Repository Explorer Log Files

The Repository Explorer uses the Repository Server to access its data and the
Repository Server logging is recorded under Process Repository in the BPI
Server Administration Console. For details of the logging settings that are
used for BPI components, see “Component Configuration - Logging” in the
Business Process Insight Server Administration Guide.

In addition, you can find log messages for the Repository Explorer in the
Servlet Engine log file.



Chapter 5 © Process Repository Explorer

Tasks

T How to Use Repository Explorer to Complete Tasks

The following are the tasks that you can complete using the Repository
Explorer:

“Open the Repository Explorer” on page 215
“Browse Definitions” on page 216

“Print Definitions” on page 216

>
>

>

» “Delete Definitions” on page 216

» “Export Process Definitions” on page 216

» “Undeploy a Process Definition” on page 219
>

“Restore a Definition” on page 219

Open the Repository Explorer

Before trying to use the BPI Repository Explorer, make sure that the Process
Repository and Servlet Engine components are started on the BPI Server
system. Use the BPI Server Administration Console to start these
components, as described in the "Starting and Stopping the BPI Server
Components" section of the Business Process Insight Server Administration
Guide.

To open the BPI Repository Explorer, complete the following steps:

1 Make sure that the Process Repository and Servlet Engine components are
started.

2 Select Admin > Business Process Insight.
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Browse Definitions

Using the Repository Explorer, you can easily browse the current and earlier
revisions of a definition to quickly see how they were defined. You need to
be able to do this as the BPI Modeler is optimized for editing and not for
browsing and therefore does not present the information relating to Process,
Data and Event definitions in an easy-to-view way.

Print Definitions

You can also print definitions using the print option at the top right-hand
corner of the UL This print option enables you to print the contents of the
right-hand pane in the Details view.

Delete Definitions

You can delete any definition using the Repository Explorer, provided it is
not the current version of the definition that has instances currently
running in the Business Impact Engine.

To delete a definition:

1 Select the definition that you want to delete from the Navigator Frame
(see “Navigator Frame” on page 221).

2 Click the History tab (see “History Tab” on page 225).

3 Select the check box for the definition, or definitions that you want to
delete.

4 Click Delete.

Export Process Definitions

The Repository Explorer can be used to export any revision of a definition
from the Process Repository.

Note: This definition is compatible with the Modeler and not the Monitor
Definer; it does not contain any Business Process Monitor information.
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You might have multiple versions of a definition where you have deployed
the Process definition multiple times. You can also export the latest version
of a definition using the BPI Modeler; however, you cannot export earlier
revisions of a definition using the Modeler, you can do this only through
the Repository Explorer.

In addition to exporting individual versions of a definition, you can also
choose to export the latest revision of all definitions from the Process
Repository; you might want to do this to move all the latest definitions to
another BPI Server.

You can export single definitions or all definitions:

» single definitions, see “Exporting a Single Definition” on page 217.

You might want to do this to take a copy of the latest revision of the
definitions. The latest version of the definition is exported to a .zip file.
Exporting the definitions through the Repository Explorer, or the BPI
Modeler, also ensures that the definitions are consistent within
themselves as the definition and all its dependencies are exported.

> all definitions, see “Exporting All Definitions” on page 218.

You might want to do this to move the definitions from one BPI Server to
another BPI Server, for example, from a development system to a staging
system. The latest versions of all the definitions within the Process
Repository are exported to a .zip file, including all the dependencies.

Exporting a Single Definition
To export a definition, complete the following steps:

1 Select the definition that you want to export from the left-hand Navigator
pane.

2 Select File > Export in the Navigation pane.
3 Select the History tab in the right-hand pane.
4 Select the revision of the definition that you want to export from the list.
5 Click the Export button in the right-hand pane.
The right-hand pane lists the definition that will be exported.
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6

9

Click the Download button to continue to export the definition.
You are presented with your browser’s File Download dialog.
Select Save, to save the definition as a .zip file.

The Save As dialog displays, where you can specify a file name and
directory location for the .zip file.

Enter the details of the file name and click Save.
The file is saved and a Download complete dialog is displayed.

Click Close and the export is complete.

Exporting All Definitions

To export all definitions, complete the following steps:

1

Select File > Export All in the Navigation pane.

The right-hand pane lists the definitions that will be exported.
Click the Download button to continue to export the definition.
You are presented with your browser’s File Download dialog.
Select Save, to save the definition as a .zip file.

The Save As dialog displays, where you can specify a file name and
directory location for the .zip file.

Enter the details of the file name and click Save.
The file is saved and a Download complete dialog is displayed.

Click Close and the export is complete.
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Undeploy a Process Definition

You cannot use the Repository Explorer to undeploy a specific definition.
You must use the BPI Modeler to do this. You can use the Cleanup Recycled
option within the Repository Explorer to undeploy and delete all current
revisions of definitions held in the Recycled folder; see “Navigator Frame”
on page 221.

Be aware that undeploying an Event definition, which is referenced by a
Data definition that has current active instances, means that these data
instances might not be able to progress. If this is the case, you can use the
Process Intervention Client to delete the individual Data definition
instances.

Restore a Definition

The Repository Explorer can be used to restore definitions that have been
deleted using the BPI Modeler. These definitions are listed in the Recycled
folder on the Navigator frame.

You can access the Restore option from the File menu on the Navigator
frame. The steps for restoring a previously deleted definition are as follows:

1 Select the definition that you want to restore from the Recycled folder.
2 Select File > Restore in the Navigator frame.

The definition is restored to the Process Repository and is removed from
the Recycled folder in the Repository Explorer. The restored definition
appears under the appropriate definition list in the Repository Explorer.
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Reference

@ Process Repository Explorer User Interface

The Process Repository Explorer page enables you to view, print and manage
the contents of the Process Repository Database.

Following is an example of the layout of the BPI Repository Explorer.
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To access Admin > Business Process Insight > Process Repository
Explorer

Relevant tasks “How to Use Repository Explorer to Complete Tasks” on
page 215

See also “Process Repository Explorer Overview” on page 212

The Repository Explorer consists of the following main areas:

» “Navigator Frame” on page 221
» “Details Tab” on page 223
» “History Tab” on page 225

Navigator Frame

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

<folders> Process, Data and Event definitions have been created in
the BPI Modeler.

The deployment status (deployed or undeployed) of each
definition is displayed using the same icons used within
the BPI Modeler. For details on the Modeler, see

Chapter 3, “Modeler Management.”

Recycled folder, which lists definitions that have been
deleted from the BPI Modeler. When you delete a
definition using the BPI Modeler, the definition is moved
to this Recycled folder, which is accessible only from the
Repository Explorer.
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Ul Elements

Description

File

The menu includes the following options:

» Export. Enables you to export the selected definition
to a zip file. For details see “Export Process
Definitions” on page 216.

» Export All. Enables you to export the latest revision of
all the definitions in the Navigator frame to a zip file.
For details see “Export Process Definitions” on
page 216.

» Restore. This option is available when you select a
definition from the Recycled folder. It restores the
definition back to its original location in the Process
Repository, at the point where it was deleted in the BPI
Modeler. For details see “Restore a Definition” on
page 219.

» Cleanup Recycled. This option deletes all definitions
in the Recycled folder and undeploys definitions that
are deployed. If a definition is still in use by the
Business Impact Engine, it is not deleted or
undeployed. When all instances of these definitions
have completed, these entries can then also be
removed using the Cleanup Recycled option and the
entries no longer appear in the interfaces. The
instances of definitions are deleted by the Business
Impact Engine using the Engine Instance Cleaner.

Note: When you select a definition in the Navigator
frame, the right-hand frame opens at the Details tab as
described in “Details Tab” on page 223. You can select
the History tab described in “History Tab” on page 225.

Refresh

Click to refresh the Navigator frame to be up-to-date with
the latest definitions that have been recently entered into
the Process Repository using the BPI Modeler.
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Details Tab

The Details tab provides details of the definition that you have selected in
the Navigator frame. Much of the information listed under the Details tab
can be determined from the BPI Modeler. However, the Repository Explorer
provides the information in a structured form, which makes it easier to
reference and print.

The information listed under the Details tab varies according to the type of
definition selected in the Navigator frame: Process, Data, or Events. For
more information, see Chapter 3, “Modeler Management.”

Following is an overview of all the sections under the Details tab for all the
definitions:

Ul Elements Description

Activities This section appears only for a Process definition and lists
details of the individual Activities that make up the
Process definition, including:

» Name of the Activity: shown next to the icon for the
Activity.

» Type of Activity: Start, End, Junction or Business
Activity.

» Start Condition: associated progression rule.

» Complete Condition: associated progression rule.

» Image File: File name of the image selected for the
Activity’s icon.

» Related Cls: List of any ClIs that the Activity is linked
to.

Checked Arcs This section appears only for a Process definition and lists
details of the arcs that have been defined as Checked Arcs
for the Process definition. For details, see “Check
Sequence Arc” on page 82.
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Ul Elements

Description

Identity/Summary

This section appears for all the definitions and lists an
overview, or summary, of the definition.This includes
information that you have entered relating to the
definition using the BPI Modeler, and information
relating to the revision of the definition.

This section also lists the revision number of the
definition and details of the other definitions that the
selected definition uses and is used by.

Process Diagram

This section appears only for a Process definition and
shows the Process Diagram of the selected process. It is
the same Process Diagram as shown in the BPI Modeler.

Properties

This section appears for Data and Event definitions and
lists details of the properties that have been defined for
the selected definition.

Related Data

This section appears only for a Process definition and lists
details of the Data definition that has been defined as the
Related Data definition for the selected Process
definition. This section includes whether the option to
track instances has been enabled for the selected process
and whether there is a Group property for collecting data
by group.
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Ul Elements

Description

Subscriptions

This section appears only for a Data definition and lists
details of the Event subscriptions related to the Data
definition and includes:

» Name of the subscription, which is shown adjacent to
the icon for the subscription.

» Subscription Description: Description as entered in the
Modeler.

» Event Binding Expression: Binding specified to
associate a specific event property from the Business
Event to the corresponding Data Definition key
property.

» Creation Option: Conditions under which you have
requested that the Event definition can be created.

» Filter Expression: Additional filtering that you can
define to be applied to the incoming business event.

» Actions: Action that you have specified for extracting
the required properties from the Business Event in
order that they can be placed into the Data Definition.

ToDo List This section appears for all the definitions and lists the
content of the current to-do list for the selected
definition.

History Tab

The History tab provides a page tabulating the details of the revision history
related to the selected definition in the Revision History table.

These details include:

» Revision number

» Deployment status

» Name of process as defined in the Modeler

» Date the revision was last saved

» Description (from the Description field in the definition)

» Labels, which is the date and time that the revision was deployed.
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Each entry in the table has a check box which you can select (and clear).
When you select the check box for one, or more, of the definitions in the
table, the Export and Delete options are made available. The Export option
is available only if you select a single entry. If you select more than one
definition, or do not select any definitions, the Export option is not
available.

If you want to export a definition on the Revision History table, select the
definition, click the Export button and then follow the instructions that are
presented to you by the Repository Explorer.

There is also a delete option available for each revision of the definition. You
cannot delete a definition that is currently being processed by the Business
Impact Engine, if you do try to delete such a definition, the Repository
Explorer issues a warning message and does not permit the delete action to
progress.

You can select any version of a definition to delete, including the current
version of a definition. In the case of the current definition, the Repository
Explorer issues a warning message for you to confirm the delete action and
then continues.

Caution: You cannot recover any definition that is deleted using the
Repository Explorer.
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Process Intervention

This chapter includes:

Concepts

» Process Intervention Overview on page 228

» Why Use the Process Intervention Client on page 229
Tasks

» How to Use the Process Intervention Client on page 232
Reference

» Process Intervention User Interface on page 239
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Concepts

& Process Intervention Overview
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This section describes how you can make changes to your Business Process
data, and delete completed instances of Process and Data definitions using
the Process Intervention Client.

You might want to modify or delete deployed Process instances to resolve
problems with the process, or its data. This is usually required after a period
of new development or where progression rules are not behaving as
expected; for example, you might need to:

» Manually progress and delete Process instances.
» Update and delete Data definition instances.

You use the Process Intervention Client to remove individual Process
instances or Data instances from the BPI Instance database. If you want to
delete several completed or active instances on a regular basis you should
use the Engine Instance Cleaner parameters as described in the "Deleting
Completed Instances from the Database" chapter of the Business Process
Insight Server Administration Guide.

Note: When you remove process and Data instances from the BPI Instance
database, they are not removed from the BPI Profile database, which
contains aggregated data for reports. If the Profile database becomes too
large, you can use the Partition and Purging Manager as described in
“Partitioning and Purging Historical Data from Profile Databases” in
Platform Administration.
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& Why Use the Process Intervention Client

When you use the Process Intervention Client to delete or modify
definitions and instances, you have identified an anomaly using the
Business Process Insight Application, and are therefore using the Process
Intervention Client to solve a specific problem. In this case, you have the
identifier of the definition that you want to modify and you can enter this
identifier directly on the search page to access the definition that you want
to modity. Alternatively, you can use the Process Intervention Client’s
tiltering capability to search for the instance that you want.

You need to be aware of the following when using the Process Intervention
Client:

» When selecting the option to delete a Process and associated Data
definition, make sure that the Data definition is not also a dependency
for other Process definitions. If the Process Intervention Client detects
that by deleting the Data definition other deployed processes are affected,
it presents you with a page that lists all the processes that also depend on
the Data definition, where appropriate.

» When you select the option to delete a Data instance, or a Process
instance including all its Data instances, you can potentially leave other
Process instances in an indeterminate state.

This is a similar scenario to the previous bullet describing Process and
Data definitions; however, in the case of instances, the Business Impact
Engine cannot determine any relationships between the Data instance
that is being deleted and other Process instances that might have a
dependency on it.

If you do delete a Data instance and there are Process instances that
depend on it, the process can no longer progress.

If you want to delete a significant number of Process instances or Data
instances, the quickest way to achieve this is to delete the Process definition
or Data definition; however, this deletes all instances of the Process and
Data definitions, including any active instances. You can then redeploy the
Process and Data definitions using the BPI Modeler.
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The following are some examples of why you might want to use the Process
Intervention Client:

» Where a Process instance has progressed through a process, but one or

more Activities that should be complete still appear as active.

You can use the Process Intervention Client to change the state of the
active Business Activities to Complete. Activities can get into this state if
you have manually progressed a Process instance, for example, when an
application that usually provides the service is not available and you have
substituted another application to complete the Activity.

When the start and complete conditions for an Activity are incorrect and
therefore cannot be satisfied. In this case, you might want to delete all
instances of the process and any associated process data.

Where you want to progress a specific Process instance to its completion,
for example, there might be an order processing instance waiting for an
automated system to enter credit card information, and the automated
system is not operational. In this case, you can modify a Data instance to
add credit card information manually and progress the order for a
customer.

To remove erroneous processes to tidy up your system. You might need to
do this if you have been developing new processes and want to remove
older versions, which are no longer required.

Where you want to search for all Process instances over a certain age and
remove them. You can also do this using the instance cleaner parameters
tools (see the "Deleting Completed Instances from the Database" chapter
of the Business Process Insight Server Administration Guide). However, you
might not want to remove all the Process instances, just for one specific
process.

To delete an orphaned Data definition that is not linked to a Process
definition, or perhaps where the Data definition was linked to a Process
that has been deleted.

To test your BPI system. You might want to delete all the active Data
definitions to reset the system.

To reset the totals and averages for Process and Data definitions. You
might want to do this periodically (daily, weekly, monthly) so you can see
the totals and averages in terms of a known period.
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» To manually synchronize the BPI Cls with the RTSM for reasons such as:

» An earlier synchronization failed when you deployed a definition
using the Modeler, and you want to invoke another one immediately
and not wait for the background synchronization to run.

» ClIs have been deleted from the RTSM in error and you want to
reinstate them. In this case, the synchronization adds, removes and
updates CIs for the latest installation of BPI (including upgrades). If
you have previously installed BPI and then removed it without
undeploying definitions, these definitions are not synchronized.

Using the Synchronize with the RTSM option to delete all existing BPI CIs
from the RTSM provides the option to remove all BPI-related Cls
regardless of who or what created them. The delete action is completed
before the synchronization is started. This option is useful if you want to
clean out CIs that have been created by prior BPI installations.

Note: If you want to clean up your development system, it is
recommended that you use the Process Intervention Client to remove the
definitions and all their instances from the Business Impact Engine and
then redeploy the process or processes that you want to use.
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® How to Use the Process Intervention Client

232

The following are the tasks that you can complete using the Process
Intervention Client.

> “Delete Process or Data Definitions and Clear Data” on page 232

» “Delete Instances” on page 233

\

“Modify the Data within a Data Instance” on page 233

\

“Search for Specific Instances” on page 234

\

“Edit the Status of the Activities in the Process Diagram” on page 236
» “Synchronize with the RTSM” on page 238

Before completing any of these tasks, you are advised to read “Why Use the
Process Intervention Client” on page 229, which provides information
about the possible impacts of making these changes.

Delete Process or Data Definitions and Clear Data

To delete or clear Process or Data definitions:

1 Open the Process Intervention page.

2 Select the Process Definitions or Data Definitions option as appropriate.
3 Select the Process or Data definition you want to edit.

4 If you select the Process definition, choose one or more of the following
options and click OK (for descriptions of these options, see “Process
Definition Page” on page 240):

Delete Process and Monitor Definitions and instances
Delete Process, Monitor and Data Definitions and all related instances

Clear Average Time and Total Instance Count (Process and Activities)
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5 If you select the Data definition, choose one or more of the following
options and click OK (for descriptions of these options, see “Data
Definitions Page” on page 246):

Delete Data Definitions and instances
Delete Average Time and Total Instance Count

To delete individual instances and not the Process or Data definition, see the
next section, “Delete Instances” on page 233.

Delete Instances

To delete instances of a Process or Data definition:

1 Open the Process Intervention page.

2 Select the Process Definitions or Data Definitions option as appropriate.
3 Select the Process or Data definition you want to edit.
4

Click the Search link to open the <Process or Data> Instance Search
dialog.

For information about completing the search criteria, see “Search for
Specific Instances” on page 234.

5 Enter the search criteria or leave the form blank and click the Search
button to initiate the filter.

The <Process or Data> Instance List displays.

6 To delete specific instances, select one or more instances, then click
Delete.

7 To delete all instances, click Select All, then click Delete.

Modify the Data within a Data Instance
To modify the data in a Data instance:

1 Open the Process Intervention page.

2 Select the Data Definitions option.

3 Select the Data definition you want to edit.
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4 Click the Search link to open the Data Instance Search dialog.

For information about completing the search criteria, see “Search for
Specific Instances” on page 234.

5 Enter the search criteria or leave the form blank and click the Search
button to initiate the filter.

The Data Instance List displays.

6 Select the instance that you want to modify and click the Edit button at
the bottom of the page.

The Data Instance details dialog displays with the criteria for the selected
instance in an editable form.

7 Modify the instance as follows:

» To change the criteria for one or more fields, edit the text, click the
Amend check box next to each field you are changing, then click OK.

» To set the criteria for one or more fields to Null, click the Null check
box and the Amend check box next to each field you are changing,
then click OK.

Note: You must check the Amend check box for the criteria to be changed
in the BPI Instance database. Otherwise, clicking OK does not change the
criteria.

» To clear changes you made before clicking OK, click the Reset button.
After you click OK, the instance is changed in the database.

8 You can continue and make changes to other instances in the same way,
or click Cancel to return to the Process Intervention page.

Search for Specific Instances
To search for a specific instance of a Process or Data definition:
1 Open the Process Intervention page.

2 Select the Process Definitions or Data Definitions option as appropriate.
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3 Click the Search link for the selected definition.

The <Process or Data> Instance Search dialog displays. The search dialog
varies according to whether you are searching for a Process or a Data
instance.

4 Enter the criteria for the search as appropriate.

» For a Process instance, you can enter a Process instance identifier
directly, or you can filter for instances according to the following
criteria:

» Process instances with a specific identifier and value for the Process
Value parameter.

» Process instances within specified time periods.

» Process instances with a particular status, for example: Active or
Completed.

» For a Data instance, the criteria on the form directly reflects the
attributes in the Data properties of the Data definition in the Modeler.
You can filter for instances according to the attributes set in the
Modeler.

For example, if the Type attribute is set for a Data instance as an
Integer, the Type field displays on the form where you would enter a
numeric value.

5 Click the Search button to initiate the search. If you want to return to the
previous screen click Cancel.

You can leave the search criteria blank, in which case Process Intervention
returns all the instances for the selected definition.
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Edit the Status of the Activities in the Process Diagram

The Process Diagram shows the status (such as Activated or Completed) of
each Activity in the Process definition. You can progress Process instances
from this option by manually activating or completing Activities in the
process.

To edit the status of Activities in the Process Diagram, complete the
following steps:

1 Open the Process Intervention page.
2 Select the Process Definitions option.
3 Click the Search link to open the Process Instance Search dialog.

For information about completing the search criteria, see “Search for
Specific Instances” on page 234.

4 Enter the search criteria or leave the form blank and click the Search
button to initiate the filter.

The Process Instance List displays.

5 Select the instance that you want to modify in the Process Diagram and
click Edit.
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The Process Diagram displays the status of each Activity as shown in the
following example:
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6 You can Activate or Complete the Activity by clicking in the appropriate
button next to the Activity. This change overrides the BPI Instance
database.

The check mark Lindicates that the Activity instance has completed at
least once.

The cog wheel §| indicates that the Activity instance has been activated
(started).

You can click the Reset button to clear changes before you click OK.
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7 Click OK and any changes you made are shown on the Process Diagram.

8 You can continue and make changes to other instances in the same way,
or click Cancel to return to the Process Intervention page.

Synchronize with the RTSM

To synchronize the BPI definitions with those held in the RTSM, complete
the following steps:

1 Open the Process Intervention page.
2 Select the Synchronize with the RTSM option.

You have the option to delete all existing BPI CIs from the RTSM before
synchronizing. This is useful if there are CIs in the RTSM that have been
created by previous installations and processes were not undeployed
before BPI was uninstalled.

3 Select the check box if you want to delete all existing BPI CIs, clear the
check box if you do not want to delete them.

4 Click the Synchronize button to begin the synchronization.
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Reference

®. Process Intervention User Interface

This section describes:

» Process Definition Page on page 240

» Data Definitions Page on page 246

» Synchronize with the RTSM on page 249
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@ Process Definition Page

The Process Definition page enables you to delete and modify deployed
Process, Monitor or Data definitions and instances from the BPI Instance
database.

Note: To open or use the Process Intervention page, you must have installed
the BPI Server and configured the connectivity between the BPI Server and
the Business Service Management Gateway Server. This configuration is
described in the "Component Configuration - HP Business Service
Management Settings" section of the Business Process Insight Server
Administration Guide.

To access Admin > Business Process Insight > Process Intervention
Tab > Process Definitions

Important For details on the affects of deleting or modifying Process
information definitions or Process instances, see “Why Use the
Process Intervention Client” on page 229.

The Process definitions within the Modeler are not
impacted by the actions of the Process Intervention
Client, so you can redeploy the Process. However,
Activated and Completed instances of the Process are
potentially impacted by changes made through the
Process Intervention Client.

Relevant tasks “How to Use the Process Intervention Client” on
page 232
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The following table describes the user interface elements of the Process
Definition List (unlabeled UI elements are shown in angle brackets).

Ul Elements

Description

Delete Process and Monitor
Definitions and instances

Deletes all Process and Monitor definitions and
their associated instances from the BPI Instance
database.

Delete Process, Monitor and
Data Definitions and all related
instances

Deletes all Process, Monitor. and Data
definitions and their associated instances from
the BPI Instance database.

Clear Average Time and Total
Instance Count (Process and
Activities)

Resets the total instance count shown in the
Process Diagram. It also resets the average
duration which is not currently displayed in the
UL

Search

Opens the Process Instance Search window
where you can filter for specific Process instances
or see all of them. For details, see “Process
Instance Search” on page 242.
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Process Instance Search

The Process Instance search criteria, described in the following table,
correlates with the Process definition’s Related Data properties, set in the
Modeler. For details, see Chapter 3, “Modeler Management.”

The following table describes the user interface elements of the Process
Instance Search dialog.

Ul Elements Description

Identifier Unique number that identifies the Process
instance. For more details on the identifier, see
“Instances Dialog Settings for a Business Process”
on page 338.

This identifier can also be seen when drilling
down to the Process Instances Dialog from the
Health page, see “Process Instances Dialog” on
page 336

The identifier is set in the Modeler’s Process
Editor. For details, see Chapter 3, “Modeler
Management.”

Value The content of the Value attribute for the listed
Process instance.

Value is based on the Process Value property of
the Business Process. The Process Value is
configured when you create the Business Process
in the Modeler. The value is typically assigned
from a Business Event when the process is
Active.

Start Time The time that the Process instance fulfilled the
Start Condition for the Start Activity.

End Time The time that the Process instance fulfilled the
End Condition for the End Activity, if applicable.
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Ul Elements

Description

Status

The status of the Process instances that you
want to list. Select the value Any to list all
Process instances in all states.

Select one of the following;
> Any

» Healthy

» At Risk

> Blocked

» Completed

See “Process Status” on page 315 for descriptions
of the status values.

Process Instance ID

Unique identifier for the Process instance.

Search button

Opens the Process Instance List. For details, see
“Process Instance List” on page 244.

» If search criteria was entered, the list shows
only the Process instances that match the
search criteria.

» If the search criteria is left blank, the list
shows all Process instances for the selected
Process definition; see “Process Instance List”
on page 244.

For instructions on setting the search criteria, see

“Search for Specific Instances” on page 234.

Clear Form

Clears all changes before clicking OK.
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Process Instance List
The Process Instance List shows in tabular form, all the Process instances
that matched the search criteria, and the attributes for each instance.

The following table describes the user interface elements of the Process
Instance List (unlabeled Ul elements are shown in angle brackets).

Ul Elements Description

Edit Displays the Process Diagram, which shows the
status of each Activity in the Process, and
enables you to edit the Activity status. For
details, see “Process Instance Diagram” on
page 244.

Delete Removes one or more selected Process instances
from the BPI Instance database.

Select All Selects all the Process instances in the list.

Unselect All Unselects all the selected Process instances.

Process Instance Diagram

The Process Instance Diagram shows the status of each Activity in the
process, for example, whether it is in the Activated (Started) or Completed
state. You can progress Process instances from the Process Diagram by
manually activating or completing Activities in the process..

To access: Select Admin > Business Process Insight > Process Intervention Tab >
Process Definitions > click the Search link > enter search criteria or leave blank >
click the Search button > select an instance > click Edit.

For an example of the Process Instance Diagram, see step 5 in “Edit the
Status of the Activities in the Process Diagram” on page 236.
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The following table describes the user interface elements of the Process
Instance Diagram (unlabeled Ul elements are shown in angle brackets).

Ul Elements

Description

7

Indicates that the Activity instance has
completed at least once.

&

Indicates that the Activity instance is started.

<no icon> Indicates that the Activity instance is not started
or completed.
OK button Applies the changes you made to the Activity

states and refreshes the diagram, showing the
changed state.

Reset button

Removes any options you selected before
clicking OK.

Activate

Manually activates the corresponding Activity.

Complete

Manually completes the corresponding Activity.
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® Data Definitions Page

The Data Definition page enables you to modify or delete deployed Process
instances and their associated Data instances from the BPI Instance
database.

To access Admin > Business Process Insight > Process Intervention
Tab > Data Definitions

Important For details on the affects of deleting or modifying Data
information definitions or Data instances, see “Why Use the Process
Intervention Client” on page 229.

The Data definitions within the Modeler are not
impacted by the actions of the Process Intervention
Client, so you can redeploy the Data definition. However
all active instances of the Data definition, and possibly
the associated Process definition, are impacted by
changes made through the Process Intervention Client.

NOTE: If you make changes to the values of Data
properties within a Process, the progression rules
associated with the Data properties are evaluated and the
Process progresses, based on the new values.

Relevant tasks “How to Use the Process Intervention Client” on
page 232
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The Data Definition list provides a list of Data Definitions that are currently
deployed in the Business Impact Engine.

The following table describes the user interface elements of the Process
Definition List (unlabeled UI elements are shown in angle brackets).

Ul Elements

Description

Delete Data Definition and
instances

Deletes all Process and Monitor definitions and
their associated instances from the BPI Instance
database.

Clear Average Time and Total
Instance Count

This clears (or removes) the values for
Totallnstances and AvrgTime from the Data
objects table in the BPI Instance database. The
Business Process Insight Server Administration Guide
provides lists of all the database tables defined
for BPI.

Search

Opens the Data Instance Search window where
you can filter for specific Data instances or see
all of them. For details, see “Data Instance
Search” on page 248.
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Data Instance Search

You can select the Search link to identify specific instances of the Data
definition. For details, see “Search for Specific Instances” on page 234.

The following table describes the user interface elements of the Data
Instance Search window (unlabeled UI elements are shown in angle
brackets).

Ul Elements Description

<search criteria> Fields that directly reflect the attributes in the
Data properties tab of the Modeler for the
specified Data definition.

Search button Opens the Data Instance List. For details, see
“Data Instance List” on page 248.

If search criteria was entered, the list shows only
the Data instances that match the search criteria.

If the search criteria is left blank, the list shows
all Data instances for the selected Data
definition.

For instructions on setting the search criteria, see
“Search for Specific Instances” on page 234.

Clear Form Clears all search criteria.

Data Instance List
The Data Instance List shows in tabular form, all the Data instances that
matched the search criteria, and the attributes for each instance.

The following table describes the user interface elements of the Data
Definition List (unlabeled UI elements are shown in angle brackets).

Ul Elements Description

Edit Displays the Data Instance Search window with
the selected instance’s criteria filled in.

Delete Removes one or more selected Data instances
from the BPI Instance database.
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Ul Elements

Description

Select All

Selects all the Data instances in the list.

Unselect All

Unselects all the selected Data instances.

@ Synchronize with the RTSM

The Synchronize with the RTSM page enables you to invoke a manual
synchronization between BPI CIs and the RTSM.

To access

Admin > Business Process Insight > Process Intervention
Tab > Synchronize with the RTSM

Important
information

For details on synchronizing the BPI CIs with the RTSM,
see “Why Use the Process Intervention Client” on
page 229.

Relevant tasks

“How to Use the Process Intervention Client” on
page 232
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Notification

This chapter includes:

Concepts

> Notification Server Overview on page 252

Tasks

» How to Perform Notification Server Administration Tasks on page 256
Reference

» Methods for All Violations on page 275

» Methods Specific to Process Impact Violations on page 276

» Methods Specific to Out-of-Sequence Violations on page 278

» Methods Specific to Monitor and Instance Threshold Violations
on page 279

» Environment Variables for Scripts on page 283

251



Chapter 7 » Notification

Concepts

& Notification Server Overview

252

This section describes the BPI Notification Server pages and how to use them
to configure the Notification Server to process subscriptions for notifications
such as process impact and monitor instance threshold violations.

Note: You cannot open or use the Notification pages, unless you have
installed the BPI Server. The Notification options appear when the BPI Server
is installed and the connectivity between the BPI Server and the BSM
Gateway Server has been configured. This configuration is described in the
"Component Configuration - HP Business Service Management Settings"
section of the Business Process Insight Server Administration Guide.

The chapter also describes how to configure the Notification Server email
templates and scripts, which can then be used to deliver notifications that
are received by the Notification Server.

The Notification Server is the BPI component responsible for sending email
notifications and HP Operations Manager messages for events. These
messages provide details of the process impact, monitor instance threshold
and out-of-sequence events. You can receive these notifications through
your email client or through an HP BTO Software client according to your
requirements.

You also have the option to execute a script when an impact event is
received; for example, the script might update a file, or send an SMS
message.
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The Notification component can be considered to be in two parts:

» Server, which is responsible for receiving the impact events from the
Business Impact Engine and converting them into the appropriate email
messages and HP Operations Manager Messages for delivery. For more
details, see “Notification Server Component” on page 253.

> Notification Server administration console, which enables you to create
subscriptions for users to receive email notifications. It also enables you to
create subscriptions for HP Operations Manager messages and scripts. For
more details, see “How to Perform Notification Server Administration
Tasks” on page 256.

Notification Server Component

The Notification Server is a component of the BPI Server and is responsible
for notifying you of the process-impact, out-of-sequence and
monitor-threshold violations that you have configured through the
Notification option for the Business Process Insight Application. The tasks
for using the Notification options are described in “How to Perform
Notification Server Administration Tasks” on page 256.

Notifications can be sent either through an SMTP server to an email client,
or as an HPOM message to an HPOM Server. There is a retry mechanism for
both types of notifications if either the SMTP server or HP Operations
Manager is not available for any reason. Notifications are queued and retried
after a configurable interval.
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The following diagram shows the architecture of the Notification Server and
its relationship to other BPI Server components.
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Business violations are created by the Notification Server as a result of
receiving:

» Process-impact and out-of-sequence notification events from the business
object manager through the Business Event Handler Transmitter.

» Monitor instance threshold violation notification events from the
Monitor Engine.
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The Notification Server sends these events as business violations to you,
based on a set of filters. These are filters that you create and that specify the
impact events for which you want notification. You can filter email
notifications based on event name, event type and the name of the Business
Process.

In addition to sending violations when an event is received, the Notification
Server can also run any script (.bat file) that you have created. Creating
scripts is described in section “Creating Script Files” on page 272.

Email Notification Messages

The email notifications contain impact information about:

» Business Processes that you are monitoring.
» Out-of-sequence events.

Out-of-sequence events are those events that you have chosen to monitor
using the Check sequence option, which is an option on the BPI Modeler.

» Monitor instance threshold violations.

There is a default template for these email notifications; however, you can
change the layout of the email messages that are sent by the Notification
Server. You can also configure the templates for the email notifications and
add properties from the business violations into the messages and configure
how many email notifications that you receive for a particular monitor
instance threshold violation.

The default templates are provided as part of the BPI installation and
instructions for creating your own templates and configuring monitor
thresholds are provided in Chapter 4, “Monitor Definer.”

The following are the template types that you can use to change the format
of your messages, if required:

» Velocity, which is a Java-based template Engine.
» XSLT, which transforms one XML document into another text document.

It does not matter which tool you use, it is entirely dependent on your own
preferences.
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Tasks

® How to Perform Notification Server Administration

Tasks

256

The following are the tasks that you can complete when using the
Notification option:

> “Managing Email Subscriptions” on page 256
“Managing HP Operations Manager Message Subscriptions” on page 260

>
> “Managing Script Subscription” on page 263

» “Creating Notification Server Templates” on page 265
>

“Creating Script Files” on page 272

Managing Email Subscriptions

This section includes creating subscriber accounts to:

> Receive specific process impact events that are generated by the BPI
Server.

» Receive specific monitor instance threshold events that are generated by
the BPI Server.

» Receive specific out-of-sequence events that are generated by the BPI
Server.

To configure the Notification Server:

1 Make sure the Servlet Engine component is started using the BPI Server
Administration Console, which is located on the system where the BPI
Server is running.

2 On the system where Business Service Management is running, select
Admin > Business Process Insight.

A tabbed page displays, which includes a tab for Notification.
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3 Click the tab for Notification and you are presented with a page
requesting you to select from Email Subscriptions, Script Subscriptions or
HPOM Message Subscriptions.

4 Select Email Subscriptions.

5 Click the New User button to add a new user.
The User Information screen displays.

6 On the User Information screen:
a Enter a User Name.

This is a name that you want to assign to the user; it can be any name
that identifies the user subscription.

b Enter an Email Address.

This is the email address for the user named in the previous step. This
must be a valid email account.

¢ Click OK.

The new user now has an account on the Notification Server and is
listed in the User List with the other users.

You now have the option to:

» Add another new user as described in the above steps.

» Subscribe the new user account to the events that you want it to receive.
To do this refer to section “Configuring the Events Received by
Notification Server Users” on page 258.

» Return to the main menu, where you can add more email subscriptions or
add HP Operations Manager message subscriptions.

» Delete an entry in the User List. To do this select the checkbox next to the
User Name entry that you want to delete and then click the Delete button.

257



Chapter 7 » Notification

258

Configuring the Events Received by Notification Server Users

When you have added the user accounts for the users to receive
notifications, you then need to configure these user accounts to subscribe to
BPI events that you want them to receive. To do this, select the
Subscriptions link on the Users List screen, under the Email Subscriptions
column, for the user that you want to configure. This link takes you to the
Process Subscriptions list for that user.

1 Click the New Subscription button.

You are taken to the EMail Subscription Details screen where you can add
the email subscription details.

2 Select the Event Name and the Process Name for your new event
subscription:

» Event Name:

You can select from: Process Impacted events, Process Monitor
Threshold Violation Events, Process Out Of Sequence events, or All
events. If you select All you subscribe to all types of event.

» Process Name:

You can select all process names to report on, or you can choose a
specific process that is deployed to the Business Impact Engine. There
is a drop down list provided, which lists all the deployed processes for
you to select from, including the All option.

Click Next.

3 If you selected Process Monitor Threshold Violation Events, continue at
step S.

4 If you selected All, Process Impacted or Process Out Of Sequence as the
Event name, you are prompted to select the Minimum Severity Level and
the Template for your new subscription:

» Minimum Severity Level:

This is the minimum severity level for which you want to receive email
notifications; for example, if you select Critical you will receive email
notifications only for violations that are critical. If you select Minor,
you receive email notifications for Minor, Warning, Major and Critical
violations.
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> Template:

Select the template that is appropriate to your Event Name, for
example, you might have created your own template for the event.

» If you have selected Process Impacted as the Event Name, choose
the EMAIL-ProcessimpactedDefault.vm template.

» If you have selected Process Monitor Threshold as the Event Name,
choose the EMAIL-MonitorThresholdDefault.vm template.

» If you have selected Process Out of Sequence, choose the
EMAIL-OutOfSequenceDefault.vm template.

» If you have selected All for the Event Name, choose the
EMAIL-GenericDefault.vm template, as it provides the most detailed
information.

Note: If you create two subscriptions for the same event type, each with
different templates, BPI uses the template from the more restrictive
subscription to format the violation. For example, if you create a
subscription for all process impact events using one template and a
subscription for a specific process impact event using a different template;
the template for the specific process impact event is the one used to
format the violation.

If you selected Process Monitor Threshold Violation Events, you are
prompted for the following information, in addition to that requested in
step 4:

» Monitor Name
» Monitor Threshold Name
Click OK to commit the subscription to the administration database.

The new Event Subscription is now added to the list of Process
Subscriptions for the user.
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You now have the option to:

» Add another subscription as described above.

» Delete an entry in the subscription list. To do this select the checkbox
next to the entry that you want to delete and then click the Delete
button.

» Logout of the Notification Server Administration Console. You do this by
closing the Web Browser Window where the console is running.

Managing HP Operations Manager Message Subscriptions

The Notification Server uses Velocity and XSLT templates to create HP
Operations Manager messages before forwarding the message to the HP
Operations Manager agent.

The HP Operations Manager agent then applies one or more templates to
filter out unwanted messages and to make any additional changes to the HP
Operations Manager message format.

Before configuring BPI to send events to HP Operations Manager, ensure
that the HP Operations Manager Agent and Message Interface template are
installed and set up on the system where the BPI Server, including the
Notification Server are installed.

Complete the following steps to configure the Notification Server to send
HP Operations Manager message notifications to the HP Operations
Manager Agent for process impact, out-of-sequence or monitor instance
threshold notification events:

1 Make sure the Servlet Engine component is started using the BPI Server
Administration Console, which is located on the system where the BPI
Server is running.

2 On the system where Business Service Management is running, select
Admin > Business Process Insight.

A tabbed page displays, which includes a tab for Notification.

3 Click the tab for Notification and you are presented with a page
requesting you to select from Email Subscriptions, Script Subscriptions or
HPOM Message Subscriptions.
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4 Select HPOM Message Subscriptions.
5 Click the New Subscription button.

You are presented with an HPOM Subscription Details screen where you
can enter the subscription details for the HP Operations Manager
messages.

6 From the New Event Subscription screen, select the Event Name and the
Process Name for your new event subscription:

» Event Name

You can select to filter for Process Impacted events, Process Monitor
Threshold events, Process Out Of Sequence events, or All events. If you
select All, you receive HP Operations Manager impact violations for all
BPI notification events.

» Process Name

You can select all process names to report on, or you can choose a
specific process that you have defined. There is a drop down list
provided, which lists all the deployed processes for you to select from,
including the All option.

7 Click Next.

8 If you selected Process Monitor Threshold Violation Events, continue at
step 10.

9 If you selected All, Process Impacted or Process Out Of Sequence as the
Event name, you are prompted to select the Minimum Severity Level and
the Template for your new subscription:

» Minimum Severity Level:

This is the minimum severity level for which you want to receive email
notifications; for example, if you select Critical you will receive email
notifications only for violations that are critical. If you select Minor,
you receive email notifications for Minor, Warning, Major and Critical
violations.
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10

11

» Template:

Select the template that is appropriate to your Event Name, for
example you might have created a custom template:

» If you have selected Process Impacted as the Event Name, choose
the OVO-ProcessimpactDefault.vm template.

» If you have selected Process Monitor Threshold as the Event Name,
choose the OVO-MonitorThresholdDefault.vm template.

» If you have selected Process Out of Sequence, choose the template
for the OVO-OutOfSequence.vm for the template.

» If you have selected All for the Event Name, choose the
OVO-GenericDefault.vm template, as it provides the most detailed
information.

Note: If you create two subscriptions for the same HP Operations
Manager message subscription, each with different templates, BPI uses the
template from the more restrictive subscription to format the violation.
For example, if you create a subscription for all process impact events
using one template and a subscription for a specific process impact event
using a different template; the template for the specific process impact
event is the one used to format the violation.

If you selected Process Monitor Threshold Violation Events, you are
prompted for the following information, in addition to that requested in
step 9:

» Monitor Name
» Monitor Threshold Name

Click OK to commit the subscription to the Notification Server
Administration database.

The new HP Operations Manager Message Subscription is now added to
the list of HP Operations Manager Subscriptions.
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You now have the option to:

» Add another HP Operations Manager Message Subscription as described
above.

» Delete an entry in the HP Operations Manager Message Subscription list.
To do this select the checkbox next the entry that you want to delete and
then click the Delete button.

You can configure the template set used by HP Operations Manager and you
can filter the events received through HP Operations Manager by
customizing the HP Operations Manager Message Interface template. Details
of how to do this are provided in the HP Operations Manager
documentation.

Managing Script Subscription

You can configure the Notification Server to run a script when it receives
specific notification events. Section “Creating Script Files” on page 272
describes how you can create these scripts and provides details of the
variables that you can include in your scripts to report details of the
violation as required.

This section describes how to configure the Notification Server to run the
scripts for specific notifications that it processes for process impact,
out-of-sequence or monitor instance threshold notification events:

1 Make sure the Servlet Engine component is started using the BPI Server
Administration Console, which is located on the system where the BPI
Server is running.

2 On the system where Business Service Management is running, select
Admin > Business Process Insight.

A tabbed page displays, which includes a tab for Notification.

3 Click the tab for Notification and you are presented with a page requesting
you to select from Email Subscriptions, Script Subscriptions or HPOM
Message Subscriptions.

4 Select Script Subscriptions.
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5 Click the New Subscription button.

You are presented with a New Subscription screen where you can enter the
subscription details for the script.

From the New Script Subscription screen, enter the following details:
» Event Name

You can select to filter for Process Impacted events, Process Monitor
Threshold events, Process Out Of Sequence events, or All events. If you
select All, you receive HP Operations Manager impact violations for all
BPI notification events.

» Process Name

You can select all process names to report on, or you can choose a
specific process that you have defined. There is a drop down list
provided, which lists all the deployed processes for you to select from,
including the All option.

Click Next.

If there are no scripts defined, the following error is displayed and you
cannot continue:

No scripts currently available for selection.
See “Creating Script Files” on page 272 for details of creating scripts.

If you selected Process Monitor Threshold Violation Events, continue at
step 10.

If you selected All, Process Impacted or Process Out Of Sequence as the
Event name, you are prompted to select the Minimum Severity Level and
the Template for your new subscription:

» Minimum Severity Level:

This is the minimum severity level for which you want to receive email
notifications; for example, if you select Critical you will receive email
notifications only for violations that are critical. If you select Minor,
you receive email notifications for Minor, Warning, Major and Critical
violations.
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» Script Name:

Select the script that you want the Notification Server to run when it
received a notification event for the specified event and process. All
the scripts that you have defined and saved in the notify-scripts are
presented in the drop-down list for you to select from.

10 If you selected Process Monitor Threshold Violation Events, you are
prompted for the following information, in addition to that requested in
step 9:

» Monitor Name
» Monitor Threshold Name
11 Click OK to commit the subscription to the administration database.

The new Script Subscription is added to the list of Script Message
Subscriptions.

You now have the option to:

» Add another New Script Subscription as described above.

» Delete an entry in the Script Subscription list. To do this select the
checkbox next the entry that you want to delete and then click the Delete
button.

Creating Notification Server Templates

The Notification Server uses templates to format email messages and
messages sent to HP Operations Manager. The templates contain
instructions on how to format event information, for example, event name
and event time. You might want customize an email template if you want to
generate email messages for different locales.

This section describes how BPI uses these templates and some guidance in
how you can modify them. You need to be familiar with either XSLT, or
Velocity to make the changes; XSLT is a standard for transforming XML
documents. It is up to you which format you choose.
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The Notification Server uses the Apache Velocity template engine to process
Velocity templates. There is a user guide available with the template engine
that provides details of creating and using Velocity templates. Details of
Velocity templates, including a user guide for creating them, can be found at
the following location:

http://velocity.apache.org/

You configure the template used for each event when you create the event
subscription through the Notification pages. The Notification Server then
uses the template that you have defined to format all notifications related to
the specified event.

Creating an Email Template

You create a custom email template for a specific event. These custom email
templates must have a file name that starts with the string EMAIL- and a file
extension of .vm for Velocity templates and .xsl for XSLT templates.

The Notification Server reads the custom templates from the following
directory:

bpi-install-dir\data\conf\bia\notify-templates\flows

If you want to modify these templates, make a copy of the appropriate
example template from the files in the following directory:

bpi-install-dir\examples\bia\NotifSvrTemplates

Make sure that you add your template to the correct directory as the
Notification pages presents the templates in the context of the selection,
based on the contents of the above directories.

You also need to make sure that you copy the template from the examples
directory to the data directory as the examples directory is updated and files
replaced if you reinstall BPI.

The Notification Server uses an email template to create XML that describes
an email. Then the notification server uses the XML to create an email.



Chapter 7 » Notification

The email XML is very simple; it contains a subject, content type, and body.
The actual schema is described in the file email.xsd, which is located at:

bpi-install-dir\misc\bia

The Notification Server applies the Velocity or XSLT templates that you
define to a violation from the Business Impact Engine. From this the
Notification Server can create an email XML document based on your
templates.

Creating an HP Operations Manager Template

The Notification Server uses a template to create XML that describes the HP
Operations Manager message. It then uses this XML to create an HP
Operations Manager message.

You configure the templates that are used to send HP Operations Manager
messages through the Notification pages.

Custom HP Operations Manager template files must start with the string
OVO- and a file extension of .vm for Velocity templates and .xsl for XSLT
templates. Store custom templates in the following directory:

bpi-install-dir\data\conf\bia\notify-templates\flows

The following is an example of an HP Operations Manager message XML
document:

<?xml version="1.0" encoding="UTF-8"7>

<0OVOMessage xmins:xsi="http://www.w3.0rg/2001/XMLSchema
instance"xsi:noNamespaceSchemalocation="ovomessage.xsd" >

<Severity>critical</Severity>

<Application>HPBPI application</Application>

<Object>PROCESS_IMPACTED or PROCESS_OUT_OF_SEQUENCE</

Object>

<MessageGroup>NOTIFICATIONS</MessageGroup>

<MessageText>A PROCESS_OUT_OF_SEQUENCE violation occurred at

7.10pm.</MessageText>

<Option>example_option_variable_1=this is an example option value</Option>

<Option>example_option_variable 2=this is another example option value</

Option>

</OVOMessage>
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The example XML document contains an element for each message
attribute:

» Message severity
> Application

» Obiject

» Message group
> Message text

Optionally, the XML document, can contain message options. An option
has the form variable=value. The notification server applies Velocity and
XSLT templates to an violation from the Business Impact Engine to create an
HP Operations Manager message XML document.

The schema for the message is available at the following location:

bpi-install-dir\misc\bia\ovomessage.xsd

Creating a Velocity Template

This section describes the list of the BPI notification methods that have been
defined for use within your Velocity template. A variable in the Velocity
context contains information from an Business Impact Engine event.

A Velocity template is a file that contains the XML describing an email or
HP Operations Manager message.

In addition to text, the file can contain Velocity formatting directives. The
following is an example of an email Velocity template:

<?xml version="1.0" encoding="UTF-8"?>

<Email xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance'
xsi:noNamespaceSchemalocation='email.xsd">

<Subject>

$alert.getSeverity() $alert.getEventName() Alert

</Subject>

<ContentType>text/plain</ContentType>

<Body>

A "$alert.getEventName()" alert has occurred.

Severity: $alert.getSeverity()
Event Group: $alert.getEventGroup()
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Event Name: $alert.getEventName()
Event Time: $alert.getEventTime()
Process Name: $alert.getFlowName()
Frocess Guid: $alert.getFlowGuid()
</Body>

</Email

A formatting directive starts with a hash (#) or a dollar ($); these formatting
directives are described more fully in the Velocity Users” Guide. A formatting
directive is used to insert event information into the XML document. In the
case of BPI this event information is provided through the alert variables.

The $alert variable contains information from a Business Impact Engine
event, for example, the service name for the event. The $alert variable
contains methods such as getFlowName() and getServiceName(), which can
be used to insert the event flow name and the event service name into the
XML. (getServiceName() inserts the service name).

Note: If the Velocity templates that you create contain non-ASCII
characters, you must encode and save the template as UTF8. This UTF8
needs to be created without a byte order mark (BOM). BOMs are added
automatically by some Windows editors; for example, Notepad and
Wordpad. Choose an editor that enables you to exclude the BOM.

If you include a BOM in your template encoding, it is not recognized as an
XML file.

When the Notification Server generates an email notification message, it
adds data to the message, where the display language is determined by the
locale of the BPI Server. If your email recipients are not in the same locale as
the BPI Server, you can use the Velocity templates to specify the locale for
the language used for the email notifications. This enables you to provide
email notifications in several languages if required.

The java Locale() class is used to identify the language string used within the
alert methods. The definition for the Locale() class can be found at the
following URL:

http://java.sun.com/j2se/1.4.2/docs/api/java/util/Locale.html
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The Locale() class takes a parameter comprising the language code and the
country code as described in the definition for the Locale() class; for
example: ko_KR for Korea and en_CA English-speaking Canadian.

For details on the methods, see “Methods for All Violations” on page 275,
“Methods Specific to Process Impact Violations” on page 276, “Methods
Specific to Out-of-Sequence Violations” on page 278, or “Methods Specific
to Out-of-Sequence Violations” on page 278.

XSLT Templates

An XSLT template is a file containing XML that transforms event XML into
email or HP Operations Manager message XML. An example of an email
XSLT template is shown below.

<?xml version="1.0" encoding="UTF-8"?>

<xsl:stylesheet xmiIns:xsl="http://www.w3.0rg/1999/XSL/Transform"

version="1.0"
xmins:env="http://schemas.xmlsoap.org/soap/envelope/"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:etype="http://www.hp.com/openview/bia/eventtype"
xmins:edata="http://www.hp.com/openview/bia/eventdata">

<xsl:output method="xml"

indent="no" />

<xsl:template match="/">

<Email xsi:noNamespaceSchemalocation='email.xsd">

<Subject>

<xsl:apply-templates select="//env:Body/*/etype:Severity/*"/><xsl:text> </
xsl:text><xsl:value-of select="//etype:EventName" /> Alert</Subject>
<ContentType>text/plain</ContentType>

<Body>

A "<xsl:value-of select="//etype:EventName" />" alert has occurred.

Severity: <xsl:apply-templates select="//env:Body/*/etype:Severity/*"/>
Event Group: <xsl:value-of select="//etype:EventGroup" />

Event Name: <xsl:value-of select="//etype:EventName" />

Event Time: <xsl:value-of select="//etype:EventTime" /><xsl:text>
</xsl:text>

<xsl:for-each select="//edata:Dataltem" >

<xsl:choose>

<xsl:when test="edata:Name = 'RootCause™ >

<xsl:text>Root Cause: </xsl:text>

<xsl:for-each select="//edata:Value/Services/Service" >
<xsl:text>-&gt;</xsl:text><xsl:value-of select="Label" />
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</xsl:for-each>
</xsl:when>
<xsl:otherwise>
<xsl:value-of select="edata:Name" /><xsl:text>: </xsl:text><xsl:value-of
select="edata:Value" />
</xsl:otherwise>
</xsl:choose>
<xsl:text>

</xsl:text>
</xsl:for-each>
</Body>

</Email>
</xsl:template>

<xsl:template match="etype:Critical" >
<xsl:text>Critical</xsl:text>
</xsl:template>

<xsl:template match="etype:Major" >
<xsl:text>Major</xsl:text>
</xsl:template>

<xsl:template match="etype:Minor" >
<xsl:text>Minor</xsl:text>
</xsl:template>

<xsl:template match="etype:Warning" >
<xsl:text>Warning</xsl:text>
</xsl:template>

<xsl:template match="etype:Normal" >
<xsl:text>Normal</xsl:text>
</xsl:template>

</xsl:stylesheet>

The style sheet is applied to the event sent by the Business Impact Engine.
The style sheet contains email XML text as well as XSL elements. XSL
elements format information from the form of the event and insert it into
the email XML.
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The schemas for the event are located in the files eventtype.xsd and
eventdata.xsd in the following directory:

bpi-install-dir/misc/bia

The message header contains a business event type, which is described in
eventtype.xsd. The message body contains a business event type followed by
business event data; Business event data is described in eventdata.xsd.

Creating Script Files

You can define a script, which is a Windows .bat file, to be run when a
notification event is received by the Notification Server; for example, this
script might send an SMS message to a recipient directly (bypassing the
email server), or it might update an entry in a database or spreadsheet.

You can create a script to complete any action that you want, and you can
also include any of the environment variables that have been defined for
use within your scripts. These environment variables identify configuration
information relating to the BPI data available for notifications and are
defined in section “Environment Variables for Scripts” on page 283.

These environment variables are included in your scripts using the
following notation:

%env_name%

where % env._name% is an environment variable name, for example,
%0OVBPI_FLOWNAME%.

For details on the environment variables, see “Environment Variables for
Scripts” on page 283.

The following examples show how you can create a script and configure the
Notification Server to run the script when a specific notification event is
received.
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Example Script to Write a String to a File

The following is an example of the steps that you need to complete to
configure the Notification Server to write the string Hello World to a file on
receipt of a specific process impact event:

1 Create the script that you want to be executed when the notification
event is received, for example:

echo "hello world" >>c:\notif.txt

This script writes the string "hello world" to the file notif.txt in the root of
your c: drive.

2 Save the script to the following location with a unique file name and a
.bat file extension:

bpi-install-dir/data/conf/bia/notify-scripts

The Notification Server looks in this directory for scripts and presents
these scripts to you through the Web Administration Console for the
Notification Server when you are configuring subscriptions. Note that if
the script that you create does not have a .bat file extension, it is ignored.

3 Follow the instructions in “Managing Script Subscription” on page 263 to
create a subscription for the script selecting Process Impacted as the Event
Name and the name of the process for the Process Name.

If you have the Web Administration for the Notification Server
administration open at the New Event Subscription page, you might need
to click the Refresh option on your Web Browser. This refreshes the page
and adds the new script to the list.
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Example Script to Write Process Name and Blocked Instances to
a File

The following is an example of the steps that you need to complete to
configure the Notification Server to take the process name and the number
of blocked instances from the event data and write the information to a file
on receipt of a specific process impact event:

1

Create the script that you want to be executed when the notification
event is received, for example:

echo %OVBPI_FLOWNAME%,
%OVBPI_NOOFBLOCKEDINSTANCES%>>c:\notif2.txt

This script writes the values of the process name and the number of
blocked instances to the file notif2.txt in the root of your c: drive.

Save the script to the following location with a unique file name:
bpi-install-dir/data/conf/bia/notify-scripts

The Notification Server looks in this directory for scripts and presents
these scripts to your through the Web Administration Console for the
Notification Server when you are configuring subscriptions.

Follow the instructions in section “Managing Script Subscription” on
page 263 to create a subscription for the script selecting Process Impacted
as the Event Name and the name of the process for the Process Name.

If you have the Web Administration for the Notification Server
administration open at the New Event Subscription page, you might need
to click the Refresh option on your Web Browser. This refreshes the page
and adds the new script to the list.
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® Methods for All Violations

The following table lists the alert methods that can be used for all violations:
Process Impact, Process Out-Of-Sequence, Business Monitor and Monitor

instance threshold.

Alert Method Names

Alert Method Description

$alert.getVersion()

Returns a STRING containing the version
number for the BPI event.

$alert.getSeverity(Zocale)

Returns a STRING containing the severity of the
BPI event. Possible values are Critical, Major,
Minor, Warning, and Normal. The language
used for these values is determined by the locale
for the BPI Server or, if specified, the locale of
the country and language specified in locale, for
example:

» $alert.getSeverity("ja"), for a Japanese locale
» $alert.getSeverity("ko"), for a Korean locale

The value returned is also used to determine the
color of the text in the email notification.

$alert.getEventGroup()

Returns a STRING containing the name of the
event group for the BPI event, that is,
NOTIFICATIONS.

$alert.getEventName()

Returns a STRING containing the name of the
BPI event, that is, PROCESS_IMPACTED,
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N or PROCESS_OUT_OF_SEQUENCE

$alert.getEventTime(locale)

Returns a STRING containing the time of the
BPI event, formatted using the locale for the BPI
Server or, if specified, the locale of the country
and language specified in locale.
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Alert Method Names

Alert Method Description

$alert.getEventDataListSize()

Returns the number of event data items in the
BPI event.

$alert.getEventDataNames()

Returns an ARRAYLIST of the names of the
event data items in the BPI event.

$alert.getEventDataByName

(Stringname, locale)

Returns a STRING containing the value of the
data item with the given name using the locale
for the BPI Server or, if specified, the locale of
the country and language specified in Zocale.

$alert.getEventDataByIndex

(index, locale)

Returns a STRING containing the value of the
data item located at the supplied index using
the locale for the BPI Server or, if specified, the
locale of the country and language specified in
locale.

® Methods Specific to Process Impact Violations

The following table lists the alert methods that can be used for Process
Impact violations. Using any of these methods for other violations results
in a message containing erroneous data.

Alert Method Name

Alert Method Description

$alert.getFlowName()

Returns a STRING containing the
process name for the BPI event.

$alert.getFlowGuid()

Returns a STRING containing GUID for
the process definition in the BPI event.

$alert.getServiceName()

Returns a STRING containing the name
of the service for the BPI event.

$alert.getServiceGuid()

Returns a STRING containing the
service GUID for the BPI event.
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Alert Method Name

Alert Method Description

$alert.getFlowNodeString()

Returns a STRING containing Activity
names for the BPI event. An example of
a string returned by this method is: Bill
Customer, Check Stock, Remove Item.

$alert.getFlowNodeList()

Returns an ARRAYLIST of Activity
names in the BPI event. You can use the
methods defined in the ArrayList class.
For example, you can access the first
element of an array list named
flowNodeList using
$flowNodeList.get(0).

$alert.getFlowNodeListSize()

Returns the number of elements in the
process Activity list in the BPI event.

$alert.getRootCause()

Returns a STRING containing the labels
of the root cause services in the BPI
event. (Note that this string cannot be
localized.) An example of a string
returned by this method is: Oracle
Financial System-&gt;Oracle System
Europe-&gt;Network Resources.

$alert.getFlowNodeStatusList()

Returns an ARRAYLIST of the status of
the Activities in the BPI event. You can
use the methods defined in the
ArrayList class. For example, you can
access the first element of an array list
namesFlowNodeStatusList using
$flowNodeStatusList.get(0).
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Alert Method Name Alert Method Description

$alert.getFlowNodeStatusString(locale) | Returns a STRING containing the labels
for the Activity status in the BPI event.
For example, Critical, Major, Minor,
Warning and Normal. These status
correspond to the HP Operations
Manager severity levels.

The language used for these values is
determined by the locale for the BPI
Server or, if specified, the locale of the
country and language specified in
locale, for example:

» $alert.getFlowNodeStatusString("ja"),
for a Japanese locale

» $alert.getFlowNodeStatusString("ko"),
for a Korean locale

$alert.getFlowNodeStatusListSize() Returns the number of elements in the
process Activity status list in the BPI
event.

@ Methods Specific to Out-of-Sequence Violations

The following table lists the methods for out-of-sequence events only. Using
any of these methods for other violations results in a message containing
erroneous data.

Alert Method Name Alert Method Description

$alert.getFlowName() Returns a STRING containing the process
name for the BPI event.

$alert.getFlowGuid() Returns a STRING containing GUID for the
process definition in the BPI event.

$alert.getFlowInstanceGuid() Returns a STRING containing GUID for the
process instance in the BPI event.
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Alert Method Name Alert Method Description

$alert.getSourceNode() Returns a STRING containing the name of the
Activity that is the source Activity for the
out-of sequence violation.

$alert.getDestinationNode() Returns a STRING containing the name of the
Activity that is the destination Activity for the
out-of sequence violation.

$alert.getFlowldentifier() Returns a STRING containing the identifier for
the impacted process instance.

® Methods Specific to Monitor and Instance Threshold
Violations
The following table lists the monitor and instance threshold violation

notification events only. Using any of these methods for other violations
results in a message containing erroneous data.

Alert Method Name Alert Method Description

$alert.getThresholdAlertGuid() | Returns a STRING containing the internal
unique identifier (GUID) of the instance
threshold violation event raised for a specific
instance threshold violation.

The following methods are duration periods that correspond to the Threshold
violation notification polling interval (seconds) as set in the BPI Server
Administration Console for Monitor Engine threshold violation notification
settings.

It is called the actual period because it can differ from the requested configuration
interval according to the other priorities that the machine, and the JVM, have at
the times the requests to start and stop tracking are made.

getThresholdAlertNotification Returns a STRING containing the duration of
PeriodDurationHours() actual notification period in terms of hours.

279



Chapter 7 » Notification

280

Alert Method Name

Alert Method Description

getThresholdAlertNotification
PeriodDurationHours(locale)

Returns a STRING containing the duration of
actual notification period in terms of hours,
using the locale for the BPI Server or, if
specified, the locale of the country and
language specified in Jocale.

getThresholdAlertNotification
PeriodDurationMinutes()

Returns a STRING containing the duration of
actual notification period in terms of minutes.

getThresholdAlertNotification
PeriodDurationMinutes(locale)

Returns a STRING containing the duration of
actual notification period in terms of minutes,
using the locale for the BPI Server or, if
specified, the locale of the country and
language specified in Zocale.

getThresholdAlertNotification
PeriodDurationSeconds()

Returns a STRING containing the duration of
actual notification period in terms of seconds.

getThresholdAlertNotification
PeriodDurationSeconds(locale)

Returns a STRING containing the duration of
actual notification period in terms of seconds,
using the locale for the BPI Server or, if
specified, the locale of the country and
language specified in Zocale.

$alert.getThresholdAlert
NotificationPeriodStart()

Returns a STRING containing the start time of
the Threshold violation notification period.
Start time is the time from and including the
time specified.

$alert.getThresholdAlert
NotificationPeriodEnd()

Returns a STRING containing the end time of
the Threshold violation notification period.
End time is the time up to but not including
the time specified.

$alert.getThresholdAlertStatus
ChangeTime()

Returns a STRING containing the time that the
Metric_Fact_Alerts table was updated with the
instance threshold alert notification.

$alert.getThresholdAlertRaised
Time()

Returns a STRING containing the time that the
event notification was sent to the Notification
Server.
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Alert Method Name

Alert Method Description

$alert.getThresholdGuid()

Returns a STRING containing the internal
unique identifier (GUID) for the monitor
instance threshold defined for the Business
Process Monitor in the BPI event.

$alert.getThresholdMessage()

Returns a STRING containing the monitor
instance threshold message in the BPI event.

This is the message that you have defined to be
displayed when the event is triggered.

$alert.getThresholdName()

Returns a STRING containing monitor instance
threshold name in the BPI event.

$alert.getThresholdNumber
NotificationsInPeriod()

Returns a STRING containing the total number
of notifications sent for the instance threshold
in the Threshold violation notification polling
interval.

$alert.getThresholdNumber
AlertsInPeriod()

Returns a STRING containing the total number
of instance threshold violations generated for
the instance threshold in the Threshold
violation notification polling interval.

The number of instance threshold violations
generated might be different to the number of
notifications sent, depending on how you
have configured the instance threshold
violation notification settings.

$alert.getThresholdNumber
NormalAlertsInPeriod()

Returns a STRING containing the total number
of Normal instance threshold violations
generated for the instance threshold in the
Threshold violation notification polling
interval.

This number is a subset of
getThresholdNumberAlertsInPeriod().
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Alert Method Name

Alert Method Description

$alert.getThresholdNumber
WarningAlertsInPeriod()

Returns a STRING containing the total number
of Warning instance threshold violations
generated for the instance threshold in the
Threshold violation notification polling
interval.

This number is a subset of
getThresholdNumberAlertsInPeriod().

$alert.getThresholdNumber
MinorAlertsInPeriod()

Returns a STRING containing the total number
of Minor instance threshold violations
generated for the instance threshold in the
Threshold violation notification polling
interval.

This number is a subset of
getThresholdNumberAlertsInPeriod().

$alert.getThresholdNumber
MajorAlertsInPeriod()

Returns a STRING containing the total number
of Major instance threshold violations
generated for the instance threshold in the
Threshold violation notification polling
interval.

This number is a subset of
getThresholdNumberAlertsInPeriod().

$alert.getThresholdNumber
CriticalAlertsInPeriod()

Returns a STRING containing the total number
of Critical instance threshold violations
generated for the instance threshold in the
Threshold violation notification polling
interval.

This number is a subset of
getThresholdNumberAlertsInPeriod().

$alert.getFlowMetricGuid()

Returns a STRING containing the Business
Process Monitor GUID in the BPI event.

$alert.getFlowMetricName()

Returns a STRING containing the Business
Process Monitor name in the BPI event.

$alert.getFlowMetricValue()

Returns a STRING containing the Business
Process Monitor value in the BPI event.
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@ Environment Variables for Scripts

The following tables list the environment variables that can be used within
your scripts to report data on process impact, process out-of-sequence and
monitor instance threshold violations.

The following table lists the environment variables that are available for all

BPI violations.

Variable

Description

OVBPI_EVENTGROUP

Name of the event group, which is always
NOTIFICATIONS.

OVBPI_EVENTNAME

Name of the event:
PROCESS_IMPACTED,
PROCESS_MONITOR_THRESHOLD_VIOL
ATION or
PROCESS_OUT_OF_SEQUENCE.

OVBPI_SEVERITY

Severity of the BPI event. Possible values
are Normal, Warning, Minor, Major or
Critical

The following table lists the environment variables available for process
impact violations. Using these environment variables for other alerts results

in erroneous data being returned.

Variable

Description

OVBPI_FLOWGUID

Internal unique identifier (GUID) for the
process definition in the BPI event.

OVBPI_FLOWNAME

Name of the process in the BPI event

OVBPI_NOOFBLOCKEDINSTANCES

Number of blocked process instances at
the time of the PROCESS_IMPACTED
event. A blocked instance is an instance
of the process that is active at an
Activity and cannot proceed as there is a
problem in an underlying operational
service.

283




Chapter 7 » Notification

284

Variable

Description

OVBPI_NOOFIMPEDEDINSTANCES

Number of at risk process instances at
the time of the PROCESS_IMPACTED
event. An at risk instance is where one
or more process instance has the
potential to be blocked in the future.

OVBPI_SERVICEGUID

Internal unique identifier (GUID) for the
service in the BPI PROCESS_IMPACTED
event.

OVBPI_SERVICENAME

Name for the service in the BPI
PROCESS_IMPACTED event.

OVBPI_ROOTCAUSE

Label of the root cause service, or
services, in the BPI
PROCESS_IMPACTED event.

The following table lists the environment variables available for instance
threshold violations. Using these environment variables for other violations
results in erroneous data being returned.

Variable

Description

OVBPI_FLOWGUID

Internal unique identifier (GUID) for the
process definition in the BPI
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.

OVBPI_FLOWIDENTIFIER

Identifier for the process instance in the
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event. This property contains a value only if
the instance threshold violation is an instance
violation, for example, Absolute duration. It
does not contain a value if the property is for a
statistical violation, for example, a Backlog
count. This is the property that you have
nominated to be the identifier for the process.
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Variable

Description

OVBPI_FLOWINSTANCEGUID

Internal unique identifier (GUID) for the
process instance in the
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event. This property contains a value only if
the instance threshold violation is an instance
violation, for example, Absolute duration. It
does not contain a value if the property is for a
statistical violations, for example, a Backlog
count.

OVBPI_FLOWMETRICGUID

Internal unique identifier (GUID) for the
process monitor in the
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.

OVBPI_FLOWMETRICNAME

Name of the process monitor in the BPI
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.

OVBPI_FLOWMETRICVALUE

Value of the process monitor in the BPI
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.

OVBPI_FLOWNAME

Name of the process in the BPI
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.

OVBPI_THRESHOLDALERTGUID

Internal unique identifier of the instance
threshold identified in the BPI
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.

OVBPI_THRESHOLDMESSAGE

Message defined for the BPI
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event. This is the message that you have
defined to be displayed when the event is
triggered.

OVBPI_THRESHOLDNAME

Name of the monitor instance threshold in the
PROCESS_MONITOR_THRESHOLD_VIOLATIO
N event.
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The following table lists the environment variables for the Out-of-Sequence
violations. Using these environment variables for other violations results in
erroneous data being returned.

Variable Description

OVBPI_FLOWIDENTIFIER Identifier for the process instance in the BPI
event. This the property that you have
nominated to be the identifier for the
process.

OVBPI_FLOWINSTANCEGUID Internal unique identifier (GUID) for the
process instance in the BPI event.

OVBPI_SOURCENODE Name of the Activity that is the source
Activity for the out-of-sequence violation.

OVBPI_DESTINATIONNODE Name of the Activity that is the destination
Activity for the out-of-sequence violation.
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Introduction to BPI Application Reports

This chapter includes:

Concepts

» BPI Application Reports Overview on page 290

Tasks

» How to Use the Reports to View and Analyze Data on page 292
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Concepts

& BPI Application Reports Overview

290

This section summarizes all the BPI reports you can view on the BPI
Application pages.

BPI enables you to view the overall status of your Business Processes and
Business Process Monitors, including any links that you might have to IT
operational resources.

The BPI Application pages can be accessed from the following menu option:

Applications > Business Process Insight

Note: The Business Process Insight Application reports and their data are
available only when you have installed the BPI license, BPI Server, and
configured the Server to send data samples to the Gateway Server.

The BPI Application Reports provide:

» Overall view of the health and status of the Business Processes that you
have deployed in your BPI system, including the status of any Business
Process Monitors.

» Overall view of the status of the IT operational resources that you have
linked your Business Process Activities to.

» Details of the individual process instances and their progression through
the Activities in the process.

> Details of the active process instances at individual Activities in the
process.

» Details of any thresholds that have been violated.

» Details of the transactions that you have linked your Business Process
Activities to within TransactionVision.
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» Graphical representation of your monitor data, which can be displayed in
terms of times, where appropriate.

» View of the aggregated Monitor data, which can include minimums,
maximums and standard deviations.

» Ability to configure the types of graphs and the period over which the
monitor data should be presented.

» Ability to search for specific process instances.
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Tasks

T How to Use the Reports to View and Analyze Data

292

The following are the tasks that you can complete to use the reports to view
and analyze data.

This task includes the following:

» “Use the reports to view data” on page 292

» “Customize the Business Process Diagrams and use annotations —
optional” on page 293

Note: Three main reports enable you to track and monitor your Business
Processes. In addition, you can also use the Business Process Diagram,
which is available from the Application > Service Health menu. For details
on using the Business Process Diagram in Service Health, see Chapter 13,
“BPI Components in MyBSM.”

Use the reports to view data

» To view all the Business Processes that are currently selected to be
monitored use the Scorecard. The Scorecard displays the current values of
the configured KPIs; see Chapter 9, “BPI Application Scorecard.”

The Value is based on the Process Value property of the Business Process.
The Process Value is assigned when you create the Business Process in the
Modeler.
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» To view a graphical representation of a selected Business Process in the
form of the process diagram, use the Health tab. The process diagram is
annotated with information of the overall Business Process in both
business and operational terms, and the individual Activities in the
process.

In addition, there are links to more details of the various components of
your Business Process; see Chapter 10, “BPI Application Health.”

» To view data for Business Processes and Business Process Activities, use the
following reports in the BPI Application:

> “Business Process Summary Report” on page 373
> “BPI Monitors Over Time Report” on page 384
> “Business Activity Summary Report” on page 388

The Reports are described in Chapter 11, “BPI Application Reports.”

Customize the Business Process Diagrams and use annotations
- optional

You can customize your Business Process diagrams and define annotations
specific to your processes. Some level of annotation is provided by default;
however, you can modify the form of these annotations for your Process
Diagrams. These customizations are described in Chapter 12, “Annotations
for Process Diagrams.”
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BPI Application Scorecard

This chapter includes:

Concepts

» BPI Application Scorecard Overview on page 296
» Understanding KPI Statuses on page 297

Tasks

» How the Scorecard Builds its Display on page 298
Reference

» BPI Application Scorecard User Interface on page 301
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Concepts

& BPI Application Scorecard Overview

296

This section provides an overview of the key features of the BPI Application
Scorecard pages and explains how to use the Scorecard pages to provide
summary information for your Business Processes.

The Scorecard presents a type of report and enables you to display the real
time status, trend, and changes-over-time data for the selected BPI Business
Processes and Business Activities. These are organized by best and worst
statuses.

The Scorecard is divided into the following areas:

» The common header, which enables you to tailor the content of the main
body of the page; see section “Common Header” on page 302.

» The main body of the page, where the selected Business Process data is
presented; see section “Results Area” on page 304.

Following is an example of the BPI Scorecard and these two areas:
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& Understanding KPI Statuses

When a KPI is not relevant to the Business Process, the Status column
displays [NA], the Trend column is empty, and the over time bar does not
exist.

When a KPI is relevant for the Business Process but has a No Data status, the
Status column displays a grey icon, the Trend column is empty, and the
relevant part of the over time bar is grey.

When the Business Processes are listed in one column only, the KPIs that are
not relevant for the Business Process are not displayed and each table
includes as many rows of KPIs as needed.

For details on KPIs, see “Health Indicators, KPIs, and KPI Domains” in Using
Service Health.
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Tasks

T How the Scorecard Builds its Display

This task describes how the Scorecard builds its display in the following
steps:

» “Sorting Mechanism” on page 299

> “Splitting Mechanism” on page 300
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Sorting Mechanism

The Scorecard pages sort and display selected Business Processes and their
KPI’s statuses from worst to best. The sorting mechanism compares the
selected Business Process Cls in pairs as shown in the following diagram.

Compare Cl_1and Cl_2

v

. no Is nbr of critical KPls for Cl_1 yes :
larger than nbr of critical KPIs for C1_27

‘equal

no Is nbr of major KPIs for C1_1 ves
<+ larger than nbr of major KPls for Cl_27 "

#equal
no .
Is nbr of minor KPIs for CI_1 yes
g - .

larger than nbr of minor KPIs for Cl_27

. +equa|

¢ Is nbr of warning KPIs for CI_1 larger | ¥Y&S )
than nbr of warning KPls for CI_27

*equal

yes Is nbr of OK KPIs for Cl_1 no :
< larger than nbr of OK KPIs for Cl_27

*equal

< yes Is nbr of Info KPIs for Cl_1 N0
larger than nbr of Info KPIs for CI_27

v +equa| L 4

Cl_2 is worse Order of Cls: Cl 1 is worse than
than CI 1 Alphabetical = s
_ + first Cl is "Worst” L

If a pair of Business Process Cls have the same number of KPIs with a specific
status, the sorting mechanism compares the number of KPIs with the next
better status using the critical, major, minor and warning statuses in this order.
The Business Process with the highest number of those KPIs is then given a
lower grade than the other Business Processes.
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300

If a pair of Business Process Cls have the same number of warning KPIs, then
the mechanism compares the number of KPIs with OK status. The CI with
the highest number of KPIs with the OK status is given a higher grade than
the other CI. The same sorting is used for the Info status.

KPIs without data are not used in the comparison.

If a pair of Business Process ClIs have exactly the same numbers of KPIs at
each status level, the page sorts the Cls alphabetically (from A to Z) and the
tirst CI in the alphabetical list, is given the lower grade.

Splitting Mechanism

When all Business Process CIs have a grade, the CIs are sorted into the Worst
and Best columns. If you select four or more Business Process Cls, the
Scorecard page is divided into two columns where:

» The Worst column displays the worst half of the Cls (lower grades)
ordered from worst (first row) to best (last row).

» The Best column displays the best half of the CIs (higher grades) ordered
from best (first row) to worst (last row).

Business Process Cls with no data KPIs always appear at the bottom of each
Worst/Best column. The splitting mechanism removes them from the list
before it lists the other Cls in the proper order and distributes these Cls
between the Worst and Best columns. The CIs with no data KPIs are then
sorted in alphabetical order and distributed between the Worst and Best
columns and put at the bottom of each column.

The Worst column includes one more Business Process Cls if you select an
odd number of ClIs.

A single column displays the Business Process Cls ordered from worst to best
from top to bottom when you select less than four CIs.
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Reference

@, BPI Application Scorecard User Interface

This section includes (in alphabetical order):
» Common Header on page 302

» Results Area on page 304

301



Chapter 9 * BPI Application Scorecard

® Common Header

The common header of the Scorecard enables you to select the criteria that you
want to use for presenting Scorecard results.

To access Applications > Business Process Insight > Scorecard
Important The Scorecard sorts and displays the ordered Business
information Processes and their KPIs statuses for the selected time

period; for details, see section “How the Scorecard Builds
its Display” on page 298.

The Scorecard page is available only when you have
configured the Business Process Insight Server to be
integrated with BSM and configured to send data samples
and configured a Profile database.

Relevant tasks

“How the Scorecard Builds its Display” on page 298

See also

“BPI Application Scorecard Overview” on page 296

The following user interface elements are included (unlabeled Ul elements
are shown in angle brackets):

Ul Element

Description

<Common report

settings>

For details, see “Common Report Elements” in
Reports.

Business Processes

Click to open the Business Processes dialog
where you can select the Business Process that
you want to display.

If one Business Process is selected, its name is
displayed to the right of the link. If more than
one Business Process is selected, (n/m) Filtered is
displayed to the right of the link, where n
represents the number of selected Business
Processes and m represents the total available for
selection.
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Ul Element

Description

KPlIs

Enables you to select the KPIs that you want to
display on the filtered results area for each
Business Process. All KPIs that have been
configured for the Business Process CI and any
child CIs are available for selection. Select one or
more KPIs and click OK.

If more than one KPI is selected, (n/m) Filtered
is displayed to the right of the link, where n
represents the number of selected KPIs and m
represents the total available for selection

View

Enables you to select the viewing period used for
the over-time bar in the results area. Select the
viewing period from the drop-down selection
box and click the Apply button to apply the
changes to the page.
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® Results Area

The Results area shows the results of the selections made from the Common
Area (see “Common Header” on page 302). The Results area enables you to
display the real time status, trend, and over time data of the Business
Process. The results are organized by worst to best statuses.

To access Applications > Business Process Insight > Scorecard
Important The Scorecard page sorts and displays the ordered
information Business Processes and their KPIs statuses for the selected

time period; for details, see “How the Scorecard Builds its
Display” on page 298.

The Scorecard page is available only when you have
configured:

» BPI Server to be integrated with BSM

» BPI Server to send data samples to the BSM Gateway
» Profile database

All the data sample information sent by the BPI Server is
displayed using the following KPIs:

» Backlog

» Business Health

» Business Impact

» Duration

» Value

» Volume
Relevant tasks “How the Scorecard Builds its Display” on page 298
See also “BPI Application Scorecard Overview” on page 296
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The following elements are included (unlabeled interface elements are

shown in angle brackets):

Ul Element

Description

Click the button to the right of the Business
Process to display the available menu options.
The context menu options are described in Using
Service Health.

<Business Process Name>

The name of the Business Process.

<Over-time bar>

Displays an over-time line, which consists of a
colored band representing the KPI status results
over the selected time; each color represents a
specific KPI status.

The width of the colored bands corresponds to
the length of time the KPI is in a particular
status. The most recent status in the time bar is
on the right.

Example:

KPI

The name of the KPI for the Business Process.
The column lists the KPIs that were selected in

the KPIs dialog box for the Scorecard.
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Ul Element Description

Status Indicates the status of the KPI. For details on the
statuses, see “Understanding KPI Statuses” on
page 297.

Tooltip: Provides the value of the status, and
indicated when the status was changed to the
current value.

Trend Indicates the trend of the KPI as compared to its
previous state.

For details on the trend information refer to the
Service Health documentation.

Tooltip: Provides the description of the trend.
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BPI Application Health

This chapter includes:

Concepts

» Health Page Overview on page 308

» BPI Instance and Violation Health Information on page 312

» Process Status on page 315

» Synchronization and Delay in Seeing Updates to Data on page 316
Tasks

» How to Configure Active Monitor Instances in the Infrastructure Settings
Manager on page 317

Reference

» BPI Application Health User Interface on page 318
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Concepts

& Health Page Overview

308

This section describes the BPI Application Health pages and explains how to
navigate and use them to track and monitor the health of your Business
Processes.

The Health pages show the operational and business health of the Business
Processes that you have defined using the BPI Modeler. The Health pages
also include data on the Business Process Monitors, Thresholds and KPIs
that you have defined for the Business Processes.

The Health pages provides:

» Graphical representation of a selected Business Process, in the form of the
process diagram. The process diagram is annotated with information
relating to the health of the overall Business Process and the individual
Activities in the process.

» Business Process or Business Activity summary information according to
the selection criteria. This shows the overall business health of the
Business Process or Business Activity, in tabular and in graphical form.
You can drill down and view related BPI reports if required.

» Details of the KPIs that you have defined for the selected Business Process
or Business Activity, or Business Process Monitor.

» Instance violation counts for the selected Business Process or Business
Activity.

> Ability to view the status of the IT operational resources that are linked to
Activities in the Business Process.

> Ability to filter Business Process and Activity data by a specified group. A
<group_property> drop-down list displays on the Health page, if the Group
property was set in the Modeler for the Business Process. The Group
drop-down lists the groups that were defined in the Modeler.
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If the Group property was not set or was set to None in the Modeler, the
<group_property> drop-down list does not appear on the Health page or
any of the Health dialogs. For details on setting the Group property in the
Modeler, see Chapter 3, “Modeler Management.”

You can limit the number of groups that can be specified using the BPI
Server Admin Console, to optimize BPI’s performance. For details on
setting the group limit, see the "Component Configuration - Business
Impact Engine (BIE)" section in the Business Process Insight Server
Administration Guide. If the number of groups specified in the Group
property field exceeds the group limit, the data for the groups listed
beyond the exceeded number are combined into a group called Other.

Note: If you had defined groups in the Modeler, but set the Group
Property to None, and you later decide you want to collect data by groups
on the client pages, you can reset the Group Property value in the
Modeler and redeploy the Business Process. Changes to the Group
Property require redeployment of the process model.

Ability to view a summary of related TransactionVision Business
Transaction ClIs and KPIs that are linked to the current Business Process.
You do this by drilling down to the Transaction Management Transaction
Summary Report from the Transactions tab on the main Health page.

If there are no TransactionVision ClIs linked to the Business Process that
you are viewing, no data is available from this option.

Ability to view details about a specific transaction instance related to a
Process instance by drilling down to the Transaction Management
Transaction Tracking Report, to see a list of all completed
TransactionVision transactions in a specified time frame.
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The Following figure shows an example of the top-level Health page for the
Business Process Insight application.
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The Health Page is subdivided into different areas of focus, but at the
top-level it provides an overall view of both the business and operational
health of your deployed Business Processes. To access, select Applications >
Business Process Insight > Health.
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Note: The Health page is available only when you have configured the BPI
Server to connect with the BSM Server so that data samples can be sent to
the BSM Server. For details, see the "Component Configuration - HP
Business Service Management Settings" section of the Business Process Insight
Server Administration Guide

The Health Page is divided into the following areas, each of which provides
more detailed information:

» “Process Diagram Area” on page 318

You can collapse and expand the Process Diagram if you want to provide
more space for the information shown on the tabbed areas under the
diagram.

» “Summary Tab” on page 326

The Summary Tab displays process instance information and the
Scorecard over time graph for the selected Business Process.

From the Summary Tab you can link to additional pages, which enable
access to details of Instances; see “Process Instances Dialog” on page 336

» “Business Health Tab” on page 330

The Business Health Tab displays KPI details in the form of a dial and
instance violation details in the form of a table.

From the Business Health Tab, you can link to additional pages, which
enable access to details of:

» Violations; see section “Instance Violations Dialog” on page 352.
» Monitor details; see section “Monitor Dialog” on page 356.

» BPI Monitors Over Time Report; see section “BPI Monitors Over Time
Report” on page 384.

» Process Over Time Report; see section “Business Process Over Time
Report” on page 392.

> Activity Over Time Report; see section “Business Activity Over Time
Report” on page 396.
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» “Transactions Tab” on page 333

From the Transactions tab, you can link to the Transaction Management
Transaction Tracking report, which provides more details of the selected
transaction event.

& BPI Instance and Violation Health Information

Some of the information presented from the Health pages (links from the
Health tab) is sourced directly from the BPI Server and some is sourced from
the BSM system.

When you open the Health page, the page consists of a set of Java Server
Pages (JSPs) and Java beans, which run on the Web Server configured for
your BSM installation.
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The data presented within the Process Diagram area, the Summary Tab and
the Business Health Tab is sourced using the BSM Web Server, which obtains
its count information directly, from the BPI data samples, as shown in the
following diagram:

BP| Health
Page

BSM Web
Server

Profile DB

[sample
data)

The BPI Instance and Violation pages, which you access when you drill
down from the top-level Health page to subordinate pages and dialogs, are
managed by a set of Java Server Pages (JSPs) and Java beans. These JSPs run
on the Web Server configured for the BPI installation and the instance and
violation data is obtained from the BPI Instance database.
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Following is a diagram of the BPI Instance and Violation web pages.
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If the BPI Server, or Servlet Engine, is not running for any reason, this
information is not available within the Health Pages.
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& Process Status
When displaying the status of a process, the following terms are used:

» Blocked

At least one instance of the process is active for an Activity, and this
instance cannot proceed due to a problem in an underlying IT
operational service.

» At Risk

There are currently no process instances in a blocked state, however there
are process instances in progress that might reach the blockage some
point in the future.

» Healthy

All active process instances are currently past the blockage and can
therefore continue to run to completion, or there is no problem with the
IT infrastructure.

There is also an icon representing each of the statuses, which is used in place
of text. Following are the Business Process Status icons:

Healthy o
At Risk W
Blocked (%]

Note: Be aware that these rate values can give slightly incorrect values.
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& Synchronization and Delay in Seeing Updates to Data

316

The data displayed on the BPI application is based on data sample data. The
frequency that the data samples are sent are configured using the Data
samples settings within the BPI Server Administration Console, described in
the Business Process Insight Server Administration Guide.

Only the instance data shown in the drill-downs from the BPI Health page is
obtained directly from the BPI Instance database.
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Tasks

T How to Configure Active Monitor Instances in the
Infrastructure Settings Manager
You can determine whether active monitor instances are to be included in

violation counts on the Health page, or to include only completed
instances.

1 To modify the active monitor instances setting, select Admin > Platform >
Setup and Maintenance > Infrastructure Settings:

2 Select Business Process Insight.

3 In the Health Page Setting, locate the Include violations for active
monitor instances setting. Change the value to:

» True to include active monitor instances in violation counts on the
Health page

» False to include only completed instances and violation counts on the

Health page and the Business Process Instance Violations component
in myBSM
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Reference

@, BPI Application Health User Interface

This section includes:

» Process Diagram Area on page 318

» Summary Tab on page 326

» Business Health Tab on page 330

» Transactions Tab on page 333

» Process Instances Dialog on page 336
» Process Instance Dialog on page 344

» Activity Instance Dialog on page 350
» Instance Violations Dialog on page 352
» Monitor Dialog on page 356

» Monitor Threshold Dialog on page 364

® Process Diagram Area

318

The Process Diagram shows the components and structure of the Business
Process when you create it using the Modeler. The data displayed is based on
data samples sent to BSM from the BPI Server.

This enables you to visualize the Business Process, which includes the
Activity annotations to indicate how many process instances are active at a
particular Activity and the process values.



Chapter 10 ¢ BPI Application Health

Following is the Process Diagram area on the Health page:
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To access Aplications > Business Process Insight > Health
Important When displayed in the Process Diagram page, the
information Business Process layout is the same as when it is created
in the Modeler.

The data displayed on the Health page changes according
to whether you select one of the following:

» Whole process — in this case, the data relates to all the
instances for all the Activities in the process.

» Specific process Activity — in this case, the data relates
to all the instances for the selected Activity.

Click a specific Activity to obtain data for the Activity.

Click anywhere in the process diagram area, but not

another Activity, to deselect it and move to a whole

process view.

See also “Health Page Overview” on page 308
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

(=) Click this icon to collapse and expand the pane
= where the Process Diagram is located. This
permits more room for the tabbed areas below
the diagram.

The arrows point upwards when the process
diagram is displayed.

uy This and the icon that follows enable you to
toggle between a fit-to-pane view and a normal
view.

Click this icon to stretch or shrink the Process
Diagram such that it fits within the available
space.

' This and the icon above enables you to toggle
—_— between a fit-to-pane view and a normal view.

Click this icon to revert the Process Diagram to
the size it was when defined within the Modeler

i Click this icon to hide or display transactions.

- This icon is the Activity that represents a
normal starting point for a process.

Note: A visual representation of the health of
the Business Process with respect the IT
operational resources on which it depends. The
health of each Activity is shown as an icon
overlay. “Activity Overlay” on page 325
describes these overlays and their meaning.

Customization: You can customize the Activity
graphic as described in Chapter 12,
“Annotations for Process Diagrams”.
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Ul Elements

Description

|

This icon is the Activity that represents an
activity within your Business Process, for
example, a check for account details.

Note: A visual representation of the health of
the Business Process with respect the IT
operational resources on which it depends is
shown in terms of an icon overlay. “Activity
Overlay” on page 325 describes these overlays
and their meaning.

Customization: You can customize the Activity
graphic as described in Chapter 12,
“Annotations for Process Diagrams”.

This icon is the Activity that represents a
normal end point for a process.

Note: A visual representation of the health of
the Business Process with respect the IT
operational resources on which it depends is
shown in terms of an icon overlay. “Activity
Overlay” on page 325 describes these overlays
and their meaning.

Customization: You can customize the Activity
graphic as described in Chapter 12,
“Annotations for Process Diagrams”.

This icon represents a junction point within
your Business Process and is a visual Activity
and is used to help define the structure of the
Business Process.

It shows the start and end point of a structural
element in the process and has no IT
operational resource status or count and value
information associated with it.
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322

Ul Elements

Description

<Activity overlay>

A visual representation of the health of the
Business Process with respect the IT operational
resources on which it depends. The health of
each Activity is shown as an icon overlay.

The Activity overlay provides additional
information to show the health of the of the
selected Business Process with respect to the IT
operational resources on which the process
depends; see “Activity Overlay” on page 325 for
more information about the meanings of the
overlays.

<group_property> drop-down

Available if the Group property was set in the
Modeler for the Business Process. If the Group
property was not set, or was set to None, this

field is not shown.

Select one of the following Group attributes to
filter the data shown for a Business Process:

» All - Shows combined data for all the groups.
» <Group> - Shows data only for that group.

» Not Set - Shows combined data for process or
monitor instances which existed before the
grouping was defined for the process.

» Other - If available, shows combined data of
groups that exceeded the group limit set in
the BPI Server Admin Console. This only
appears if the number of defined groups
exceeded the limit. For details on setting the
group limit, see the "Component
Configuration - Business Impact Engine
(BIE)" section in the Business Process Insight
Server Administration Guide.

For more details on groups, see “Health Page
Overview” on page 308.
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Ul Elements

Description

<Normal Arc>

Process Activities are linked using Arcs, which
are dotted lines that join Activities. The Arc
shows the direction of the flow in the Business
Process; they do not imply any sequence or
processing order, but they do imply an expected
order. Arcs are not enforced; however, they are
used when determining the business impact
status of the process.

If you want to know when the Activities in your
process are executed in an unexpected order,
use a Sequence Arc.

<Sequence Arc>

A Sequence Arc is a solid line and is a
notification that the Activities, which are
connected by the arc, are not being activated in
the correct order. The correct order is
determined by the direction of the arc between
the Activities.

<Text below the Activity icon>

This is the name of the Activities as entered in
the BPI Modeler when the process was created;
for example: Confirm Identity.

<Text in upper left-hand
corner of Activity icon>

In the case of a Start or Business Activity, this
represents the total Business Process value of all
the instances that are currently active at that
Activity.

In the case of an End Activity, this represents
the total value of all the instances that have
completed at that Activity.

If the locale for the system is set, a currency
symbol appears with the text for values that are
currencies.

Customization: You can customize this text as
described in Chapter 12, “Annotations for
Process Diagrams”.
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Ul Elements

Description

<Text in upper right-hand
corner of Activity icon>

This is the count of the number of instances
that are currently active at the Activity. The End
Activity shows the total of the completed
instances for the business; this is the total of all
instances since the process was deployed in the
Modeler or the counts were reset.

If the locale for the system is set correctly, the
count is displayed in a locale-sensitive format.

Customization: You can customize this text as
described in Chapter 12, “Annotations for
Process Diagrams”.

Business Health Status

Overall Business Health of the Business Process.
The worst case status is presented here.

Last Update

The date and time the data presented on the
Health page was last updated.

Note: If you have configured a delay for
sending data samples to BSM, the data
presented is not for Last Update time, but for
the Last Update time adjusted by the delay you
have configured; refer to section “Data
Samples” on page 41 for more information.

Operational Status

Overall IT operational resource status for the
Business Process. The worst case status is
presented here.

This is the IT operational resource status as it is
known to BPIL

Real Time Process Diagram

Click to view the Process Diagram data from the
BPI Server in real time.

Selected Business Process

Click to open a drop-down list where you can
select a different Business Process that you want
to display on the Health page.
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Activity Overlay

The Activity Overlays provide additional information about the Process
Diagram to show the health of the Business Process.This is the health of the
Business Process in terms of the IT infrastructure of the underlying systems
on which the individual Business Activities are linked. The IT infrastructure
is linked to the Activities in your Business Process when you model the
process using the BPI Modeler.

The overlays are presented as visual representations and are shown in terms
of an icon overlay on the Activity of the Business Process.

The diagram displays the operational status as an overlay on an Activity if
the status is OK or above.

The following table describes the overlays in more detail (unlabeled Ul
elements are shown in angle brackets):

Ul Elements (A-Z) Description
i A system health status of OK. All the system KPIs
oot

fell within their configured settings.

QTQ:- A system health status of Warning. The worst
status of any system KP], for a dependent CI, was
reported as a warning (using the worst-child
rule).

: A system health status of Minor. The worst status
of any system KPI, for a dependent CI, was
reported as minor (using the worst-child rule).

a7 A system health status of Major. The worst status
o of any system KPI, for a dependent CI, was
reported as major (using the worst-child rule).

(%] A system health status of Critical. The worst
status of any system KPI, for a dependent CI, was
reported as critical (using the worst-child rule).

@ The system health status is No Data. This means
there is insufficient data to make a decision on
the system health status.
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® Summary Tab

The Summary tab shows business and operational summary information
relating to either the selected Business Process (see “Business Process
Elements” on page 327), or the selected Process Activity (see “Business
Activity Elements” on page 328).

Following is an example of the Summary Tab on the Health page.

Dperabonal Status

Businass Hazlth

Summary Business Health Transactions
KDL Past Hour
Barklog S

Aplications > Business Process Insight > Health > select
the Summary tab

» If you select a Business Process, you can then select
specific categories of process instances; for example,
blocked instances. You are then moved to the
Instances Details page, where the list of instances is
filtered to show only those process instances that are
blocked.

» The label No Data is displayed when no data samples
are available.

Description :  Automabed Phone Provisioning
Buszinass Impact: Instancas Valua
[*] 523 USDS0, 425
W o UsSDo
a n uspo
523 UsESn, 425
To access
Important
information
See also

“Health Page Overview” on page 308

The Summary Tab includes the following:

> “Business Process Elements” on page 327

> “Business Activity Elements” on page 328
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Business Process Elements

The following table describes the elements presented on the Summary Tab
when the Business Process is selected; that is, you have not selected a
specific Activity in the Business Process.

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Elements Description

<Name> The name of Business Process is shown in the title
bar of the tabs area and is the name of the Business
Process as entered using the Modeler.

Description Content of description field entered using Modeler.

If no description is provided, [NA] is displayed as a
value.

Business Impact

Breakdown of the health status of all the process
instances for the selected Business Process. It
includes instances that are:

» Healthy

» At Risk

» Blocked

For more details about the status field, see “Process
Status” on page 315.

Click the status label to open the Process Instances
Page, which is filtered to show only instances with
the selected status; see “Process Instances Dialog”
on page 336.

Instances

Numbers of instances for the Business Process in
each of the specified statuses; see “Process Status”
on page 315 for a description of the status field.

The total Count for all instances is also presented
and the count of Violations.

Value

Value of the instances for the Business Process in
each of the specified statuses; see “Process Status”
on page 315 for a description of the status field.

The total Value for all instances is also presented.
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Ul Elements Description

Completed Click to open the Process Instances Page, which is
filtered to show only instances with the status of
Completed.

<Scorecard summary> Scorecard display for the selected Business Process
showing the over-time bar; see Chapter 9, “BPI
Application Scorecard”.

Business Activity Elements

The following table describes the elements presented on the Summary Tab
when a specific Business Activity is selected (unlabeled Ul elements are
shown in angle brackets):

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

<Name/Activity name> Name of Business Process and the Business Activity
is shown in the title bar of the tabs area and is the
name of the Business Process and Business Activity
as entered using the Modeler.

Description Content of description field for the Business
Activity when entered using the Modeler. If no
description is provided, [NA] is displayed as a
value.

Instances Lists the Active instances for the selected Activity.

Active instances are still progressing through the
process.

Click the Total Active link to open the Instances
Page; see “Process Instances Dialog” on page 336.
The instances page is filtered to show all the
process instances for the selected Activity within
the selected Business Process.
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Ul Elements Description

Count Label for the instance counts, which lists the
number of Active instances at the selected Activity.

Active instances are still progressing through the
process.

Value Labels for the value, which lists the values of the
instances that are Active at the selected Activity.

Active instances are still progressing through the
process.

<Scorecard summary> Scorecard display for the complete Business
Activity showing the over-time bar; see Chapter 9,
“BPI Application Scorecard”.
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® Business Health Tab

The Business Health tab enables you to view objectives set on a Health
Indicator, Violation counts and details.

Following is an example of the Business Health tab on the Health page.

SurTaFy | Business Health Transactione
Monitor Status : Details Sample period: 3 minubss Instance Violation Counts : Dolails Al Wiolatior:
=l Name Q W L} i
- all - Brovision Tims La 3E =9 a4
A0 SeEA o T e b
i Eold Srovision Tims & a7 27 31
-'-j [ 7 .
N h Manually Disapproved = a a
LISDA2.692 .57 Oh: 17 m: 50 5 TR T VO S R
Badklag Duration
Phone Provision Phone Provision Time
-
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To access

Aplications > Business Process Insight > Health > select
the Business Health tab

Important
information

The Business Health tab displays:

» Obijective dials for the objectives set on a Health
Indicator associated with a Business Process, Business
Activity or Business Process Monitor using the option:
Admin > Service Health > View Management> Cl
Indicators

See “Business Health Dials” on page 331 for more
details.

» Table showing the Instance Violation Counts for the
selected Business Process or Business Activity; see
“Instance Violation Counts” on page 332.

» Violation details for the selected Business Process or
Business Activity.

Click to open the Violations page; see “Instance
Violations Dialog” on page 352.

NOTE: You must create a unique KPI for each Health
Indicator. Otherwise, KPIs that contain multiple related
Health Indicators are not displayed.

See also

“Health Page Overview” on page 308
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The Business Health tab includes the following:

> “Business Health Dials” on page 331

» “Instance Violation Counts” on page 332

Business Health Dials
When you open the Business Health tab, you are presented with a series of
dials representing the KPI statuses that you have configured.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

<Dials> The dials provide a visual representation of the business
objectives that have been set on Health Indicators
associated with a Business Process, Business Activity or
Business Process Monitor.

The dial shows the current value. The needle on the dial
indicates status of the KPI value with respect to the
objectives that have been set on the related Health
Indicators.

<Drilldown> You can select a dial and drill down for more
information, as follows:

» For dials representing Business Process Monitor KPIs
configured using the Monitor Definer, you can drill
down to the Monitors Over Time Report; see “BPI
Monitors Over Time Report” on page 384.

» For dials representing Business Process or Business
Activity KPIs, you can drill down to the Business
Process Over Time or Business Activity Over time
Report; see “Business Process Over Time Report” on
page 392 and “Business Activity Over Time Report” on
page 396.

You can also drill down to the Monitors page for more

details of the Monitors; see “Monitor Dialog” on

page 356.
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Ul Elements Description

<KPI name and The name of the KPI and the appropriate Process.
process or activity Activity, or Monitor or Process Activity name are
name> displayed below the dial.

If the dial represents objectives set on a custom monitor,
the KPI name is shown as the custom monitor data units
value.

<KPI status> The KPI status shows the current status of all the KPIs for
which you have set Health Indicator objectives.

<Tooltip> There is a tooltip for each dial showing the monitor
status, plus the monitor and objective values. The
background color for the tooltip indicates the Business
Process Monitor status.

Instance Violation Counts

The Business Health tab displays an Instance Violation Counts table which
summarizes the counts for the selected Business Process or Business Activity.

The Instance Violation Counts table can be configured to include threshold
violations for active instances of duration monitors, or to include only
completed instances. A duration monitor instance is considered active if the
business process instance has entered the monitor's span, but not yet exited.
For details on this configuration setting, see “How to Configure Active
Monitor Instances in the Infrastructure Settings Manager” on page 316.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

All Violations Click the link to open the Violation page, which is
filtered to show violations for the selected Business
Process, or Business Activity; see “Instance Violations
Dialog” on page 352.

Threshold Name You can select an Instance Threshold and drill down to
Drilldown the Threshold Violations table for more information
about the individual threshold instances.
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® Transactions Tab

The Transactions tab displays summary information relating to the Business
Transactions that are linked to the selected Business Process or Business
Activity.

Following is an example of the Transactions Tab on the Health page:

BondTrage

Business Transactions [ status

Agualk 33 Large Loan

OO0 C

To access Aplications > Business Process Insight > Health > select
the Transactions tab

See also “Health Page Overview” on page 308

You can see which Business Transactions drive each Business Activity in the
Business Process in one of the following ways:

» In the “Transactions Tab Table” on page 334.

» In the “Transactions Tab Process Diagram” on page 335.
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Transactions Tab Table

The Transactions tab table shows in table format which Business
Transactions drive each Business Activity in the Business Process.

Following are the user interface elements that are presented in the
Transaction Tab table. The elements are the same if you select the whole
Business Process, or a Business Activity (unlabeled Ul elements are shown in

angle brackets):

Ul Elements

Description

Business Transactions

The name of the Business Transaction as defined
in TransactionVision and as linked to the BPI
Business Process.

Click a Business Transaction to drill down to the
Transaction Summary Report in Transaction
Management. This report displays a list of all
completed transactions in a specified time
frame, as well as volume and response time
metrics. For details, see “Transaction
Management Reports” in Using Transaction
Management or the Transaction Management
Help.

<column data>

This column data is as defined under:

Admin > Service Health> Business Transactions
The columns included on the Transactions Tab
are variable to match the KPI defined for

Business Transaction and as shown in Service
Health.

Status Current status of the Business Transaction as
defined by TransactionVision.
Used By List of all activities linked to the Business

Transaction.
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Transactions Tab Process Diagram

Following is an example of the Process Diagram when the Transactions Tab
is selected on the Health Page.

Seorecard | Health fteports

Selected Business Erocess: Buy Stock 1] B“'""e"’;;::lj;': & Operational Status: ) Last Update: 03108:02 |
a BEE
0
By i ME
A
[ ™
$4.2E4, CICIO T=1,280 X By §0 T=3
P
<3l W <
(#] ! W
r \
Insufficient ¥ Y Exacution
Funda i ‘ Failad
¢ -\,\
¥
40 0 45,800 2 $13,600 4 $6.800 2 10, 200\3 43,400 L. $13,705,655 T=4,032
T T | NERREERG  R.
] J
Lagin Subrnit walidation Lack WAIME \' E:-c&r.ute E-(GCL'ﬁ‘Jn
Trade Aecount ranEndion ceaEEhul
40 T=0 $0 T=0 40 T=0 0 T=0
Subrnit Walidation Lack WIME Exgodbe
Trade drapp=d Arzount Dropped Traneackion
Dropped Dropped Cropped

When you select the Transactions tab on the Health page, the Process
Diagram changes to show the relationships between the Business Activities
and the Business Transactions. Each Business Transaction is represented by
the Transaction icon along the bottom of the Process Diagram, with dotted
lines to the activities they drive.

When you click a Business Transaction icon, the dotted lines are highlight
between the icon and the Business Activities to which the icon is linked. You
can also click the Business Activity to highlight the dotted line to the
Business Transaction that drives it.

The Hide Transactions icon enables you to toggle between hiding and
viewing the transaction icons and dotted lines.
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@ Process Instances Dialog

The Process Instances dialog displays information relating to the process
instance counts.

Process Instances

Phone Provision: Process Instances

Business Activity : | All Activities bt | Region : _

Process Instances: Found 4,518 - showing most recent 10. Export all as CSV.
IdentiFierl:l Search Instance Status: Maximum List Size ¢ | 10 W
Identifier Process Value Start Time End Time Status -
812246 $105.95 | 2/23/10 1:41:56 PM PST == 0
812236 569.99 272310 1:41:37 PM PST -- o
812232 £99.30  2/23/10 1:41:26 PM B5ST == o
812231 £85.60 2/23/10 1:41:23 PM PST — o
812221 $105.95 | 2/23/10 1:40:54 PM PST == 0
812212 569.99  2/23/10 1:40:37 PM PST -- o
812208 $99.50 | 2/23/10 1:40:29 PM PST == o
812208 £85.60 2/23/10 1:40:27 PM PST -- (v]
812198 $105.95 | 2/23/10 1:39:53 PM P5T == 0

Q Hezlthy Y at Risk € Blocked @ Completed

Close Help
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To access Aplications > Business Process Insight > Health > select
one of the following links in the left panel of the
Summary tab: Healthy, Blocked, At Risk or Completed

Important The display is filtered according to the status of the
information instances and whether the instance counts have been
requested from a Business Process, or an Activity context.
The most recent instances are listed first. For details, see:

» “Process Instances for a Selected Business Process” on
page 337

» “Process Instances for a Selected Business Activity” on
page 341

See also “Health Page Overview” on page 308

Process Instances for a Selected Business Process

This section describes the Process Instances dialog when selected from a
Business Process context. The Process Instances dialog is divided into the
following areas:

> “Instances Dialog Settings for a Business Process” on page 338

> “Instances Dialog Results for a Business Process” on page 339
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Instances Dialog Settings for a Business Process

The following table describes the user interface elements for the settings area
of the Instances dialog for a Business Process (unlabeled Ul elements are

shown in angle brackets):

Ul Elements

Description

Business Activity

Indicates the selection criterion for the dialog.
You can list all the Activities in the selected
Business Process, or you can select a specific
Activity and list only the instances that are
active at the Activity.

The number of Process Instances found and the
number of Process Instances listed in the results
area is displayed underneath this UI element.

<group_property> drop-down

Available if the Group property was set in the
Modeler for the Business Process. If the Group
property was not set, or was set to None, this

field is not shown.

Select one of the following Group attributes to
filter the data shown for a Business Process:

» All - Shows combined data for all the groups.
» <group> - Shows data only for that group.

» Other - Shows combined data of groups that
exceeded the group limit set in the BPI Server
Admin Console. This only appears if the
number of defined groups exceeded the limit.
For details on setting the group limit, see the
"Component Configuration - Business Impact
Engine (BIE)" section in the Business Process
Insight Server Administration Guide.

For more details on groups, see “Health Page
Overview” on page 308.

Identifier

The Identifier of the Process Instance that you
want to list in the results area. You can search for
a specific instance, or leave this field blank if you
want to list all Process Instances. Wildcard
searches are also available.
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Ul Elements

Description

Instance Status

The status of the Process Instances that you want
to list in the results area.

Select the value Any to list all Process Instances
in all states.

Maximum List Size

The number of Process Instances that you want
to list in the results area. You can select from a
list size of 12, 20 50 or 100.

Export all

Enables you to export all the process instances
and their values to a file in comma separated
value (CSV) format. You can optionally include
Data definition values when exporting the
process instance information; this is set from the
Servlet Engine option within the BPI Server
Administration Console. see "Component
Configuration - Servlet Engine" in the Business
Process Insight Server Administration Guide.

The exported CSV file can then be imported into
Microsoft Excel for analysis.

Instances Dialog Results for a Business Process

The following table describes the user interface elements in the results area
(unlabeled UI elements are shown in angle brackets):

Ul Elements Description

End Time The time that this Process Instance fulfilled the
End Condition for the End Activity, if applicable.

Identifier The identifier for the Process Instance. Click to

open the Process Instance page to obtain more
information relating to the selected Process
Instance; see section “Process Instance Dialog”
on page 344.
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Ul Elements

Description

Process Value

The content of the Value attribute for the listed
Process Instance.

Process Value is based on the Process Value
property of the Business Process. The Process
Value is assigned when you create the Business
Process in the Modeler. The value is typically
assigned from a Business Event when the
processes is active.

Start Time The time that this Process Instance fulfilled the
Start Condition for the Start Activity.
Status The status of the listed Process Instance, and can

be one of:
» Healthy
» At Risk
» Blocked
» Completed

See “Process Status” on page 315 for descriptions
of the status values.
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Process Instances for a Selected Business Activity

This section describes the Process Instances dialog when selected from a

Business Activity view.

The Process Instances dialog is divided into the following areas:

> “Instance Dialog Settings for a Business Activity” on page 341

» “Dialog Instance Results for a Business Activity” on page 343

Instance Dialog Settings for a Business Activity

The following table describes the user interface elements for the settings area
(unlabeled UI elements are shown in angle brackets):

Ul Elements

Description

<Activity Name>

Name of the selected Activity

Activity Name

Select box that shows the current selection
criterion for the dialog. You can list all the
instances in the selected process, or you can
select a specific Activity and list only the
Instances that are active at the Activity.

Activity Status

The status of the Process Instances that you want
to list in the results area.

Select the value Any to list all Process Instances
in all states.

Average Duration (H:M:S)

The average time taken for all process instances
to fulfill the Start and End condition for the
Activity. This time is measured across all the
instances that have passed through this Activity.

A value for this field is provided only when there
is sufficient data to generate a statistical result.
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Ul Elements

Description

Export all

Enables you to export all the process instances
and their values to a file in comma separated
value (CSV) format. You can optionally include
Data definition values when exporting the
process instance information; this is set from the
Servlet Engine option within the BPI Server
Administration Console. See "Component
Configuration - Servlet Engine" in the Business
Process Insight Server Administration Guide.

The exported CSV file can then be imported into
Microsoft Excel for analysis.

Identifier

The Identifier of the Process Instance that you
want to list in the results area. Leave this field
blank if you want to list all Process Instances for
the selected Activity.

Instance Rate (per hour)

The rate at which instances of the Activity are
being completed, expressed as an hourly rate.

A value for this field is provided only when there
is sufficient data to generate a statistical result.

Maximum List Size

The number of Process Instances (Active and
Completed) that you want to list in the results
area. You can select from a list size of 8, 20 50 or
100.

Operational Status

Status of selected Activity, and can be one of:
» Healthy

» At Risk

» Blocked

» Completed

See section “Process Status” on page 315 for
descriptions of the status values.

Process Value Rate (per hour)

The value of the process instances as they are
processed on an hourly basis.

A value for this field is provided only when there
is sufficient data to generate a statistical result.
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Dialog Instance Results for a Business Activity

The following user interface elements are included (unlabeled Ul elements

are shown in angle brackets):

Ul Elements

Description

Activity Start Time

The time that this Process Instance fulfilled the
Start Condition for the selected Activity. If an
Activity fulfills its Start Condition multiple time,
the most recent start time is listed.

Activity Stop Time

The time that this Process Instance fulfilled the
End Condition for a selected Activity.

Identifier

The identifier for the Process Instance. Click to
open the Process Instance page to obtain more
information relating to the selected Process
Instance; see “Process Instance Dialog” on
page 344.

Process Value

The content of the Value attribute for the listed
Process Instance.

Start Time

The time that this Process Instance fulfilled the
Start Condition for a Start Activity.
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@ Process Instance Dialog
The Process Instance dialog displays information relating to the selected

process instance.

Following is an example of the Process Instance dialog.

Process Diagram Process Timeline | Monitor Thresholds | Business Activities | Data Definition | Transactions

| Process Instances > Process Instance

EWT_Wire Transfer; Process Instance - Process Diagram

Instance Identifier: 346144

Call Request ™., Failed
i " Identity
Request Cheeck: Check Check:Funds Check Transfer Funds
Transfer Destination Satrce H Iderticy Funds Transferred
Irevabd Irevabd Insufficient
Destination Saurce Funds

@ normal @ wWarning /4 Miner Vielation W Major Vielation € critical @ Unknown

Close Help Reload
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To access

Applications > Business Process Insight > Health >
Summary tab > select one of the following links in the
left panel of the Summary tab: Healthy, Blocked, At Risk
or Completed > the Process Instances dialog opens >
select an identifier.

See also

“Health Page Overview” on page 308

The Process Instance dialog includes the following:

“Process Diagram” on page 346

“Process Timeline” on page 346

“Monitor Thresholds” on page 347

“Data Definition” on page 348

>
>
>
» “Process Activities” on page 347
>
>

“Transactions” on page 348
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Process Diagram

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

<Activity> Click an Activity in the process diagram and open the
Activity Instance dialog; see “Activity Instance Dialog”
on page 350.

<Process diagram> This shows the process diagram for the selected Process
Instance; see “Process Diagram Area” on page 318 for a
description of the process diagram.

Process Timeline

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description

<Activity> Click an Activity in the process diagram and open the
Activity Instance dialog; see “Activity Instance Dialog”
on page 350.

<Process Instance This shows the Process Instance details as a time line, so

details> that you can easily see the order in which Activities are
executed and graphically see the length of time spent at
each Activity.
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Monitor Thresholds

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Elements

Description

<Associated
monitor>

Click the associated Monitor to open the Monitor dialog;
see “Monitor Dialog” on page 356.

<Instance threshold
name>

Click the instance threshold name to open the Threshold
instance dialog; see “Monitor Threshold Dialog” on
page 364.

<Monitor Instance
threshold details>

This shows the monitor instance threshold details. Each
instance threshold is shown in the form of a dial. The
dial shows the status of the Monitor Instance Threshold.

Process Activities

This page lists the details of a selected Process Activity.

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Elements

Description

Activity Name

The name of the Activity instance.

Overall Duration

Time taken to complete the Activity.

Latest Start Time

Time at which the Process Instance fulfilled the Start
Condition for the last activation of the Activity.

Latest End Time

Time at which the Process Instance fulfilled the End
Condition for the last activation of the Activity.

Multiple Starts

Whether the Activity fulfilled its start condition more
than once.

<Activity>

Click an Activity to open the Activity Instance dialog; see
“Activity Instance Dialog” on page 350.
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Data Definition
This page lists the Data definition property values for the Associated Data
definition that has been defined in the Modeler for the Business Process.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements Description
Property Name The name of the Data Definition property as entered in
the Modeler.
Property Value The value for the Data Definition property at the selected
Activity.
Transactions

This page lists the TransactionVision transaction instances associated within
the context of the current Process Instance.

Following is an example of the Transactions tab:

Process Diagram | Process Timeline | Monitor Thresholds | Business Activities | Data Definition I Transactions

Erocess Instances > Process Instance

BondTrade: Process Instance - Transactions

Instance Identifiar: 00000129677890330000000000002510

BondTrade
Business Transaction @ Start Time End Time Completion State Result State
Bond &/24/10 5:25:55 PM &6/24/10 5:25:59 PM o) ]
e PDT PDT t t

(] Completed Wl Processing @ unknown @ Success € Failed

Close Help Raload
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The following elements are included for each transaction instance. User
interface elements are described below:

Ul Elements

Description

Business Transaction

The class name of the transaction instance.

If you configured BPI to integrate with TransactionVision
within Transaction Management, a link to the
Transaction Tracking Report (managed by Transaction
Management) for the selected transaction instance, is
displayed. For more details on the Transaction Tracking
Report, see Using Transaction Management.

Completion State

The current state of the transaction instance. This value
may be Processing, Completed or Unknown.

End Time

The time that the transaction instance finished.

Result State

The result state of the transaction instance. This value
may be Success, Failed or Unknown.

Start Time

The time that the transaction instance started.
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@, Activity Instance Dialog

This dialog lists all the instances that have fulfilled their Start and End
conditions for the selected Activity.

Process Instances » Process Instance = Activity Instance

EWT_Wire Transfer: Activity Instance

Instance Identifier: 247940

Activity Instance
Hame Check Destination
Activity Status Completed

Overall Activity Duration (H:M:S5) 0 : 00 : 00.03

Paired Start and End Times: Found 1.

Maximum List Size 1 | 10 ¥

Duration Start Time End Time
0:00: 0003 6/22/10 4:02:30 PM PDT 6/22/10 4:03:30 PM PDT
Close ‘ Help ‘ Reload
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To access Applications > Business Process Insight > Health >
Summary tab > select Completed status in the left pane
(opens the Process Instances dialog) > Business Activities
tab > select Activity Name link

See also “Health Page Overview” on page 308

User interface elements are described below:

Ul Elements

Description

Activity Status

The status of the selected Activity, see “Process Status” on
page 315 for details of the possible statuses for the
Activity.

Maximum List Size

A drop-down list box that enables you to configure the
number of items that appear in the list.

Name

The name of the selected Activity.

Overall Activity
Duration (H:M:S)

The time taken to complete the Process Activity.

Paired Start and End
Times

This is a list of the history of the Activity with respect to
the number of times the selected instance has fulfilled
the Start and End Conditions for the Activity; it includes
the Duration, Start Time and End Time.
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% Instance Violations Dialog

The Instance Violations dialog lists all the Threshold Violation instances
related to the selected Business Process or Business Activity.

Viclations
EWT_Wire Transfer: Violations
Violations: Found 1,224,889 - showing most recent 10. Export all as CSV.
Identifier : |—| Saarch | Severity | &l b Maximum List Size : |10 W
'I'l_me Threshold Tlrr_'le Violation Monitor Threshold M.onil:pr Value At Severity F‘roce_s; -
Violated Raised Name Name Violation Time Identifier
g_a’hfi.fDLTD 3:45:12 gﬁi&? 3:50:12 ﬁf ﬁtc Check |1 s mi0s A, 347008
gl"r“122p-"DLTD 3:45:12 g:\fig:? 3:50:12 E ﬁto Check Ohe T 0s 248827
g-"M22p-"DLTD 3:45:12 g:\fig:? 3:50:12 m_c ﬁtc Check OhiSm: 0= 2agm4n
g."r.‘122p-"DLTD 3:45:12 gl"n‘122p."Dl:rD 2:50:12 % ﬁto Check Oh:3m: 0s 347087
g."MEQp-"DLTD 2:45:10 g."MEEp."Dl:rD 3:50:12 ﬁ ﬁtc Checlk OhiSm:i0s L 247007
It:S,."'\\'II22l:,-"D]._|_D 3:45:10 g:\figf 3:50:12 E ﬁto Check Oh:7 0= ':— 248928
gl"r“122p-"DLTD 3:45:10 g:\fig:? 3:50:12 % ﬁtc Check OhiSm:0s () z4g547
g-"M22p-"DLTD 3:45:10 g:\fig:? 2:50:12 % ﬁto Check Ohi3m: 0= @ 247086
g."r.‘122p-"DLTD 3:45:09 gl"n‘122p."Dl:rD 3:50:12 ﬁ ﬁtc Check Oh:Sm: 0= A 47006
g."MEQp-"DLTD 2:45:0% g."MEEp."Dl:rD 3:50:12 E{ ﬁto Check OhiZm:i0s @ 247025 =
@ normal @ Warning /A Minor Viclation T Major Viclation € critical @ Unknown

Close Halp Reload

352



Chapter 10 ¢ BPI Application Health

To access Applications > Business Process Insight > Health >
Business Health tab > select Name identifier or All
Violations

Important » The most recent instance Threshold violations are

information listed first.
» The label No Data is displayed when no data samples

are available.
See also “Health Page Overview” on page 308

The following user interface elements are included for the Instance

Violation settings:

Ul Elements

Description

Activity Name

The Activity Name for the single-activity
Monitor.

Identifier

Enter a Process Identifier to list violations related
to a specific process instance. Leave this blank to
list violations for all process instances, or enter a
partial string to search.

Severity

Select a severity level (Warning, Minor, Major or
Critical) to list violations that are greater than or
equal to a specific violation level. Enter All to list
all violation levels.
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Ul Elements

Description

Maximum List Size

The number of instance violations that you want
to list in the results area. You can select from a
list size of 10, 20 50 or 100.

Export all as CSV

Enables you to export all the process instances
and their values to a file in comma separated
value (CSV) format. You can optionally include
Data definition values when exporting the
process instance information; this is set from the
Servlet Engine option within the BPI Server
Administration Console. See "Component
Configuration - Servlet Engine" in the Business
Process Insight Server Administration Guide. The
exported CSV file can then be imported into
Microsoft Excel for analysis.
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The following user interface elements are included (unlabeled Ul elements
are shown in angle brackets):

Ul Elements

Description

Time Threshold Violated

The time that the instance threshold condition was
violated.

Time Threshold Raised

The time that the instance threshold condition was
detected by BPIL.

The time that a instance threshold is detected can
be different if you have stopped the BPI Monitor
Engine, or the BPI system has been disabled for
some reason.

Monitor Name

Name of the Monitor that this instance threshold is
defined for.

Click to open the related Monitor Dialog; see
section “Monitor Dialog” on page 356.

Threshold Name

Name of the instance threshold.

Click to open the related Monitor Threshold dialog;
see section “Monitor Threshold Dialog” on
page 364.

Monitor Value At Time of
Threshold Violation

Value of Monitor when instance threshold was
violated.

Severity

Level of the violation, which can be one of:
» Normal

» Warning

» Minor

» Major

» Critical

Process ldentifier

Identifier for Process Instance listed for the selected
Activity and affected by the instance threshold
violation.

Click to open the related Process Instance page; see
section “Process Instance Dialog” on page 344.
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@ Monitor Dialog

The Monitor Dialog shows the data collected that relates to the Business
Process Monitors that you defined for a Business Process.

Monitor Diagram Monitor Description | Monitor Values | Monitor Graph | Monitor Summary |

| Monitors > Check Funds

EWT_Wire Transfer: Process Monitors - Monitor Diagram

Monitor Hame : |Check Funds w

Monitor Scope : Single activity scope, Duration

G E

Call Request ™., Failed

! Identity
$0 0 $2,063 1 0 0 51,035.3]0.5 ]B!.Z‘W WEU .i-'a,‘h?] i §663,301,394  T=121,729
E------___------@--"-----___"-D-ji _-----------___@____-----------@---___"-------E---"-___"--"E

Request Check Check Check Funds Check Transfer Funds
Transfes Drestination Source i Identity Funds Transferred
Qrz,s?s,uuf' T=13,201 §73,015 854 f T=13,231 $73.19|,3‘5&% Tel3,251
Irrvald Irnealid Insufficent
Destination Source Funds

@ Hormal & Warning /% Minor Viclation % Major Vialation € Critical @ Unknown

Close Help Reload |
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To access Applications > Business Process Insight > Health >
Business Health tab > select one of the following links in
the left panel of the Summary tab: Healthy, Blocked, At
Risk, or Completed (opens the Process Instances Dialog) >
select an identifier (opens the Process Instance Dialog) >
select the Monitor Threshold tab > click Associated

Monitor
Important Information about defining Business Process Monitors
information can be found in the following documentation:

» Business Process Insight Monitor Definer Online Help

» Business Process Insight Integration Training Guide -
Defining Business Monitors

See also “Health Page Overview” on page 308

The Monitor dialog includes the following:

“Monitor Diagram” on page 357
“Monitor Description” on page 358
“Monitor Values” on page 358
“Monitor Graph” on page 361

Y Y Y Y Y

“Monitor Summary” on page 363

Monitor Diagram

This page shows a graphical representation of the selected Monitor as a
process diagram, see “Process Diagram Area” on page 318 for a description
of the process diagram.

Click an Activity on the process diagram to open the Process Instances
dialog in the selected Activity context.

Select a group from the <group_property> drop-down list to view the Monitor
Diagram by that group, if groups were defined in the Modeler. If groups were
not defined, the <group_property> drop-down is not displayed. See “Health
Page Overview” on page 308 for details.
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The additional information about the process diagram are the red flags.
These red flags reflect those added when you defined the Monitor in the
Monitor Definer and show the start and end points for this Monitor
Definition. The flags do not appear in the case of a Business Process Monitor
with a span of Whole Process.

Monitor Description

This page displays the details of the Monitor as defined when you created
the Monitor using the Monitor Definer:

» Monitor Name
» Monitor Description
» Monitor Span

In the case of a Monitor Definition that has been defined with a span of
Single Activity or Multiple Activity, the Start Activity and End Activity
values are also listed.

You can use this page to gain an overview of all the monitors reported for
the selected process.

Monitor Values

This page lists the values for the Monitor instances, starting with the most
recent.

User interface elements are described below:

Ul Elements Description

Monitor Name Name of the selected Monitor.

The number of Monitor Instances found and the
number of Monitor Instances listed in the results
area is displayed underneath Monitor Name.

Process ldentifier Enter a Process Identifier to filter the list based
on a specific Process Instance, or leave the field
blank to filter on all instances.
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Ul Elements Description

Monitor Status Select the value of the status for the Monitor on
which you want to filter the results:
> All
» Active

» Completed

Maximum List Size The number of Monitor instances that you want
to list in the results area. You can select from a
list size of 10, 20 50 or 100.

Export All as CSV Enables you to export all the Monitor instance
data to a file in comma separated value (CSV)
format.

The exported CSV file can then be imported into
Microsoft Excel for analysis.

The results shown in the results area varies according to whether you are
viewing a Value or Duration Monitor.

» “Value Monitor” on page 359

» “Duration Monitor” on page 360

Value Monitor

The following table describes the user interface elements for the Monitor
Instance results area for a Value Monitor.

User interface elements are described below:

Ul Elements Description
Process Identifier The identifier for the Process Instance.
Start Time Time when process instance entered the span of

the Monitor.

End Time Time when process instance exited the span of
the Monitor.
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Ul Elements

Description

Monitor Status

Status of the Process Instance, which can be one
of All, Active or Completed.

Process Value

The configured value of each Process Instance
that is currently within the span of the monitor

Severity

The worst status of any instance threshold in
this monitor and which the process instance has
violated. The status can be:

» Normal

» Warning

» Minor

» Major

» Critical

» Unknown

Duration Monitor

The following table describes the user interface elements for the Monitor
Instance results area for a Duration Monitor.

User interface elements are described below:

Ul Elements

Description

Process ldentifier

The identifier for the Process Instance.

Start Time Time when process instance entered the Monitor
span.
End Time Time when process instance exited the Monitor

span.

Monitor Status

Status of the Monitor instance, which can be
one of All, Active or Completed.
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Ul Elements Description
Monitor Duration The value of the Monitor specified as a time.
Severity The worst status of any instance threshold in

this monitor and that the process instance has
violated. This status can be:

» Normal

» Warning

» Minor

» Major

» Critical

» Unknown

Monitor Graph

This page shows the Monitor results as a graph based on the statistics
collected for the Monitor; these statistics are selected from the Data
Aggregation Method. The graph can be either a bar chart or a line. The data
shown on the graph is tailored to your filter criteria. When you have
completed the settings for the filters, the graph is drawn automatically as
required.

The page is divided into an area to select the filter criteria and a results area,
which show the required data in graphical form.

User interface elements are described below:

Ul Elements Description

Monitor Name Name of the selected Monitor. You can change
the Monitor that you want to see the results for
using this drop-down selection box.

Data Aggregation Method The statistical sources that you want to use as
the data to be plotted on the graph.

Graph Type Select the type of graph that you want to show.
This can be either a bar chart, or a line graph.
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Ul Elements

Description

Graphing Period

Select the time period that you want to plot
results for. If you select All, then all the data
collected is plotted.

Chart by group

If you have defined Groups for your Monitors, in
the Monitor Definer, you have the option to
chart your data using the Group definitions.
Select Yes to chart using your Group definitions,
or No to chart the data without using groups.

Export Graph as CSV

Enables you to export the statistical data plotted
on the graph to a file in comma separated value
(CSV) format. You can optionally include Data
definition values when exporting the process
instance information; this is set from the Servlet
Engine option within the BPI Server
Administration Console. See "Component
Configuration - Servlet Engine" in the Business
Process Insight Server Administration Guide.

The exported CSV file can then be imported into
Microsoft Excel for analysis.

Export all data sources as CSV

Enables you to export all the statistical data for
all the data sources to a file in comma separated
value (CSV) format. You can optionally include
Data definition values when exporting the
process instance information; this is set from the
Servlet Engine option within the BPI Server
Administration Console. See "Component
Configuration - Servlet Engine" in the Business
Process Insight Server Administration Guide.

The exported CSV file can then be imported into
Microsoft Excel for analysis.
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Monitor Summary

This page displays summary information relating to recent and all values of
the Monitor.

User interface elements are described below:

Ul Elements (A-Z) Description

Monitor Values to date The data relating to each listed Monitor value
since the Monitor was deployed.

Recently Completed Monitor The data relating to each listed Monitor value
Values over the last collection interval (Data sample
collection period).
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@ Monitor Threshold Dialog

The Monitor Threshold dialog displays the statistical data collected that
relates to the Business Process Monitor Thresholds that you defined in the
Monitor Definer.

Threshold Definition I Threshold Viclations
l Process Ingtances > Process Ingtance > Time to Chack Funds
EWT_Wire Transfer: Process Instance Monitor Thresholds - Threshold Definition
Threshold Name : Time to Check Funds
P check Funds: P® Time to Check Funds
Thrashold Namae Time te Check Funds
Dascription Time raquired to check funds
Thrashold Type Absolute
Monitor Field Each Process Instance Value
Warning Lewvel >m 3 ming
Minor Level >=m 5 mins
Major Lavel >m 7 ming
Critical Level >m 3 mins
Racant Monitor Average 2d: Sh:30m
Associated Maonitor Check Funds
Close Help Reload
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To access Applications > Business Process Insight > Health >
Business Health tab > select one of the following links in
the left panel of the Summary tab: Healthy, Blocked, At
Risk, or Completed (opens the Process Instances Dialog) >
select an identifier (opens the Process Instance Dialog) >
select the Monitor Threshold tab > click Threshold Name

See also “Health Page Overview” on page 308

Click the Threshold name link to see the Monitor Threshold details, which
are divided into the following tabbed areas:

» “Threshold Definitions” on page 365

» “Threshold Violations” on page 366

Threshold Definitions

This tab displays the details of the Monitor Threshold as defined using the

Monitor Definer:

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Elements

Description

<Parent monitor definition>

The following is additional information relating
to the parent Monitor Definition:

<group_property> drop-down list

The <group_property> drop-down list enables you
to view the threshold details by group, if a
Group property was set in the Monitor Definer.
See “Health Page Overview” on page 308 for
details.
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366

Ul Elements

Description

Recent Monitor Average

The average Monitor value as measured over the
latest collection interval; see section “Collection
Interval” on page 203 for information relating to
the collection interval.

Associated Monitor

Link to the Monitor Page that shows
information for the Monitor that is associated
with the selected Threshold.

Threshold Violations

This tab displays a list of all the violations found for the selected instance

threshold.

The data shown in the list is tailored to your filter criteria. When you have
completed the settings for the filters, the list is populated automatically as

required.

The page is divided into the following areas, which show the required data

in list form:

» “Filter Criteria for Threshold Violations” on page 366

» “Results Area for Threshold Violations” on page 367)

Filter Criteria for Threshold Violations

The following user interface elements are included (unlabeled UI elements

are shown in angle brackets):

Ul Elements

Description

<group_property>

Select a group from the drop-down list to view
the threshold violations by group, if groups were
defined in the Monitor Definer. If groups were
not defined, <group_property> is not displayed.
See “Health Page Overview” on page 308 for
details.

Identifier

Enter a Process Identifier to list violations related
to a specific process instance. Leave this blank to
list violations for all process instances.
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Ul Elements

Description

Severity

Select the violation level that you want to list. If
you select the value All, all violation levels are
listed.

Maximum List Size

The number of Threshold Violations that you
want to list in the results area. You can select
from a list size of 8, 20 50 or 100.

Export all as CSV

Enables you to export all the Threshold
Violation data to a file in comma separated value
(CSV) format. You can optionally include Data
definition values when exporting the process
instance information; this is set from the Servlet
Engine option within the BPI Server
Administration Console. See "Component
Configuration - Servlet Engine" in the Business
Process Insight Server Administration Guide.

The exported CSV file can then be imported into
Microsoft Excel for analysis.

Results Area for Threshold Violations
The following user interface elements are included (unlabeled Ul elements

are shown in angle brackets):

Ul Elements

Description

Process ldentifier

The identifier for the Process Instance. Click to
open the Process Instance page to obtain more
information relating to the selected Process
Instance; see section “Process Instance Dialog”
on page 344.

Time Threshold Violated

The time that the instance threshold condition
was violated.
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Ul Elements

Description

Time Violation Raised

The time that the instance threshold condition
was detected by BPIL

The time that an instance threshold is detected
can be different if you have stopped the Monitor
Engine, or the BPI or BSM system has been
disabled for some reason.

Monitor Value At Violation
Time

Value of parent Monitor instance at the point
where the Violation occurred.

Severity

The level of the instance threshold violation,
which can be:

» Normal

» Warning

» Minor

» Major

» Critical

» Unknown
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BPI Application Reports

This chapter includes:

Concepts

» Report Pages Overview on page 370
Tasks

» How to View and Analyze Data Using the BPI Application Reports
on page 371

Reference

» BPI Application Reports User Interface on page 373
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Concepts

& Report Pages Overview

370

The BPI Application Report pages display historical data relating to
summaries of Business Processes, Business Activities, and Monitors that you
have defined.

The BPI reports consist of charts and tables that help you track and analyze
the health of your monitored BPI environment.

You can view and generate the BPI reports, as well as drill down and apply
various filtering criteria to examine performance trends and pinpoint the
cause of health and performance issues.

Reports enable you to examine and analyze the data that is collected for
Business Process Insight in the Profile database. When generating reports,
you can specify various report settings, including time range and resolution,
profile, grouping, and filters.

As with all BSM reports, you can customize the BPI reports by adding a
header and a footer, by selecting to automatically or manually generate the
report, or by customizing other display elements. More details of using BSM
reports can be found in "Using the Report Manager Reports " in Reports.
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Tasks

T How to View and Analyze Data Using the BPI Application
Reports

The following steps describe how to view and analyze data using the BPI
Application reports.

» “Prerequisites” on page 371
» “View and analyze the data using the reports” on page 371

» “Enrich the Business Process Report View"” on page 372

1 Prerequisites

To see report information for your Business Processes, you need to make
sure that you have created a Profile database using the following option
within BSM:

Admin > Platform > Manage Profile Databases

2 View and analyze the data using the reports

When there is data available in the Profile database; that is, BPI is sending
data samples, the following BPI reports are available to help you analyze
the BPI Business Process data:

> Business Process Summary. Displays summary data for the selected
Business Process; see section “Business Process Summary Report” on
page 373.

You can drill down to the following reports from the Business Process
Summary report.
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372

> BPI Monitors Over Time. Displays two graphs for each selected
Monitor definition; see section “BPI Monitors Over Time Report” on
page 384.

The first graph displays the average/minimum/maximum/weighted
value or duration of the selected Monitor over time.

The second graph displays the number of Monitor instance violations
over time.

> Business Activity Summary. Displays summary data for the selected
Business Activity; see section “Business Activity Summary Report” on
page 388.

You can drill down to the Business Activity Over Time report from this
report.

The following diagram shows the hierarchy of reports for Business
Process Insight.

Business
Process
Summary

BPI Monitors
O Tirme

Business
Procass
Activity
Business Summary
Procass Ovar
Time

Business
Process
Activity Over
Tirme

3 Enrich the Business Process Report View

You can additionally attach IT Universe Cls to the appropriate Business
Activity. This enables you to add additional CI information to your
reports to enhance the level of information that the reports provide.
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Reference

@, BPI Application Reports User Interface

This section includes:

» Business Process Summary Report on page 373
» BPI Monitors Over Time Report on page 384

» Business Activity Summary Report on page 388
» Business Process Over Time Report on page 392

» Business Activity Over Time Report on page 396

® Business Process Summary Report

The Business Process Summary Report displays the summary data for the
selected Business Processes. Use the Business Process Summary Report to
gain an overall view of the historical health of your Business Processes.
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Following is an example of a Business Process Summary Report

e&&mvavaaﬂn

[Rozorms » Bosntns Process Summary

R B |

| Businges Peocess Symmery,
oo Bh B P A &
W | Mieetn o cate W

Susiness Processes. Flteres(3)
show: Oviaise O Couat @ om

EECEED

e — N Total Value of C P

Avg. Vahir Avg. Valao of A1 Pisk Avg. Vah

. oo [

Phane Proviaion () (1 289.183.22 2R 1) =
AFID_Supply Coain (1] 1,447 470,98 1,447 430,88 o
_Gourd.

|| %] | 5= =)

Business Process ~ lm‘umm A I A Beee 00 e ST Avg. Mumber of At Risk Instances | b B! S Blocked
T o0 o0 )
Prane Provison ] 2471041 2471841 o
8FD_Susey Cran . 807 oL 000 ]
To access Applications > Business Process Insight > Reports

>Business Process Summary

Relevant tasks “How to View and Analyze Data Using the BPI
Application Reports” on page 371

See also “Report Pages Overview” on page 370
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Report Settings

The following table describes the user interface elements of the Business
Process Summary report settings (unlabeled Ul elements are shown in angle
brackets):

Ul Elements Description

<Common report elements> For details, see “Common Report Elements” in
Reports.

Business Processes Click to open the Business Processes dialog box

where you can filter which Business Processes
you want to display. For details, see “Browse/
Search Tabs” on page 375.

Show Select one of the following options:

» Value. Select to display value data for the
Business Processes in the Value area.

» Count. Select to display Business Process
count values in the Count area.

» Both. Select to display both the counts and
the values. This is the default for the Report.

Browse/Search Tabs
When you select Business Processes, a dialog opens with the Browse and

Search views in which you can select which Business Processes you want to
display.

Browse View

You can browse ClIs in the RTSM. These ClIs are already populated in the
RTSM by the person responsible to IT operations. This is done either
manually or through automated means, such as discovery.

Select the Business Process view and the Business Process Cls that you want
to display on the Report page.
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If one Business Process is selected, its name is displayed to the right of the
link. If more than one Business Activity is selected, Filtered (n) is displayed
to the right of the link, where n represents the number of selected Processes.

You can only select ClIs within the current Browse view.

Search

Search for one or more Business Process Cls in the views or the RTSM, search
for all occurrences of a CI, or filter the list of CIs that is displayed.

The Search option enables you to find the CI you need. You can set up
searches based on any combination of the filter criteria based on CI Type
and CI Name.

When searching for CIs by name, you enter a string, or partial string in the
CI Name list box. The search returns all CIs that contain the entered string
somewhere in the name (within the boundaries of the other search criteria
that you define).

When using this search option, note the following:

» The search by CI name option is not case sensitive.

» You can search just for the name by using the first few letters of the name
or first part of the name. Wildcards do not work.

» You can search just for the CI type by entering the type, such as
business_activity.

If there are more than one CIs beginning with that name or of that CI
type, a list displays in the left panel.

» You can select one or more Cls and click the right arrow to put the Cls in
the Related ClIs right panel.
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Report Value

The following table describes the user interface elements of the Business
Process Summary Value area. The Value area is displayed when you select
Value or Both from the Show: option (unlabeled Ul elements are shown in
angle brackets).

Ul Elements Description

Select a Business Process and click the Drrill
¥ Down to Business Process Over Time
Report button to drill down to the Business
Process Over Time report for the selected
Business Process. The report is displayed with
the most appropriate option selected.

Select a Business Process and click the Drill

Down to Business Activity Summary Report
button to drill down to the Business Activity
Summary report for the selected Business
Process. The report is displayed with the most
appropriate option selected.

RE' Select a Business Process and click the Drill Down

to Duration Monitors Over Time Report button
to drill down to the BPI Monitors Over Time
report for the selected Business Process where
only the Duration Monitors are shown in the
report.

The button is enabled only if the selected
Business Process has Duration Monitors defined.

= Select a Business Process and click the Drill

2= Down to Value Monitors Over Time Report
button to drill down to the Monitors Over Time
report for the selected Business Process where
only the Value Monitors are shown in this
report.

Custom Monitor can also be selected for this
report.

The button is enabled only if the selected
Business Process has a Value Monitor defined.
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Ul Elements

Description

Business Process

The name of the selected Business Process.
Note: You can sort on this column.

Tooltip: Displays the name of the Business
Process and the currency symbol, in cases where
the value is a currency type.

Total Value of Completed
Instances

Displays the total of the value attribute for all
the Business Process instances that were
completed in the selected time period.

The background color of the table row is set to
gray.

Tooltip: Displays the value of the table cell with
a currency unit if it is available.

Avg. Value of Backlog Instances

Displays the average of the value attributes for
all the Business Process instances with a status of
Active over the specified period of time.

The background color of the table row is set to
gray.

Tooltip: Displays the value of the table cell with
a currency unit if it is available.

Avg. Value of Healthy Instances

Displays the average of the value attributes for
all the Business Process instances that have a
Healthy status over the specified period of time.
The background color of the table row is set to
green.

Tooltip: Displays:
» The value of the table cell.

» The value of the Avg. Number of Backlog
Instances cell.

» The percentage of the current table cell value
compared to the value of the Avg. Number
of Backlog Instances cell.
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Ul Elements

Description

Avg. Value of At Risk Instances

Displays the average of the value attributes for
all the Business Process instances that have an
At Risk status over the specified period of time.
The background color of the table row is set to
yellow.

Tooltip: Displays:
» The value of the table cell.

» The value of the Avg. Value of Backlog
Instances cell.

» The percentage of the current table cell value
compared to the value of the Avg. Value of
Backlog Instances cell.

Avg. Value of Blocked Instances

Displays the average of the value attribute for all
the Business Process instances that are in the
Blocked status over the specified period of time.

The background color of the table row is set to
red.

Tooltip: Displays:

» The value of the table cell.

» The value of the Avg. Number of Backlog
Instances cell.

» The percentage of the current table cell value
compared to the value of the Avg. Number of
Backlog Instances cell.
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Report Count

The following table describes the user interface elements of the Business
Process Summary Count area. The Count area is displayed when you select
Count or Both from the Show: option (unlabeled UI elements are shown in
angle brackets).

Ul Elements Description

Select a Business Process and click the Drill

¥ Down to Business Process Over Time Report
button to drill down to the Business Process
Over Time report for the selected Business
Process. The report is displayed with the Count
option selected.

Select a Business Process and click the Drill

Down to Business Activity Summary Report
button to drill down to the Business Activity
Summary report for the selected Business
Process. The report is displayed with the Count
option selected.

RE' Select a Business Process and click the Drill

Down to Duration Monitors Over Time Report
button to drill down to the Monitors Over
Time report for the selected Business Process
where only the Duration Monitors are shown
in the report.

The button is enabled only if the selected
Business Process has a duration Monitor
defined.
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Ul Elements

Description

-
o

Select a Business Process and click the Drill
Down to Value Monitors Over Time Report
button to drill down to the Monitors Over
Time report for the selected Business Process
where only the Value Monitors are shown in
this report.

Custom Monitors can also be displayed in this
report.

The button is enabled only if the selected
Business Process has a Value Monitor defined.

Business Process

The name of the selected Business Process.
Note: You can sort on this column.

Tooltip: Displays the name of the Business
Process.

Number of Completed
Instances

Displays the total number of the Business
Process instances that were completed in the
selected time period.

The background color of the table row is set to
gray.

Tooltip: Displays the value of the table cell.

Avg. Number of Backlog
Instances

Displays the average number of backlogged
Business Process instances out of the number of
samples reported over the specified period of
time.

The background color of the table row is set to
gray.
Tooltip: Displays the value of the table cell.
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Ul Elements

Description

Avg. Number of Healthy
Instances

Displays the average number of the Business
Process instances that have a Healthy status,
out of the number of samples reported over the
specified period of time. The background color
of the table row is set to green.

Tooltip: Displays:
» The value of the table cell.

» The value of the Avg. Number of Backlog
Instances cell.

» The percentage of the current table cell value
compared to the value of the Avg. Number
of Backlog Instances cell.

Avg. Number of At Risk
Instances

Displays the average number of the business
process instances that have an At Risk status,
out of the number of samples reported over the
specified period of time. The background color
of the table row is set to yellow.

Tooltip: Displays:
» The value of the table cell.

» The value of the Avg. Number of Backlog
Instances cell.

» The percentage of the current table cell value
compared to the value of the Avg. Number
of Backlog Instances cell.
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Ul Elements

Description

Avg. Number of Blocked
Instances

Displays the average number of Business
Process instances that are in the Blocked status,
out of the number of samples reported over the
specified period of time.

The background color of the table row is set to
red.

Tooltip: Displays:

» The value of the table cell.

» The value of the Avg. Number of Backlog
Instances cell.

» The percentage of the current table cell value
compared to the value of the Avg. Number
of Backlog Instances cell.
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@ BPI Monitors Over Time Report

The BPI Monitors Over Time Report displays two graphs for a selected
Business Process Monitor: Monitor Data and Status Distribution.
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To access Applications > Business Process Insight > Reports > BPI
Monitors Over Time

Important Use the BPI Monitors Over Time Report to list

information information relating to the Business Process Monitors

status for your Business Processes over a selected time

period. The report data is shown in graphical form and

can also be published in tabular form for the following

graphs:

» Monitor Data, which plots the average/minimum/
maximum/weighted value or duration of the selected
Business Process Monitor over time.

» Status Distribution, which plots the Monitor instance
violations over time, based on their status.

Relevant tasks

“How to View and Analyze Data Using the BPI
Application Reports” on page 371

See also

“Report Pages Overview” on page 370

Report Settings

The following table describes the user interface elements of the BPI Monitor
Over Time Report settings (unlabeled Ul elements are shown in angle

brackets).
Ul Elements Description
<Common report elements> For details, see “Common Report Elements” in
Reports.
BPI Monitors Click to open the BPI Monitors dialog box where

you can filter which BPI Monitor you want to
display. For details, see “Browse/Search Tabs” on
page 375.

Graph by Group

This option appears when one Business Process
Monitor is selected. If more than one monitor is
selected, this option is not available.

Click Graph by Group to drill down to a Monitor
Graph with a display that is split according to
the different elements in the Group definition
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Monitor Data Area
The Monitor Over Time Report displays a separate set of charts for each
selected Monitor and for the selected time period in the Monitor Data area.

If you have selected an BPI Value or Custom Monitor, the graph displays the
following information:

Ul Elements

Description

Average Duration

The average duration of the completed instances of
the selected Monitors out of the total number of
completed instances of the selected Monitors.

Average Value per
Instance

The average value of the completed instances of the
selected Monitor out of the total number of
completed instances.

Maximum Duration.

The maximum duration of all the completed
instances for the selected Monitor.

Maximum Value

The maximum value of all the completed instances
of the selected Monitor.

Minimum Duration

The minimum duration of all the completed
instances for the selected Monitor.

Minimum Value

The minimum value of all the completed instances
of the selected Monitor.If you have selected an BPI

Duration Monitor, the graph displays the following
information:

Weighted Average
Duration

The weighted average duration of all the completed
instances of the BPI Monitors out of the total
number of completed instances of the Monitor.

<Tooltip>

There is tooltip for each point on the graphs and
you can progressively drill down to a specific hour
for more detailed data.
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The Monitor Over Time Report displays a separate bar chart for each of the
selected Monitors for the selected time period in the Status Distribution

area.

The Monitor Over Time report displays the following data for the selected
Monitor over the selected time period:

Ul Elements

Description

Total % of Value/Duration
Critical Violated Instances

The percentage of the total number of instances of
the Monitor instances that completed with a
Critical Violated status out of the total number of
completed instances of the Monitor.

Total % of Value/Duration
Maijor Violated Instances

The percentage of the total number of instances of
the Monitor instances that completed with a Major
Violated status out of the total number of
completed instances of the Monitor.

Total % of Value/Duration
Minor Violated Instances

The percentage of the total number of instances of
the Monitor instances that completed with a Minor
Violated status out of the total number of
completed instances of the Monitor.

Total % of Value/Duration
Non-Violated Instances

The percentage of the total number of instances of
the Monitor instances that completed with a
Non-Violated status out of the total number of
completed instances of the Monitor.

Total % of Value/Duration
Warning Violated

The percentage of the total number of instances of
the Monitor instances that completed with a

Instances Warning Violated status out of the total number of
completed instances of the Monitor.
<Tooltips> Tooltips for bars in the bar chart display the number

of instances, the total number of instances, and the
percentage and you can progressively drill down to
a specific hour for more detailed data.
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@ Business Activity Summary Report

The Business Activity Summary Report shows summary information for a
Business Activity over a selected period of time.

Following is an example of a Business Activity Summary report.

[ Reorts » Busimess Actuty Summary
Scorecand Heath [
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789,008 38
| Actrvity tame « | Manatier of Comploted Instances | Avg. Husbies of Backlog instances
159 a2
135599 (53]
To access Applications > Business Process Insight > Reports >
Business Activity Summary
Relevant tasks “How to View and Analyze Data Using the BPI
Application Reports” on page 371
See also “Report Pages Overview” on page 370

388



Report Settings

Chapter 11 ¢ BPI Application Reports

The following table describes the user interface elements of the Business
Activity Summary Report settings (unlabeled Ul elements are shown in

angle brackets).

Ul Elements

Description

<Common report elements>

For details, see “Common Report Elements” in
Reports.

Business Processes

Click to open the Business Processes dialog box

where you can select the Business Process whose
Activities you want to report on. For details, see
“Browse/Search Tabs” on page 375.

Show

Select one of the following options:

» Value - Select to display value data for the
Business Activities in the Value area.

» Count - Select to display Business Activity
count values in the Count area

» Both - Select to display both the Activity
Value and Activity Count values for the
Business Process Activities. Both the Value
and the Count area are displayed. This is the
default.
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Value Table

This table lists the value of completed process instances at each Activity,
plus the average value of the active instances at each Activity (backlog).

The following table describes the user interface elements of the Value table
(unlabeled UI elements are shown in angle brackets).

Ul Elements

Description

+

Select a Business Process and click the Drill Down
to Activity Over Time Report button to drill
down to the Activity Over Time report for a
selected Business Activity. The report is displayed
with the Value option selected.

Activity Name

The name of the selected Business Activity. You
can select to list the Activities in ascending or
descending alphabetical order.

Tooltip: Displays the name of the Business
Activity.

Total Value of Completed
Instance

Displays the total of the value attribute for all
the Business Activity instances that were
completed in the selected time period.

Tooltip: Displays the value of the table cell, with
value units (where value units are set).

Avg. Value of Backlog Instances

Displays the average value (backlog) of the active
instances at each Activity in the process over the
selected time period.

Tooltip: Displays the value of the table cell.
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This table lists the total number of completed process instances at each
Activity, plus the average number of the active instances at each Activity

(backlog).

The following table describes the user interface elements of the Count table
(unlabeled UI elements are shown in angle brackets).

Ul Elements

Description

¥

Select a Business Process and click the Drill Down
to Activity Over Time Report button to drill
down to the Business Activity Over Time report
for the selected Business Activity. The report is
displayed with the Count option selected.

Activity Name

The name of the selected Business Activity.

Tooltip: Displays the name of the Business
Activity.

Number of Completed
Instances

Displays the total number of the Business
Activity instances that were completed in the
selected time period.

Tooltip: Displays the value of the table cell.

Avg. Number of Backlog
Instances

Displays the average value (backlog) of the active
instances at each Activity in the process over the
selected time period.

Tooltip: Displays the value of the table cell.
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@ Business Process Over Time Report

The Business Process Over Time Report shows an over-time graph of
information relating to the Business Process value and count data over a

selected time period.

Following is an example of the Business Process Over Time Report:

Soerecerd Heatn Rezony ; =]
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To access Applications > Business Process Insight > Reports >

Business Process Summary > Business Process Over Time
Important The report data is shown in graphical form and can also
Information be published in tabular form.
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Relevant tasks “How to View and Analyze Data Using the BPI

Application Reports” on page 371

See also “Report Pages Overview” on page 370

Report Settings

The following table describes the user interface elements for the Business
Process Over Time Report settings (unlabeled Ul elements are shown in

angle brackets).

Ul Elements

Description

<Common report elements>

For details, see “Common Report Elements” in
Reports.

Business Processes

Click to open the Business Processes dialog box
where you can select a Business Process that you
want to display.

You can select only Business Processes that have
a Business Process Monitor defined for them.
The name of the Business Process is displayed to
the right of the link.

Show

Is preselected when you enter the report
according to the setting at the Parent Business
Process Summary, you can change the selection
as follows:

» Select Value to display value-related data for
the Business Processes in the Value area.

» Select Count to display count-related data for
the Business Processes in the Count area.
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Data
The Data graph displays data relating to the Value or Count for the selected
Business Process over the selected time period.

The Business Process Over Time report displays the following data for the
selected Business Process over the selected time period:

Ul Elements Description

<Tooltips> Tooltips for the over time graph display the same
information for the selected entry and you can
progressively drill down to a specific hour for more
detailed data.

Avg. Backlog Value/Count | The average Value or average Count for the backlog
KPI for the selected Business Process. This average is
taken from the total number of completed Business
Process instances.

Total Value/Count of The total Value or Count of the completed instances
Completed Instances for the selected Business Process.
Health

The Health bar chart displays the overall health of the Business Process over
the selected time.

The Business Process Over Time report displays the following health
information for the selected Business Process over the selected time period:

Ul Elements Description

<Tooltips> Tooltips for the bars in the bar chart display the
same information for the selected entry and you
can progressively drill down to a specific hour for
more detailed data.

Avg. % of At Risk The percentage of the average number of instances
Instances or Avg. % of At | of the Business Process, which are in the state of At
Risk Instances Value Risk, measured from the total number of instances

over the period.
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Ul Elements

Description

Avg. % of Blocked
Instances or Avg. % of
Blocked Instances Value

The percentage of the average number of instances
of the Business Process, which are in the state of
Blocked, measured from the total number of
instances over the period.

Avg. % of Healthy
Instances or Avg. % of
Healthy Instances Value

The percentage of the average number of instances
of the Business Process, which are in the state of
Healthy, measured from the total number of
instances over the period.
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® Business Activity Over Time Report

The Business Activity Over Time Report shows an over-time graph of
information relating to the Business Activity status.

Following is an example of a Business Activity Over Time Report.
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To access

Applications > Business Process Insight > Reports >
Business Activity Summary > Business Activity Over Time

Important
Information

This report shows information relating to the values and
counts for Activities in the selected Business Activity over
a selected time period. The report data is shown in

graphical form and can also be published in tabular form.
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Relevant tasks “How to View and Analyze Data Using the BPI
Application Reports” on page 371

See also “Report Pages Overview” on page 370

Report Settings

The following table describes the user interface elements for the Business
Activity Over Time Report settings (unlabeled Ul elements are shown in

angle brackets).

Ul Elements

Description

<Common report elements>

For details, see “Common Report Elements” in
Reports.

Business Processes

Click to open the Business Processes dialog box
where you can select the Business Process that
you want to display data for.

Activities: Click to open the Activities dialog box where
you can select the Business Activity that you
want to display.

Show Is preselected when you enter the report

according to the setting at the Parent Business
Activity Summary, you can change the selection
as follows:

» Select Value to display value-related data for
the Business Process.

» Select Count to display count-related data for
the Business Process.
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Value
This over-time graph shows the total value of completed instances and the
average Backlog value of process instances at the selected Activity.

The Business Activity Over Time report displays the following Value data for
the selected Business Activity over the configured time period:

Ul Elements Description

Total Value of Completed The total Value of the completed instances for the

Instances selected Business Activity.
Avg. Value of Backlog The average Value for the backlog KPI for the
Instances selected Business Activity. This average is taken

from the total number of completed Business
Process instances.

<Tooltips> Tooltips for the over time graph display the same
information for the selected entry and you can
progressively drill down to a specific hour for more
detailed data.

Count
This over-time graph shows the number of completed instances and the
average number of Backlog instances at the selected Activity.

The Business Activity Over Time report displays the following Count data
for the selected Business Activity over the configured time period:

Ul Elements Description

<Tooltips> Tooltips for the over time graph display the same
information for the selected entry and you can
progressively drill down to a specific hour for more
detailed data.
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Ul Elements

Description

Avg. Number of Backlog
Instances

The average number of instances for the backlog
KPI for the selected Business Activity. This average is
taken from the total number of completed Business
Process instances.

Number of Completed
Instances

The total number of the completed instances for the
selected Business Activity.
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Annotations for Process Diagrams

This chapter includes:

Concepts

> Annotations Overview on page 402

Tasks

» How to Customize Your Process Diagram on page 403

» How to Include Character Set Encoding in the Annotation File
on page 411

Reference

» annotations.xml File Format on page 412
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Concepts

& Annotations Overview

402

This section describes how to add annotations to your Process Diagrams,
which appear within the Health page and on the Service Health application
Business Process Diagram.

BPI enables you to view any deployed Business Process. When displaying the
Process Diagram, it annotates each of the Activities by showing the number
of active process instances and the Value of the total instances at each
Activity.

Following is an example of a process diagram shown from the Health Page.

USCEE11 1 USC2E6,45F 1 T=UEC7F 7.
b W) W] <
Mew Order Process Ship Order End
Order

BPI enables you to customize a process diagram as follows:

> You can configure a customized image for each Activity in the process.
> You can configure the text that is shown above each Activity.

As an example, you can customize your process diagram to be displayed as
shown in the following figure. In this figure, the instance values and the
instance counts are shown on two of the Activities and the End Activity is
configured to show the total value of all completed instances.

$8,621 1 $26,457 3 T=477K
. B
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Tasks

P How to Customize Your Process Diagram
You can customize your Process Diagram as follows:

> “Use the Modeler to Customize Activity Icon Images” on page 404

» “Use an annotations.xml File to Customize Activity Icon Images” on
page 405

» “Use an annotations.xml File to Customize Activity Text” on page 407

» “Example of a Complete Process in the annotations.xml File” on page 410

Note: Keep the following in mind when customizing Activity icons:

» Itis recommended that you define the Activity images using the
Modeler’s Process Editor. After the Business Process is deployed, the new
images are displayed immediately in the Process Diagram on the Health
page, Process Instance pages and Service Health page.

» If you define images in the annotation.xml file, the images display in the
Process Diagram but not in the Modeler’s Process Editor. It may take time
for the images to display in the Process Diagram on the various pages.

» If you have different images selected in the Modeler, those images take
precedence over the images in the annotation.xml file.

» The following image file types are supported: .jpeg, .jpg, .gif, and .png.
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404

Use the Modeler to Customize Activity lcon Images

You can customize the Activity icons for each Activity from the Modeler’s
Properties dialog.

To configure the text shown above each Activity, you create an
annotations.xml file as described in “Use an annotations.xml File to
Customize Activity Icon Images” on page 405.

To customize the Activity icons:

1 Upload the image or images to both the BSM Gateway Server and BPI
Server as follows:

» On the BSM Gateway Server, place images in:
BSM-install-dir\AppServer\webapps\bpi.war\customimages
> On the BPI Server, place images in:

BPI-install-dir\nonOV\ jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\c
ustomimages

and

BPI-install-dir\nonOV\ jakarta-tomcat-5.0.19\webapps\ovbpimetric
definer\customimages

2 Open the Modeler:
Admin > Business Process Insight > Modeler

3 Click the Business Process in the left pane and click the Process Editor in
the right pane to display the Activities of the Business Process model.

If you are creating a new Business Process model in the Process Editor, you
can customize each Activity icon using the following steps. For more
information about the Modeler and creating Business Process models, see
Chapter 3, “Modeler Management.”

4 Right-click on the Activity you want to customize and click Properties.
The Activity Properties dialog opens.
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5 Select an image from the Images dropdown list.

Make sure the images you use are proportional in width and height. If the
images are not square, they may not display properly.

6 Close the Properties dialog to see the customized Activity icon.

Use an annotations.xml File to Customize Activity Icon Images

You can create an annotations.xml file to modify the image of one or more
Activities in your Process Diagram. For details of the configuration elements,
see “annotations.xml File Format” on page 412.

The completed annotations.xml file must be copied to the following
locations:

» Under the BSM installation hierarchy:
BSM-install-dir\lib

where BSM-install-dir is the installation directory for the BSM Gateway
Server to which the BPI Server is configured to connect.

» On the BPI Server:

BPI-install-dir\nonOV\ jakarta-tomcat-5.0.19\webapps\hpbpi-bpd \WEB-I
NF\classes

The annotations.xml file needs to be placed on the BPI Server so that the
annotations are correct on the Process Instance pages.

To customize the Activity icons using the annotations.xml file:

1 Upload the image or images to both the BSM Gateway Server and BPI
Server as follows:

> On the BSM Gateway Server, place images in:

BSM-install-dir\AppServer\webapps\bpi.war\customimages
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> On the BPI Server, place images in:

BPI-install-dir\nonOV\ jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\c
ustomimages

and

BPI-install-dir\nonOV\ jakarta-tomcat-5.0.19\webapps\ovbpimetric
definer\customimages

2 Edit the annotations.xml file to replace the default Process Activity image
with a custom image:

<step name="Activity name">
<texttype>none</texttype>
<image>customimages/image name.gif</image>
</step>

For Example:

<step name="Process Order">
<texttype>none</texttype>
<image>customimages/engineer_on_call.gif</image>
</step>
In this example, the Process Order Activity is shown with a custom
image as seen below.
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When BPI detects that the file exists and the icon was not customized using
the Modeler, BPI uses the file when it draws a Process Diagram.
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Note: If there is an error processing the annotations.xml file, the file is
ignored and the Process Diagram displays as it would if the file did not exist.
The Business Process Insight Problem Solving Guide provides some information
about troubleshooting your system when your annotations are not
displayed as expected.

Use an annotations.xml File to Customize Activity Text

You can create an annotations.xml file to modify the text of one or more
Activities in your Process Diagram. For details of the configuration elements,
see “annotations.xml File Format” on page 412. The completed
annotations.xml file must be copied to the locations described in “Use an
annotations.xml File to Customize Activity Icon Images” on page 405.

Following are examples of how to edit the annotations.xml file to hide text,
show the value for active instances, scaled active value, and value and
instance count, using a custom image.

To Hide Text on Process Activities

If you do not want any text shown above your Process Activities, specify
your XML as follows:

<step name="Process Order">
<texttype>none</texttype>
</step>

In this example, the Process Order Activity is shown without any text above
the Activity, as seen below.
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To Show the Value for Active Instances and Custom Image on a Process
Activity

If you want to show the value for the active instances on a custom image for
a Process Activity, specify your XML as follows:

<step name="Process Order">
<texttype>value</texttype>
<textsymbol>$</textsymbol>
<image>customimages/engineer_ on_phone.gif</image>
</step>

In this example, the Process Order Activity is shown with an active value as
seen below.

45,52

Jrocess
Croer

To Show the Scaled Active Value

If you want to show the value for the active instances that has been scaled
and that also includes a custom image for a Process Activity, specify your
XML as follows:

<step name="Process Order">
<texttype>value</texttype>
<textsymbol>$</textsymbol>
<textdp>-3</textdp>
<scalesymbol>K</scalesymbol>
<image>customimages/engineer_ on_phone.gif</image>
</step>
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In this example, the Process Order Activity is shown with a scaled active
value, as seen below.

Prucess
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To Show Value and Instance Count

If you want to show both a value, which has been scaled, for the active
instances and the number of active instances, plus a custom image for a
Process Activity, specify your XML as follows:

<step name="Process Order">
<texttype>both</texttype>
<textsymbol>$</textsymbol>
<textdp>-3</textdp>
<scalesymbol>K</scalesymbol>
<image>customimages/engineer_on_phone.gif</image>
</step>

This displays the Process Order Activity showing both the value and
instance count, as shown below.
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Example of a Complete Process in the annotations.xml File

The following is an example of the annotations.xml file for a complete
process:

<?xml version="1.0" encoding="IS0-8859-1"7?>
<annotations>
<step name="New Order">
<texttype>none</texttype>
<image>customimages/phone_receiver.gif</image>
</step>
<step name="Process Order">
<texttype>both</texttype>
<textsymbol>$</textsymbol>
<textdp>2</textdp>
<image>customimages/engineer_ on_phone.gif</image>
</step>
<step name="Ship Order">
<texttype>both</texttype>
<textsymbol>$</textsymbol>
<textdp>2</textdp>
<image>customimages/ship.gif</image>
</step>
<step name="End">
<texttype>value</texttype>
<textsymbol>$</textsymbol>
<textdp>-3</textdp>
<scalesymbol>K</scalesymbol>
<image>customimages/success.gif</image>
</step>
</annotations>
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In this example, the Process Diagram is displayed as shown below.

45,821 1 426,457 3 T=477K
=
Mew Order Process Ship Drder End
Crrder

P How to Include Character Set Encoding in the
Annotation File
To create an annotations file that contains a specific character set encoding,
for example, UTF-8:
1 Use an editor that supports UTE-8.

The editor that you use does not add any extra characters (hidden
characters) to the file. As an example, Notepad writes three additional
bytes to the start of a file, which although not visible within Notepad,
create errors in the XML file that you create.

2 Specity the first line of your XML as follows:
<?xml version="1.0" encoding="UTF-8"?>

In the UTF-8 example, if you specity UTF-8 as the XML encoding and do
not use a corresponding UTF-8 editor when entering the UTF-8
characters, BPI fails to parse the annotations.xml file and therefore
ignores your settings.

3 Make sure that you use an editor that supports the character set encoding
that you specify in your annotations file.
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Reference

®_annotations.xml File Format

The annotations.xml file is structured as follows:

<?xml version="1.0" encoding="..." ?>
<annotations>
<step name="...">
<texttype> ... </texttype>
<textsymbol> ... </textsymbol>
<textdp> ... </textdp>
<scalesymbol> ... </scalesymbol>
<image> ... </image>
</step>

...further steps...

</annotations>

Note: An Activity is configured using the <step> element.

The following sections describe this structure in more detail and provide
some examples of configuration options.

encoding=
<annotations>
<step>
<texttype>

<textsymbol>

Y Y Y Y Y Y

<textdp>
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» <scalesymbol>

» <image>

encoding=
The first line of the annotations file declares that this file contains XML and
it declares the encoding used within this XML.

If your annotations include 8-bit Western European characters, then you
could set the first line of the file to be:

<?xml version="1.0" encoding="1SO-8859-1"7>
The following are examples of other XML encodings you could use:
windows-1252

UTF-8
UTF-16

The XML encoding that you use depends on the editor you are using to
create the annotations file and the type of characters you are using.

<annotations>

The annotations element simply encloses the set of activity elements.

You must have one, and only one, annotations element within the
annotations.xml file.

<step>

You define a step element for each Activity in the Process Diagram that you
want to annotate.

BPI uses only one annotations.xml file, and there is no way to specify a
Process Name in the annotations.xml file. This means that when you specify
a step element for a particular Process Activity name, all Process Activities
with the same name in any process definition, are displayed with the same
annotation in the Process Diagram. As a result, you might want to consider
making sure that your Activity names are unique across your process
definitions.
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Example:

You might have a step element structured as follows:

<step name="New Order">

</step>

In this case, any process with a Process Activity named New Order is
annotated when BPI displays it as a Process Diagram.

<texttype>

The texttype element enables you to specify the data that is displayed
above the image of the Process Activity.

You can specify one of the following values:

> count
This displays the number of active instance at this Process Activity.
Example:
<texttype>count</texttype>

If you do not specify a texttype element, a value for count is
automatically added to the Process Diagram.

When displayed within the Process Diagram, the value for count is
displayed above, and slightly to the right, of the Process Activity.

» value

This is the value of all the current active instances at the specified Process
Activity and as defined by the Process Value property for the Process.

Example:
<texttype>value</texttype>

When displayed within the Process Diagram, the Process value of the
active instances is displayed above, and slightly to the right, of the
Process Activity.
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» both

This enables you to display both the active count of process instances at
this Process Activity, and the active value of these instances.

Example:
<texttype>both</texttype>

When displayed within the process diagram, the value of the active
instances is displayed above, and slightly to the left, of the Process
Activity, and the count of the active instances is displayed above, and
slightly to the right, of the Process Activity.

> none
This enables you to display the Process Activity without any text above it.
Example:

<texttype>none</texttype>

<textsymbol>

The textsymbol element enables you to specify a character sequence to
display as part of the active instance value. This character sequence is
usually displayed before the active instance value, but its position is
localizable.

The textsymbol element is used only if you have specified a texttype setting
of value or both.
Example:

<textsymbol>$</textsymbol>

<textdp>

The textdp element enables you to specify the number of decimal places to
use when displaying the value attribute for active instances at a specified
Process Activity.

The textdp element is used only if you have specified a texttype setting of
value or both.
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416

Example:

You might set the value for textdp to be 2 as follows:
<textdp>2</textdp>

If you have a value of 2.8765, this is shown as 2.88 on the Process
Diagram.

If you do not specify a textdp element, the value is shown with zero
decimal places on the Process Diagram.

If you specify a negative value for the value of textdp, that is, a number
between -1 and -100, then the number that you want to display is
truncated by that number of digits, and the value is rounded. When you
specify a negative value for textdp, you also need to specify a scalesymbol
element. For examples of using negative values, see “<scalesymbol>" on
page 416.

<scalesymbol>

The scalesymbol element is used to define the symbol you want to be
displayed with the active instances value to reflect the scaled number. In
other words, if you have specified a textdp with a negative value then you
need to set a scalesymbol to show the scaling that has occurred.

The following are examples of how you might set values for textdp and
scalesymbol and the results that are displayed:

Example 1:
<textdp>-3</textdp>

<scalesymbol>K</scalesymbol>

If you have a value of 234567, this is shown as 235K on the Process
Diagram.

Example 2:
<textdp>-6</textdp>

<scalesymbol>M</scalesymbol>

If you have a value of 1234567, this is shown as 1M on the Process
Diagram.
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<image>

The image element specifies a file name of an image that you want to be
displayed in place of the standard Process Activity image. The file name for
the image is relative to the webapps directory.

Example:

You might set the following:
<image>customimages/myImage.gif</image>

In this example, BPI looks for the mylmage.gif file in the following
directories:

> BSM installation directory:
BSM-install-dir\AppServer\webapps\bpi.war\customimages
» BPI Server installation directories:

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\hpbpi-bpd\c
ustomimages

and

BPI-install-dir\nonOV\jakarta-tomcat-5.0.19\webapps\ovbpimetric
definer\customimages

You need to create the directory customimages, if it does not already
exist.
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BPlI Components in MyBSM

This chapter includes:

Concepts

» MyBSM Components Overview on page 420

Tasks

» How to Add BPI Components to MyBSM on page 421
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Concepts

& MyBSM Components Overview

420

Within Business Service Management, you can use the MyBSM portal server
to add and customize BPI pre-defined components so that you can display
specific content that is relevant to you.

You can configure MyBSM to display the following pre-defined BPI
components:

> Business Process Overtime to display information about the volume
(throughput), backlog (active process value) and health of a selected
Business Process CI over a specific time interval. For details, see "Business
Process Over Time Report" on page 392.

> Business Process Instance Violations to display information about the
instance violations for a selected Business Process. For details, see
"Instance Violation Counts" on page 332.

> Business Process Summary to display the summary data for all selected
Business Processes. For details, see "Business Process Summary Report" on
page 373.

> Business Process Diagram to display the overall status of the health of
your Business Process. For details, see "Process Diagram Area" on page 318.

Note: The Process Diagram in MyBSM and Service Health displays only
the data from the "current" sample, whereas the Health Page displays the
totals.
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Tasks

P How to Add BPI Components to MyBSM

You can add one or more BPI pre-defined components. For details on adding
and using components in MyBSM, see "Working With MyBSM" in Using
MyBSM.
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